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General Notices
Sample Code

NetSuite Inc. may provide sample code in SuiteAnswers, the Help Center, User Guides, or elsewhere
through help links. All such sample code is provided “as is” and “as available,” for use only with an
authorized NetSuite Service account, and is made available as a SuiteCloud Technology subject to the
SuiteCloud Terms of Service at www.netsuite.com/tos.

NetSuite may modify or remove sample code at any time without notice.

No Excessive Use of the Service

As the Service is a multi-tenant service offering on shared databases, customers may not use the
Service in excess of limits or thresholds that NetSuite considers commercially reasonable for the
Service.  If NetSuite reasonably concludes that a customer’s use is excessive and/or will cause
immediate or ongoing performance issues for one or more of NetSuite’s other customers, NetSuite
may slow down or throttle such customer’s excess use until such time that the customer’s use stays
within reasonable limits. If a customer’s particular usage pattern requires a higher limit or threshold,
then the customer should procure a subscription to the Service that accommodates a higher limit and/
or threshold that more effectively aligns with the customer’s actual usage pattern.

Integration with Third Party Applications

NetSuite may make available to Customer certain features designed to interoperate with third party
applications. To use such features, Customer may be required to obtain access to such third party
applications from their providers, and may be required to grant NetSuite access to Customer’s
account(s) on such third party applications. NetSuite cannot guarantee the continued availability of
such Service features or integration, and may cease providing them without entitling Customer to
any refund, credit, or other compensation, if for example and without limitation, the provider of a
third party application ceases to make such third party application generally available or available
for interoperation with the corresponding Service features or integration in a manner acceptable to
NetSuite.

Copyright

This document is the property of NetSuite Inc., and may not be reproduced in whole or in part without
prior written approval of NetSuite Inc. For NetSuite trademark and service mark information, see
www.netsuite.com/portal/company/trademark.shtml.

© 2017 NetSuite Inc.
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Dashboards Overview
You can create a unique dashboard setup to ensure maximum efficiency and ease when you use
NetSuite. For each user, NetSuite displays a variable set of tabbed pages, called a center. The center
is based on the user's assigned role. Each NetSuite center provides the pages and links that users with
the same role need to do their jobs.

Most tabbed pages of each center display a collection of real-time data relevant to the page and to
the role of the user viewing the page. This collection, called a dashboard, provides a visual workspace
that gives users instant, uninterrupted access to accurate information. A dashboard is available not
only on your home page, but on every page you see in NetSuite except the Documents, Setup, and
Customization pages. On your dashboards, you can view the data you need to make decisions, and edit
records.

Dashboard content is displayed in a variety of portlets, dynamic data display windows. Some portlets
provide direct access to raw data, and others display data that has been synthesized into critical
business metrics, such as key performance indicators (KPIs), performance scorecards, trend graphs,
and report snapshots. Other portlets enable you to display data from Web site RSS feeds.

For each page, NetSuite provides a default dashboard configuration that can be changed to meet
individual users' business needs. Administrators can personalize the dashboards for one or more
pages and publish them to a group of users so that they all see a consistent interface. The dashboards
that users see depend on their roles. Administrators can choose whether to give individual users the
ability to personalize their own dashboards further.

To set up dashboards, you need to understand the following:

■ The different types of content available. See Dashboard Portlets.

■ How to modify a default dashboard to include the content you need. See Personalizing Dashboards.

■ How to publish dashboards to groups of users. (You must have the Publish Dashboards permission
for this task.) See Publishing Dashboards Overview.
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Note: NetSuite dashboards include functionality provided by HighCharts JS, which is software
owned by and licensed through Highsoft Solutions AS.

Dashboard Portlets
NetSuite offers many types of content for dashboard portlets. To see the content available on a
particular page, click the Personalize Dashboard link in the Settings portlet or the Personalize link in the
upper right corner of the page. The Personalize Dashboard panel displays the content that you can add
to your dashboard on tabs for Standard Content, Report Snapshots, and Trend Graphs. The portlets
that you are currently using appear on the Currently Used tab.

Custom dashboard pages have the same limits on portlets as the standard Home page.

For descriptions of dashboard content, see Portlet Types Table.

Using portlets
Portlet controls are hidden until you move your pointer over the portlet.

If a dashboard contains a portlet that is extremely slow to load, the first time the portlet opens,
NetSuite may display a popup suggesting that you minimize the portlet to speed dashboard loading
time.

■ To minimize a portlet, click its title bar. When you move your pointer over the title bar, it changes to
crossed arrows as shown.

Click the title bar again to expand the portlet’s content.

Portlets with content that is calculated from current data include a Refresh icon  on the right of the
title bar.

■ Click the icon to refresh the portlet content and ensure it includes the latest data.

Portlet Types Table
The following table describes content available for display in dashboard portlets, and notes how you
can set up content after adding portlets to your dashboard.

Note: Not all content is available on all pages. To see the content that is available for a
specific page, click the Personalize link in the upper right corner of the page or the Personalize
Dashboard link in the Settings portlet. The Personalize Dashboard panel lists the content you
can add. Portlets have task links, in some cases, including a Set Up link, available under icons in
their upper right corner. For details, see Setting Up Dashboard Portlet Content.

For most content, you can display one portlet per dashboard on a standard NetSuite tab. The table
explicitly notes content that can be displayed in multiple portlets. Custom NetSuite tabs may have
multiple portlets with other content as well.
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Content Description

Calendar Lists activities for a selected period ordered by date and time, with links to drill
down into individual activity records.
In the portlet, you can select between a daily, weekly, monthly, or agenda view. You
can choose to display your own calendar or a public calendar for another entity
within the organization.
You can click the Set Up menu option for the portlet to display a popup where you
can define the types of activities to display in the calendar.
For more details, see Calendar Portlets.

Custom Portlet (Can display up to six.)
Shows results from a portlet SuiteScript, which can be lists, data entry forms, free-
form HTML, or links to external data.
In the portlet, click Set Up to select the source file for the SuiteScript results.
For information about creating scripts, see the help topic Portlet Scripts.

Custom Search (Can display up to six on the Home page.)
Shows results from a saved search.
In the portlet, click Set Up to select the saved search, specify a custom title for
the portlet, the number of results to display, whether to drill down into search
results in the portlet or on a new page, and, if the Inline Editing feature is enabled,
whether to enable inline editing of search results.

Note: When placed in the right or left columns of a dashboard, custom
search portlets display only the first 4 results columns of the saved search.
When placed in the center column, they display the first 9 results columns.
Custom search portlets also include New, Edit, and View columns with links
for each result record.

For more details, see the help topic Displaying Saved Search Results in Dashboard
Portlets.

KPI Meter (Can display up to three.)
Shows up to three graphical meters of key performance indicator (KPI) data.
In the portlet, select a KPI to display from the dropdown. Click Set Up to select date
range(s), highlighting, and comparison options. You also can click menu options to
print the KPI meter or download it to a PNG, JPG, PDF, or SVG file.
Choices of KPIs for a meter are limited to the KPIs displayed in the dashboard's Key
Performance Indicators portlet, plus the following: Actual vs. Forecast, Actual vs.
Quota, and Forecast vs. Quota.
For more information, see KPI Meters.

KPI Scorecard Shows a performance scorecard with comparisons of selected key performance
indicator (KPI) data.
In the portlet, click Set Up to select a KPI Scorecard and layout options.
For more information, see KPI Scorecards Overview.

Key Performance
Indicators

Shows key business metrics. These metrics are summary data from reports or
saved searches for selected date ranges, with options to show comparisons
between date ranges and to highlight results not meeting defined thresholds.
In the portlet, click Refresh to refresh all KPIs, or click the Refresh icon next to an
individual KPI to refresh one at a time. If available, click the Trend Graph icon next
to a KPI to view a popup trend graph of KPI data.
Click Set Up to select standard KPIs or custom KPIs based on custom saved
searches, define comparison and highlighting options, and define the appearance
of popup trend graphs.
For more information, see Key Performance Indicators Overview.

Links Shows links to pages that NetSuite has defined as related.

https://system.netsuite.com/app/help/helpcenter.nl?fid=chapter_N2989989.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N690632.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N690632.html
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Content Description

This portlet is available on the Activities, Cases, Customers, Lists, Reports, and
Transactions pages.
Unlike other portlets, which are column-oriented and sorted top to bottom, the
Links portlet is row-oriented and sorted left to right.

List Shows a list of records of a selected type, with links to view, and if you have
permission, to edit, individual records. Shows 9 columns when placed in the
center column of the dashboard; shows 4 columns when placed in the right or left
column.
In the portlet, click Set Up to select a type of record and the number of records
shown.
If the Inline Editing feature is enabled and you have permission, you can edit
records directly in the portlet. See the help topic Using Inline Editing.

Note: On some tabs, the available List portlets are configured to show
predefined types of records. For example, the Activities page offers Tasks
and Phone Calls list portlets.

My Login Audit Shows information about your login activity. You can display the My Login Audit
portlet on your dashboard to track your previous successful login, your previous
failed login, the IP address associated with your login activity, the date when your
password will expire, and other login information.

Note: The date and time displayed in the My Login Audit portlet is based
on the Time Zone preference you set on the General subtab at Home >
Set Preferences. For more information, see the help topic Setting General
Preferences.

For more information, see My Login Audit Portlet.

New Release Shows a summary of new features from the latest release of NetSuite, with links to
more detailed descriptions.

Phone Calls Shows a list of upcoming phone calls, with links to view, and if you have permission,
to edit, individual records.
In the portlet, select a view and a sorting method, and click Set Up to define the
number of phone calls shown.
If the Inline Editing feature is enabled and you have permission, you can edit
records directly in the portlet list.

Project Tasks (Available when the Project Management feature is enabled. To learn how to
enable Project Management, see the help topic Enabling Project Features.)
This portlet is available on the Projects tab.
Shows a list of project tasks with links to view, and if you have permission, to
edit, individual records. Shows project tasks assigned to you and other project
resources,
In the portlet, select a view and a sorting method. Click Set Up to define the
number of tasks shown.
For more information, see the help topic Tasks and Project Tasks Portlets on Your
Dashboard.

Quick Add Shows a form where you can quickly add records of a selected type.
In the portlet, click Set Up if you want to change the type of records to be added.
For more information, see Quick Add Portlet.

Quick Search Shows a form where you can quickly search for records of a selected type, using
one selected filter field and entered keywords.

https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N495192.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N475661.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N475661.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=chapter_4740572949.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N509646.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N509646.html
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Content Description

In the portlet, click Set Up to define the type of records to search, then enter
keywords in the portlet's text box and select a field name from the Search For
dropdown.
For more information about Quick Search, see the help topic Quick Search Portlet.

RSS/Atom Feed (Can display up to two.)
Shows RSS or Atom feed URL content, from an external Web site or HTML
document.
In the portlet, click Set Up to select display options and a URL. NetSuite provides a
number of standard RSS feed URLs, or you can choose Custom and enter another
URL.
For more information, see RSS/Atom Feed Portlets.

Recent Records Shows a list of records that you have recently created, modified, or viewed.
In the portlet, click the record to view it. If you have permission, an Edit link is also
available. You can click it to open the record in Edit mode.

Important: Recent record links are also listed in a menu under the clock
icon, to the left of the Home tab on every NetSuite page.

For more information, see Reviewing Recent Records.

Recent Reports (Available on the Reports tabbed page.)
Shows a list of reports that you have recently created, modified, or viewed.
In the portlet, click the report name to view the individual report.

Reminders Shows important tasks of selected types, usually that are past due or soon due to
be completed.
In the portlet, click Set Up to select types of reminders and to define the number of
days in advance that reminders should be shown. Click on a reminder to go to the
page where action needs to be taken.
For more information, see Setting Up Reminders.

Report Snapshots (Can display up to 10.)
Each added portlet provides a graphical or list summary of a selected standard or
custom report's data, with a link to view the underlying report.
In the portlet, you can select a date range for data and click thumbnails to choose
among chart types for graphical data. You can click Set Up to select the type of
display and other layout options, including chart themes. You also can click menu
options to print the report snapshot chart, download it to a PNG, JPG, PDF, or SVG
file, or view the underlying report results.
Report snapshot list text truncates at 25 characters when the report snapshot
portlet is in the left or right dashboard column. To avoid this truncation, place the
portlet in the middle column.
Report snapshot list amounts are rounded to the nearest whole number and do
not display decimal places.
For more information, see Report Snapshots Overview.

Scheduler (Available on the Activities page.)
Shows an interface where you can view others' schedules and add activities.

Note: This portlet cannot be removed or modified.

In the portlet, you can select the date and use the View Group dropdown menu
to select others' schedules. Click the buttons to create new events, add invitees or
resources.

Search Form Shows a form to search for records of a selected type. Filter fields are based on
system-defined defaults or a custom search form that you defined as preferred.

https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N643459.html
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Content Description

In the portlet, click Set Up to select the search form to be used. Click Full Search to
switch to the default search page for the selected record type. Click Edit to open
the definitions page for the selected search form and make edits.
See the help topic Adding Personalized Search Forms to NetSuite Pages.

Settings Shows links to user-level setup tasks.

Important: The contents of this portlet are system-defined. This portlet
cannot be removed or modified.

For more information, see Settings Portlet.

Shortcuts Shows links to selected pages, so you can navigate quickly to frequently used
pages.
In the portlet, click Set Up to reorder the listing of existing shortcut links or click
New Shortcut to add a shortcut, if you know the URL of the page. If you do not
know the URL, go to that page and click More > Add to Shortcuts in the upper right
corner of that page.
For more information, see Shortcuts Portlet.

Tasks Shows a list of upcoming CRM tasks assigned to you, with links to view, and if you
have permission, to edit, individual records.
In the portlet, select a view and a sorting method, and click Set Up to define the
number of tasks shown.
For more information, see the help topic Tasks and Project Tasks Portlets on Your
Dashboard.

Trend Graphs (Can display up to 5.)
Shows a chart of key performance indicator (KPI) data with a time-based X axis.
In the portlet, click thumbnails to choose among different chart types. You also
can change the graph's X axis scale by selecting different time intervals from
the dropdown list. Click Set Up to select a KPI to be graphed and layout options,
including chart themes. You also can click menu options to print the trend graph
chart or download it to a PNG, JPG, PDF, or SVG file.
For more information, see Trend Graphs.

Note: You can set chart theme preferences that define the default look and feel for dashboard
charts, including report snapshots and trend graphs. The Chart Theme preference sets the
shape and colors for chart data. The Chart Background preference sets the display behind the
data. See the help topic Setting Preferences for Appearance.

Personalizing Dashboards
NetSuite provides a default set of dashboard portlets for each tab in each center. Most default
dashboard configurations can be personalized. The Settings portlet and a few other portlets are
required on many dashboards and cannot be removed.

You may want to personalize only your home page dashboard, or you may want to change dashboards
on other pages that you use frequently. In addition to changing page content, you can go to Home
> Set Preferences to set personal preferences such as color scheme that apply to all pages. For
information, see the help topic Setting Personal Preferences.

If your administrator has published a dashboard for one of your NetSuite tabs, you may not be able to
personalize that page's dashboard yourself. If the published dashboard is in Locked mode, you cannot
make any changes to its content. If the published dashboard is in Add/Move Content mode, you can

https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N666481.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N509646.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N509646.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N479574.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=chapter_N475297.html
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add or move portlets but you cannot remove portlets from the dashboard. However, you can still set
personal preferences.

You can choose to use one, two, or three columns in a dashboard. The minimum required screen width
size when using a three-column layout is 1400 pixels. For more information, see Dashboard Layouts.

If you are an administrator, you can personalize your dashboard and then share it with users whose
roles share your center. For information, see Publishing Dashboards Overview.

■ Adding a Portlet to a Dashboard

■ Setting Up Dashboard Portlet Content

■ Arranging Dashboard Portlets

■ Selecting an Existing Search to be a Custom KPI

The Viewing link at the top right of the home page opens a popup window where you can select the
Date Range for all your portlet content at one time. If you use multi-book accounting, you can also
select the Accounting Book in this window. When you close the popup window, the link changes to
display your viewing options.

Dashboard Layouts
You can choose among four layout types for every page that supports dashboards. Select your
preference from the Layout dropdown list in the upper right of the page.

The available layout options are as follows:

■ Two-column, narrow on the left.

■ Two-column, narrow on the right.

■ Three-column, wide in the middle. For three-column layouts, the minimum screen width is 1400
pixels.

■ One-column.

Adding a Portlet to a Dashboard
You can add a portlet to a dashboard at any time, unless your administrator has published that
dashboard in Locked mode. If a dashboard is locked, you cannot personalize it by adding or removing
portlets.
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To add a portlet to a dashboard:

1. Click the Personalize Dashboard link in the Settings portlet or the Personalize link in the top
right corner of the page. The Personalize Dashboard palette opens at the top of the page.

The portlets that already appear on your dashboard are shown when you click the Currently
Used tab.

2. In the other tabs, click a portlet icon to add it to the top the page. The portlet automatically
selects the column with the width that is best suited to its content. If you prefer, you can drag
the portlet to a specific location.

■ The available portlet tabs are Standard Content, Report Snapshots, and Trend Graphs. You
may not have permission to add portlets from every tab.

■ Rest your pointer over a portlet icon to see popup help.

■ To learn more about portlet types, see Portlet Types Table and Dashboard Portlets.

■ For information about Report Snapshots, see Report Snapshots Overview.

■ For information about Trend Graphs, see Trend Graphs.

After you have added a portlet, you can modify its contents and layout and move it to another
location on the dashboard. For information, see Setting Up Dashboard Portlet Content and Arranging
Dashboard Portlets.

To delete a portlet from a dashboard:

There are two ways to remove portlets:

■ Click Remove in the portlet menu.

■ Click the portlet icon in the Currently Used tab of the Personalize Dashboard palette. As you move
your pointer over the portlet icons, the corresponding portlet on your page is outlined in red.
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Note: If you remove an Activities, Reminders, Key Performance Indicators, or Report Snapshot
portlet from your home page, alert emails no longer include information from the removed
portlet. For more information, see the help topic Setting Personal Preferences.

Some portlets cannot be removed from a dashboard. One of these is the Settings portlet. Your
administrator can also prohibit you from deleting a portlet.

Arranging Dashboard Portlets
You can arrange the portlets on your dashboard to best fit your needs. You can move portlets up or
down and from one column to another. For more information on Dashboard Layouts, see Dashboard
Layouts.

To move a portlet on the dashboard:

1. Move your pointer to the title of the portlet.

2. When the pointer changes to crossed arrows, drag the portlet to its new location.

Portlet content may change if you move a portlet from a wide column location to a narrow one.

■ The Key Performance Indicators portlet displays more data and options when it is placed in the
wide column than when in a narrow column. For more details, see Setting Up the Key Performance
Indicators Portlet.

■ Custom search and list portlets display only the first 4 results columns when they are placed in a
narrow column. When placed in the wide column, they display the first 9 results columns.

■ Report snapshot text truncates at 25 characters when the report snapshot portlet is in a narrow
dashboard column. To avoid this truncation, place the portlet in the wide column.

Setting Up Dashboard Portlet Content
As you add portlets to your dashboard, you can review the data and layout for each portlet. Initially,
portlets show default data or no data because you need to perform portlet setup tasks after you have
added portlets to a dashboard.

Most portlets have a menu that includes a Set Up link. When you click Set Up, a popup window opens
where you can define data and layout. The menu is located on the right side of the title bar:

https://system.netsuite.com/app/help/helpcenter.nl?fid=chapter_N475297.html


Setting Up Dashboard Portlet Content  10

Some portlets, such as the KPI Meter, also have dropdown lists where you choose portlet content.

Note: If a portlet does not contain a dropdown list or a menu with a Set Up link, its data and
layouts are not configurable.

The setup options for most portlets are self-explanatory. The following list includes brief tips about
setting up different portlets. Links to more detailed explanations are provided as needed.

■ Calendar – Select a calendar to display. By default, your calendar is shown. For details, see Calendar
Portlets.

■ Custom Portlet – Click Set Up to select the source file for the SuiteScript results to display. For more
information, see Custom Portlets.

■ Custom Search – Click Set Up to select the saved search and the number of results to display. You
can also give your portlet a custom title and choose whether to drill down into search results in
the portlet or on a new page. If Inline Editing feature is enabled, you can choose whether to enable
inline editing of search results. For more information, see Custom Search Portlets.

■ KPI Meter – From the dropdown list, select a KPI to display. Click Set Up to select date ranges,
comparison, and highlighting options. For more information, see KPI Meter Portlets.

■ KPI Scorecard – Click Set Up to select a KPI scorecard and define layout options. For more
information, see KPI Scorecard Portlet.

■ Key Performance Indicators – Click Set Up to select standard KPIs or custom KPIs based on custom
saved searches. After you select the KPIs, you can select comparison and highlighting options. For
more information, see Key Performance Indicators Portlet.

■ List – Click Set Up to select the type of record and the number of records to show. To edit records
directly in the portlet, enable the Inline Editing feature. See the help topic Using Inline Editing. For
more information on List portlets, see List Portlets.

■ Quick Add – Click Set Up to select the type of record to be added. For more information, see Quick
Add Portlet.

■ Quick Search – Click Set Up to define the type of records to search, then enter keywords in the
portlet's text box and select a field name from the Search For dropdown list. For more information,
see Quick Search Portlet.

■ Project Tasks – Add a List portlet to your dashboard, click Set Up in the portlet menu and choose
Project Task as List Type. For more information, see Project Tasks Portlets.

■ RSS/Atom Feed – Click Set Up to select a feed and set display options. NetSuite provides a
number of standard feeds, or you can choose custom and enter a URL for another feed. For more
information, see RSS/Atom Feed Portlets.

■ Reminders – Click Set Up to select types of reminders and to define the number of days in advance
that reminders should be shown. For more information, see Setting Up Reminders.

■ Report Snapshot – Select a date range for graphed data. If available, click Set Up to select a type of
display and other layout options. For more information, see Report Snapshot Portlets.

■ Search Form – If any of your saved searches is used as the preferred search form for a particular
record type, you can display this search form in a portlet on your dashboard. For more information,
see Search Form Portlet.

https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N495192.html
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■ Shortcuts – Click Set Up to reorder the listing of existing shortcut links. Click New Shortcut to add a
shortcut if you know the URL of the page. If you do not know the URL, go to the page, and click More
> Add to Shortcuts on that page. For more information, see Shortcuts Portlet.

■ Tasks – Select the Basic view to be able to display tasks assigned to other users in your system. For
details, see Tasks Portlet.

■ Trend Graph – Click Set Up to select a KPI to graph and layout options. To change the graph's X axis
scale, click on time period options in the portlet. For more information, see Trend Graph Portlets.

Calendar Portlets
Calendar portlets list your activities ordered by date and time, with links to drill down into individual
activity records. The calendar portlet is displayed by default on the Activities tab, and can be added to
dashboards on other tabs.

You can add multiple calendar portlets to each dashboard. They act independently of each other and
so provide the flexibility of displaying different calendar and time frame configurations on one page.

■  – Calendar portlets are standalone items. They can be set up to display other calendars and date
periods. For example, you may choose to display a Group calendar in the Monthly view to assist
with meeting scheduling.

■  – The center portlet is set up with a Weekly view of your personal calendar, providing a snapshot
of the week ahead.

In each calendar portlet, you can select among a daily, weekly, monthly, or agenda view. You also can
choose to display your own calendar or the public calendar for another entity within the organization.
See Toggling Calendar Portlet Settings.

To change the types of activities listed in a calendar portlet, click the Set Up menu option for the
portlet. See Choosing the Activities Shown in a Calendar Portlet.

You can print the details from a calendar portlet by clicking its Print menu option.

To add a Calendar portlet to a dashboard:

1. Click the Personalize link in the upper right corner of your dashboard or use the Personalize
Dashboard link in the Settings portlet.

2. On the Standard Content tab of the Personalize Dashboard palette, click the Calendar icon or
drag it onto the dashboard.
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Toggling Calendar Portlet Settings
In each calendar portlet, you can quickly toggle the following settings:

■ Displayed Calendar: By default, the calendar portlet displays My Calendar, a calendar of your own
activities. To display activities for another entity within your organization that has a public calendar,
click My Calendar and select that entity from the list. Entities with private calendars are not listed.
To learn how to make a calendar public, see the help topic Setting Calendar Preferences.

■ Calendar View: Daily, Weekly, Monthly, or Agenda.

If you want to change the default values for these settings, click the Calendar Preferences link in the
upper right corner of the Activities tab. For details about setting calendar preferences, see the help
topic Setting Calendar Preferences.

You can move the calendar forward and backward in time by clicking the > and < buttons.

Choosing the Activities Shown in a Calendar Portlet
You can click the Set Up menu option for a calendar portlet to bring up a popup where you can set the
types of activity records that are shown in the portlet. The Calendar popup may include the following
options:

■ Show Events – Enabled by default.

■ Show Blocking Tasks – Enabled by default.

■ Show Non-Blocking Tasks – Enabled by default. Non-blocking tasks are those that do not reserve
time. They appear first on your calendar on the day for which they are scheduled.

■ Show Blocking Phone Calls – Enabled by default.

■ Show Non-Blocking Phone Calls – Enabled by default. Non-blocking phone calls are those that do
not reserve time. They appear first on your calendar on the day for which they are scheduled.

■ Show Canceled Events – Disabled by default. If this option is enabled, canceled events display in the
calendar in strikethrough text.

■ Show Campaign Events – Disabled by default. Available if your role gives you access to Campaign
records.

https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N500263.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N500263.html
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■ Show Resource Allocations – Disabled by default. This option appears when you are designated
a project resource and have active allocations. If this option is enabled, the project name for each
allocation is displayed for each day you are allocated.

■ Show Weekends in Monthly View – Enabled by default.

■ Records to Display in Agenda View – Is set to Today’s Activities Only by default. Can be set to
Today’s and Upcoming Activities.

■ Number of Records to Display in Agenda View – Is set to 7 by default. This field must have a value
set.

Custom Portlets
Custom portlets enable you to display SuiteScript results on your dashboard.

To be able to use this portlet, you first need to create a SuiteScript portlet script. To learn how to create
portlet scripts, see the help topics Portlet Scripts and Portlet Script Type.

To add a custom portlet to your dashboard:

1. Click the Personalize link in the upper right corner of your dashboard or use the Personalize
Dashboard link in the Settings portlet.

2. On the Standard Content tab of the Personalize Dashboard palette, click the Custom Portlet
icon or drag it onto the dashboard.

3. To specify the script to be used by the portlet, click the Set Up link in the portlet or the portlet
menu, select the script from the Source list, and click Save.

Custom Search Portlets
You can configure custom search portlets to display saved search results on the home page dashboard.
Up to six custom search portlets can be used on the home page dashboard.

To add a Custom Search portlet to your dashboard:

1. Click the Personalize link in the upper right corner of your dashboard or use the Personalize
Dashboard link in the Settings portlet.

2. On the Standard Content tab of the Personalize Dashboard palette, click the Custom Search
icon or drag it onto the dashboard.

3. To specify which saved search to display, click the Set Up link in the portlet or the portlet menu,
select the search from the Search list, and click Save.

You can also add a custom title for your portlet and specify other display options. For more
details, see the help topic Displaying Saved Search Results in Dashboard Portlets.

When placed in the right or left columns of a dashboard, custom search portlets display only the
first 4 results columns of the saved search. When placed in the center column, they display the first 9

https://system.netsuite.com/app/help/helpcenter.nl?fid=chapter_N2989989.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_4387799288.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N690632.html
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columns. Custom search portlets also include New, Edit, and View columns with links for each result
record.

KPI Meter Portlets
A KPI meter portlet displays data for one of the KPIs included in the Key Performance Indicators
portlet.

To be able to add a KPI meter for a key performance indicator, you need to add and configure a Key
Performance Indicators portlet first. For more information, see Setting Up the Key Performance
Indicators Portlet.

To add a KPI Meter portlet to your dashboard:

1. Click the Personalize link in the upper right corner of your dashboard or use the Personalize
Dashboard link in the Settings portlet.

2. On the Standard Content tab of the Personalize Dashboard palette, click the KPI Meter icon or
drag it onto the dashboard.

3. In the portlet’s dropdown menu, select the key performance indicator to display it as a meter.

4. For additional display options, click the Set Up link in the portlet menu. You can modify the time
period, comparison, and highlighting options for this KPI meter.

To learn more about KPI meter portlets, see KPI Meters.

KPI Scorecard Portlet
KPI Scorecard portlets can display data comparisons across multiple key performance indicators (KPIs).
These comparisons are stored in NetSuite as separate KPI Scorecard records. You need to create a
KPI scorecard before you can add it to your dashboard. To learn how to set up a KPI scorecard, see
Creating a KPI Scorecard.

To add a KPI Scorecard portlet to your dashboard:

1. Click the Personalize link in the upper right corner of your dashboard or use the Personalize
Dashboard link in the Settings portlet.

2. On the Standard Content tab of the Personalize Dashboard palette, click the KPI Scorecard icon
or drag it onto the dashboard.

3. Click the Set Up link in the portlet or the portlet menu to configure the portlet.

4. Select the KPI scorecard to display and click Save. You can also set filtering and orientation
options, as well as choose to show or hide the date row or the trend graph icon.

For more information on adding KPI Scorecard portlets, see Adding a KPI Scorecard Portlet to a
Dashboard.
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Key Performance Indicators Portlet
Key Performance Indicators (KPIs) provide summaries of your forecast, pipeline, orders, cases, and
financial data right on your dashboard. Each KPI compares data based on reports over different time
ranges. You can use standard KPIs or create custom KPIs based on saved searches.

To add a Key Performance Indicators portlet to your dashboard:

1. Click the Personalize link in the upper right corner of your dashboard or use the Personalize
Dashboard link in the Settings portlet.

2. On the Standard Content tab of the Personalize Dashboard palette, click the Key Performance
Indicators icon or drag it onto the dashboard.

3. To configure the KPIs to be displayed, click the Set Up link in the portlet menu.

For more information about KPIs, see Key Performance Indicators Overview. To learn how to set up
custom KPIs, see Defining Custom KPIs.

List Portlets
List portlets can display records of a specific record type. You can choose among standard record
types (employees, activities, transactions, and many other) and custom record types created by you or
other users. You can also use this portlet to add new records of the selected record type. In addition to
viewing records, you can use this portlet to display the results of saved searches related to the record
type you selected.

To add a List portlet to your dashboard:

1. Click the Personalize link in the upper right corner of your dashboard or use the Personalize
Dashboard link in the Settings portlet.

2. On the Standard Content tab of the Personalize Dashboard palette, click the List icon or drag it
onto the dashboard.

3. To specify the type of records you want to be displayed, click the Set Up link in the portlet or the
portlet menu, select the record type from the List Type menu, and click Save.

To display the results of a saved search related to the record type you selected, use the portlet’s View
menu.

To create a new record of the selected record type, you can use a link in the portlet menu.

My Login Audit Portlet
The My Login Audit portlet shows information about your login activity. You can display the My Login
Audit portlet on your dashboard to track your previous successful login, your previous failed login, the
IP address associated with your login activity, the date when your password will expire, and other login
information.
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Note: The date and time displayed in the My Login Audit portlet is based on the time zone
you selected as your preference on the General subtab at Home > Set Preferences. For more
information, see the help topic Setting General Preferences.

To add the My Login Audit portlet to your dashboard:

1. Click the Personalize link in the upper right corner of your dashboard or use the Personalize
Dashboard link in the Settings portlet.

2. In the Standard Content tab of the Personalize Dashboard palette, click or drag and drop the
My Login Audit icon.

3. To configure the login information displayed in the My Login Audit portlet, click the Set Up link in
the portlet menu.

Choosing the Information Shown in the My Login Audit Portlet
You can click the Set Up menu option in the My Login Audit portlet to bring up a popup where you can
select the type of information that is displayed in the portlet. The My Login Audit Setup popup includes
the following subtabs:

■ Last Login — Select the information you want to display regarding your current and previous login.

■ Successful Logins — Select the information you want to display regarding your successful login
attempts.

■ Login Failures — Select the information you want to display regarding your failed login attempts.

■ Password Updates — Select the information you want to display regarding your login password.

■ Mobile Devices — Select the information you want to display regarding your mobile login attempts.

https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N475661.html
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■ Web Services — Select the information you want to display regarding your web service login
attempts.

For more information about the options listed in each subtab, refer to the field-level help.

For more information about your login credentials, see the help topic Email Address and Password:
Your Login Credentials.

Quick Add Portlet
You can use the Quick Add portlet to quickly add new records of a selected type from the dashboard
without shifting to another page. For example, a Sales Rep could create a new customer record from
the Home page, or a new task record from a customer page.

You can set up the Quick Add portlet to be used for a number of standard record types or for a custom
record type that you have defined as available for Quick Add. You also can edit the fields available in
the portlet for data entry.

To add a Quick Add portlet to a dashboard:

1. Click the Personalize link in the upper right corner of your dashboard or use the Personalize
Dashboard link in the Settings portlet.

2. On the Standard Content tab of the Personalize Dashboard palette, click the Quick Add icon or
drag it onto the dashboard.

3. To change the default record type, click the Set Up link in the portlet menu, select the record
type from the Quick Add: Type list, and click Save.

For more information, see Using Quick Add for Standard Records and Using Quick Add for Custom
Records.

Using Quick Add for Standard Records
Quick Add is available for the following standard record types:

■ Case

■ Contact

■ Customer

■ Event

■ Lead

■ Opportunity

■ Partner

https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N485109.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N485109.html
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■ Phone Call

■ Prospect

■ Task

■ Vendor

The fields in the Quick Add portlet for each standard record type are based on the Quick Add fields
defined for the user's preferred form for the record type, as defined on the Role setup page for the role
used to log in. Quick Add fields on standard forms are system-defined.

Note: Fields included in the Quick Add portlet are also available for Inline Editing when this
feature is enabled. For details, see the help topic Using Inline Editing.

The following table lists the default Quick Add fields for each supported record type. Fields listed in the
middle column cannot be removed from the Quick Add portlet. Note that field names may be slightly
different in your user interface.

Record Type Fields Required in Quick Add
Portlet

Other Default Quick Add Fields

Case Subject, Company, Incident Date Message, Contact

Contact Contact, Subsidiary (OneWorld
only)

Company, Job Title, Email, Phone

Customer Company Name, Subsidiary
(OneWorld only)

Customer ID, Web Address, Email, Phone

Event Title, Date, Start Time, End Time Location, Message

Lead Subsidiary (OneWorld only) Customer ID, Company Name, Web
Address, Email, Phone

Opportunity Company, Status, Expected Close,
Projected Total

Estimated Budget, Sales Readiness,
Buying Time Frame, Buying Reason, Title,
Details

Partner Partner ID, Partner Code,
Subsidiary (OneWorld only)

Company Name, Phone, Email

Phone Call Subject, Organizer, Date Phone Number, Transaction

Prospect Company Name, Subsidiary
(OneWorld only)

Phone, Email, Web Address

Task Title, Priority, Start Date, Due Date Insert Before

Vendor Vendor ID, Company Name,
Subsidiary (OneWorld only)

Email, Phone, Default Expense Account

Using Quick Add for Custom Records
You can set up custom records so that they are available to be added from the Quick Add portlet. You
need to enable the Allow Quick Add option for any custom record type for it to be listed in the Quick
Add Type dropdown list.

To enable Quick Add for a custom record:

1. Open the custom record type that you would like to use in the Quick Add portlet. Custom record
types are available at Customization > Lists, Records, & Fields > Record Types.

https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N495192.html
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2. Select the Allow Quick Add box.

By default, only the Name field is provided for custom record Quick Add portlet data entry. To
permit data entry for other custom record custom fields, you can enable the per field Allow
Quick Add option.

3. To enable Quick Add for a field, click that field on the Fields subtab. On the Display subtab of the
field settings page, select the Allow Quick Add option. Click Save to apply your settings.

4. Click Save to save the custom record type settings.

After you have enabled the Allow Quick Add option for the custom record type, you may need to
refresh the page to display the enabled fields in the Quick Add portlet.

Quick Search Portlet
You can add a Quick Search portlet to be able to search for general records or transaction records right
from your dashboard.

To add a Quick Search portlet:

1. Click the Personalize link in the upper right corner of your dashboard or use the Personalize
Dashboard link in the Settings portlet.
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2. On the Standard Content tab of the Personalize Dashboard palette, click the Quick Search icon
or drag it onto the dashboard.

3. By default, the portlet is configured to search over general records, such as customers, vendors,
items, activities, and other records.

To make this portlet search over transaction records, such as cash sales, purchase orders,
customer refunds, and other transactions, click the Set Up link in the portlet menu and select
Transaction from the Search Type menu.

To learn more about the Quick Search portlet, see the help topic Quick Search Portlet.

Project Tasks Portlets
If you use Project Management, you can add the Project Tasks portlet to display project tasks on your
dashboard. The portlet shows project tasks assigned to all resources and provides quick access to
project task information.

To add a Project Tasks portlet:

1. Click the Personalize link in the upper right corner of your dashboard or use the Personalize
Dashboard link in the Settings portlet.

2. On the Standard Content tab of the Personalize Dashboard palette, click the List icon or drag it
onto the dashboard.

3. Click the Set Up link in the portlet or the portlet menu and select Project Task from the List Type
list.

4. Click Save to update the portlet content.

If you use the Inline Editing feature, you can change a project task's status in the Project Tasks portlet.
Changes made to a task in the portlet are automatically changed on the task record. For more
information on inline editing, see the help topic Using Inline Editing.

You can also click Edit next to a task in the Project Tasks portlet to update the information on a project
task record. Use the portlet filter options to select the range of tasks to display in the portlet. Filter
selections are sticky changes, meaning your selections are saved until you change them.

RSS/Atom Feed Portlets
You can publish information from news sources on your dashboard. By default, NetSuite offers you
feeds by CNN, Reuters, Yahoo, CBS Market Watch, and more. In addition to the predefined feeds, you
also can choose to display custom RSS feeds from other sites, or to create a custom feed to publish
messages to users of your NetSuite account. Generally, you can include a maximum of two RSS/Atom
feeds per page.

https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N643459.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N495192.html
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Note: Currently, you can add only two RSS feeds each on the home tab and Issues tab (if
available). There is no limitation on the number of RSS feeds on custom tabs. For information,
see the help topic Creating Center Tabs.

To add an RSS/Atom feed portlet to a page:

1. Click the Personalize link in the upper right corner of your dashboard or use the Personalize
Dashboard link in the Settings portlet.

2. On the Standard Content tab of the Personalize Dashboard palette, click the RSS/Atom Feed
icon or drag it onto the dashboard.

To set up an RSS/AtomFeed portlet:

1. Click Set Up in the portlet menu to open the setup popup window.

2. Select an RSS feed from the Source list.

If you select one of the sources that NetSuite provides, the Feed URL field automatically contains
the correct URL.

If you select Custom, enter the URL of the feed in the Feed URL field. This URL can be from a
website or from your own set of HTML pages used as an RSS feed.

To find the URL for a website’s feed:

1. Go to the website, and look for an RSS/XML link or  icon.

2. Click the link or icon to open the feed page.

3. Copy and paste this page's URL into the setup window's Feed URL field.

To learn how to create your own custom RSS feed, see Creating Custom RSS/Atom Feeds.

3. In Number of Links, type the number of links you want to appear in the portlet.

4. If you want to display links only, without additional details, clear the Show Details box. The
details that are displayed depend on the RSS feed.

5. Click Save.

You now can see the feed information in the dashboard portlet.

If the portlet takes up too much space on your dashboard, click Set Up again and reduce the number of
links or clear the Show Details box.

https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N2890512.html
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Creating Custom RSS/Atom Feeds
You can create your own custom RSS/Atom feeds to publish information to users in dashboard
portlets. In this case, RSS/Atom Feed portlet displays links to HTML pages stored in the file cabinet with
brief descriptions of every page linked.

To create a custom feed, you must first create HTML documents containing the information to which
the RSS/Atom Feed portlet will link. Then you should upload these files to the file cabinet. Finally,
you need to create an RSS Feed record in NetSuite that will include the links to your HTML files. This
record also includes a definition of the audience for the file. The audience may include different roles,
employees, customers, and other entities.

To create a custom RSS/Atom feed:

1. Create a set of HTML documents outside of NetSuite that you will link to from an RSS/Atom Feed
portlet.

2. Go to Documents > Files > File Cabinet. Upload your HTML files.

3. For each file, click Edit and copy the file's URL.

4. Go to Lists > Web Site > RSS Feeds. Click New. The RSS Feed record stores the links and
information to display in your custom RSS/Atom Feed portlet.

5. In the Title field, enter a title for your feed. This title is displayed as the portlet title.

6. In the Alias field, enter a name to describe this feed in the custom RSS Feeds list.

7. In the Description field, enter a message describing this feed.

8. Check or clear the Available Externally box to define the audience for your feed:

■ If you clear this box, the RSS feed is available only to users with login access to your account,
and you must choose who can access this feed by selecting users on the Audience subtab.

■ If you check this box, all users will have access to this feed.

9. On the Items subtab, add the titles, descriptions, and URLs for each of your HTML files.

■ The Title appears as the link text in the RSS/Atom Feed portlet.

■ The Description field contains details about the content of the linked HTML page.

■ The URL field should contain the URL for the linked HTML file.

10. When you have added titles, descriptions, and URLs for all your HTML files, click Save.

Users in the defined audience now can choose to display the custom feed in an RSS/Atom Feed portlet
on their dashboards. For information, see RSS/Atom Feed Portlets. If you are an administrator, you can
publish your dashboard with this feed to users with other related roles. For information, see Publishing
Dashboards Overview.

Note: Currently, you can add only two RSS feeds each on the Home tab and Issues tab
(if available). You can get around this limitation by creating a custom tab, where there is no
limitation on the number of RSS feeds. For information, see the help topic Creating Center Tabs.

Reviewing Recent Records
The Recent Records portlet displays a list of records that you have recently created, modified, or viewed
with links that you can click for quick access to these records. Recent records are also listed on the
recent records menu, , on the left of the navigation menu.

The Recent Records portlet does not have a Set Up link, so you cannot change its contents.

In this portlet, as in others, the controls are hidden until you move your cursor over the portlet. Each
record includes a link to view the record. In addition, if you have edit permission for the record, an Edit
link appears to the right as shown in this screenshot.

https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N2890512.html
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The following screenshot displays the Recent Records menu available from the  icon on the
navigation menu. Click a link to display an individual record, or click All Recent Records to display a list
of all records you have used recently, in reverse chronological order.

Setting Up Reminders
You can set up reminders for important data or tasks in NetSuite. Reminders appear in the Reminders
portlet on dashboards. When you click a reminder in the portlet, you go to a page with more details
where you can take action as necessary.

For example, Wolfe Electronics has set up a reminder to receive orders. When there are orders to be
received, a reminder appears in the Reminders portlet. A user clicks the reminder and goes to the
Receive Orders page.

To add a Reminders portlet:

1. If you do not see any Reminders portlet on your dashboard, click the Personalize link in the
upper right corner of your dashboard. You can also use the Personalize Dashboard link in the
Settings portlet.

2. On the Standard Content tab of the Personalize Dashboard palette, click the Reminders icon or
drag it onto the dashboard.

To set up the Reminders portlet:

1. In the Reminders portlet’s menu, click Set Up.
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2. Click a reminder in the left list or drag it to the Current Selections list on the right.

The reminders are arranged alphabetically. Custom reminders are marked with .

The available system-defined reminders depend on your role and the features enabled in your
account. For a list of the reminders NetSuite offers, see System-Defined Reminders Table .
Custom reminders are available when saved searches to which you have access are marked as
available for reminders. For information, see Creating Custom Reminders.

3. You can change the order in which reminders appear in the Reminders portlet by dragging them
up or down in the list.

4. If you want a reminder to be used as a headline reminder, drag it under the Headline.

Headline reminders are displayed in the upper part of the portlet and use a more prominent
layout.

5. If you want the reminders to be shown even when there are no results to display, select Show
reminders with zero results.

6. When ready, click Save.

A count and a link is displayed for each reminder that has matching results. Click the reminder
link to display the related task or search results.

Note: To see continually updated results for reminders, refresh the portlet periodically.

You can apply highlighting rules to any of your reminders. Each highlighting rule adds a color indicator
to the reminder whenever the specified threshold is reached.

To set up highlighting rules:

1. In the Reminders portlet, point to a reminder you want to edit and click the edit icon .

2. To add a highlighting rule, click Add Rule, choose the color to use, and specify the threshold.
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You can specify as many rules as you need.

3. Click Save to apply the highlighting rules.

Reminder alerts
The Reminders portlet indicates if a specific Saved Search (both Standard or Custom Reminders) is
interrupted for any reason by a yellow triangle icon.

All other saved searches that finish successfully show a reminder count as expected. If you hover the
mouse over the icon, it shows a hint according to your role, permissions, and saved search ownership.

■ For Administrators, the message for errors for standard reminders appears as Unable to load.
Please contact Support.

■ For non-Administrators, a message of Unable to load. Please contact your Administrator will
appear.

■ For Administrators who are also owners, the message of Unable to load. Please modify your
search will appear.

■ For Administrators who are not owners, the message of Unable to load. Please contact the owner
or create a new reminder will appear.

■ For non-Administrators who are owners, the message of Unable to load. Please modify your
search will appear.

■ For non-Administrators who are owners and can perform search, the message View: Unable to
load. Please change to a role with sufficient permissions and modify your search will appear.

■ For non-Administrators who are not owners but can perform Search, the message Full: Unable to
load. Please contact the owner or create a new reminder will appear.

■ For non-Administrators who are not owners and cannot perform search, the message View: Unable
to load. Please contact your Administrator will appear.
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System-Defined Reminders Table
The following table describes reminders that may be available, depending on your role and the
features enabled in your account.

Note: Custom reminders may also be available to you. See Creating Custom Reminders.

For more information on setting reminders, see Setting Up Reminders.

Reminder Description

Allocation Schedules due Reminds you of allocation schedules that are due.

Amortization Entries
pending

Reminds you of amortization entries that are pending.
Clicking this reminder takes you to the Amortization Journal Entries page
filtered to show only transactions for the current period.

Assemblies to Build Reminds you of assembly work orders you need to enter.

Assemblies to Order Reminds you of assembly work orders to order.

   

Bills to Pay Reminds you of bills you need to pay. You can customize this reminder
by choosing how many days before the due date you would like this
reminder to appear. Clicking this reminder takes you to the page.

Calls that are overdue Reminds you of phone calls that are overdue.
Clicking this reminder takes you to a list of phone calls filtered to show
only calls that are overdue.

Calls to complete Reminds you of phone calls that are not complete.
Clicking this reminder takes you to a list of phone calls filtered to show
only calls you need to complete.

Campaigns to Email Reminds you of campaigns you need to email. Clicking this reminder
takes you to the Campaign Calendar page.

Campaigns to Print Reminds you of marketing campaigns you need to print.

Cases to respond to Reminds you of cases you need to resolve. Clicking this reminder takes
you to the Cases page. The number corresponds to the number of open
or escalated cases assigned to you and awaiting support reply.

Checks to Print Reminds you of checks you need to print. Clicking this reminder takes
you to the Print Checks and Forms page.

Commissions Rejected by
Accounting

Shows the number of commissions that have been rejected by the your
company's accounting department. Clicking this reminder takes you to
the Commissions list filtered to show only commissions that have been
rejected by accounting.

Credit Cards to Approve Reminds you of credit card payments you need to approve. Clicking this
reminder takes you to the Unapproved Payments Register.

Credit Memos to Print Reminds you of credit memos you need to print. Clicking this reminder
takes you to the Print Credit Memos page.

Customers to Bill Reminds you of customers that need to be billed. Clicking this reminder
takes you to the page you use for billing, which varies according to how
you process customer billing.

Customers to Renew Reminds you of the number of customers you need to renew. Clicking
this reminder takes you to the Customers & Projects page.
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Reminder Description

Direct Deposits Returned Reminds you of the number of returned Direct Deposits. Clicking this
reminder takes you to the View Direct Deposit Status page filtered to list
all payments returned with an Unreachable or Unknown Error status.

Direct Deposits to Approve Reminds you of direct deposits you need to approve. Clicking this
reminder takes you to the Approve Direct Deposit Payments page
filtered to list all payments pending approval.

Direct Deposits to Print Reminds you of direct deposit vouchers you need to print. Clicking this
reminder takes you to the Print Checks and Forms page.

Electronic Funds Transfers
Returned

Reminds you of the number of returned electronic funds transfers.
Clicking this reminder takes you to the View Electronics Funds Transfer
Status page filtered to list all payments returned with a Failed,
Unreachable or Unknown Error status.

Electronic Funds Transfers to
Approve

Reminds you of electronic funds transfer you need to approve. Clicking
this reminder takes you to the Approve Electronic Funds Transfers page
filtered to list all transfers pending approval.

Employees to Pay Reminds you of the number of employees awaiting a payroll run. You
can customize this reminder by choosing how many days before the next
pay period you would like this reminder to appear. Clicking this reminder
takes you to the Payroll Run page.

Employees to Review Reminds you of the number of employees you need to review. Clicking
this reminder takes you to your Employees list.

Employees with an Expiring
Authorization

Reminds you of employees who have authorizations expiring.

Employees with an Expiring
Visa

Reminds you of employees who have visas expiring.

Employees with an
Upcoming Anniversary

Reminds you of employees who have upcoming anniversaries.

Employees with an
Upcoming Birthday

Reminds you of employees who have upcoming birthdays.

Estimates to Print Reminds you of estimates you need to print. Clicking this reminder takes
you to the Print Estimates page.

Event Invitations to respond
to

Reminds you of invitations you need to respond to. Clicking this
reminder takes you to the Events List page.

Expense Reports to Approve Reminds you of expense reports you need to approve. Clicking this
reminder takes you to the Approve Expense Reports page.

Invoices Overdue Reminds you of overdue invoices. You can customize this reminder by
choosing how many days after the due date you would like this reminder
to appear. Clicking this reminder takes you to the Open Invoices report
filtered to show only invoices that are overdue.

Invoices Rejected Reminds you of invoices that were rejected.

Invoices to Approve Due to
Credit Hold

Reminds you of invoices that you must approve due to credit hold.

Invoices to Approve Due to
Inconsistent Payment Terms

Reminds you of invoices that you must approve due to inconsistent
payment terms.

Invoices to Approve Due to
Unknown Tax Amount

Reminds you of invoices that you must approve due to unknown tax
amount.
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Reminder Description

Invoices to Approve Reminds you of invoices that you must approve.

Invoices to Print Reminds you of invoices you need to print. Clicking this reminder takes
you to the Print Invoices page.

Items to Order Reminds you of items you need to order. Clicking this reminder takes
you to the Inventory Stock Status By Item list filtered to show only items
you need to order or build.

Journals to Approve Reminds you of journal entries to approve.

Memorized Transactions
due

Reminds you of memorized transactions that are due. You can customize
this reminder by choosing how many days before the due date you
would like this reminder to appear. Clicking this reminder takes you to
the Memorized Transactions page.

NetSuite System Alerts to
Acknowledge

Reminds you of problems encountered in processing transactions and
provides suggestions on how to resolve the problem.

Opportunities to Close Reminds you of the number of open opportunities. You can customize
this reminder by entering the number of days before the expected close
date you would like this reminder to appear. Clicking this reminder takes
you to a list of your open opportunities.

Orders to Fulfill Reminds you of sales orders you need to fulfill. Clicking this reminder
takes you to the Fulfill Sales Order page.

Orders to Pack Reminds you of sales orders you need to pack. Clicking this reminder
takes you to the Pack Orders page.

Orders to Receive Reminds you of the number of purchase orders you need to receive.
Clicking this reminder takes you to the Receive Purchase Orders page.

Orders to Ship Reminds you of sales orders you need to ship. Clicking this reminder
takes you to the Mark Orders Shipped page.

Out Of Stock eBay Auctions
to Delist

Reminds you of eBay auctions that have run out of stock. Clicking this
reminder takes you to the End eBay Auctions Early page.

Overdue Projects Reminds you of projects that are overdue. You can customize this
reminder by choosing how many days before the estimated end date
you would like this reminder to appear. Clicking this reminder takes
you to the Customer & Projects page filtered to show only the overdue
projects.

Paychecks to Print Reminds you of paychecks you need to print. Clicking this reminder takes
you to the Print Checks and Forms page.

Payments to Deposit Reminds you of payments you need to deposit. Clicking this reminder
takes you to the Deposit page filtered to show deposits you need to
make.

Payroll Batches to Commit Reminds you of payroll batches you need to commit. Clicking this
reminder takes you to the Payroll batch list where you can view or edit
each uncommitted payroll before committing.

Periods to Close Reminds you of accounting periods you need to close. You can
customize this reminder to remind you to close a period in a specific
number of days after the period ends. Clicking this reminder takes you
to the Manage Accounting Periods page.

Purchase Orders to Bill Reminds you of the number of purchase orders you need to bill. Clicking
this reminder takes you to the Bill Purchase Orders page.
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Reminder Description

Purchase Orders to Print Reminds you of purchase orders you need to print. Clicking this
reminder takes you to the Print Purchase Orders page.

Purchase Requests to
Approve

Reminds you of purchase requests entered by employees that you need
to approve. Clicking this reminder takes you to the Approve Purchase
Requests page.

Receipts to Print Reminds you of receipts to print.

Rejected Intercompany
Purchase Orders

Reminds you of the rejected intercompany purchase orders.

Rejected Intercompany
Vendor Returns

Reminds you of the rejected intercompany vendor returns.

Resource Allocations to
Approve

Reminds you of resource allocations that you need to approve.

Return Authorization
Requiring Revenue
Commitment Reversals

Reminds you of the number of sales orders that need revenue
commitments. Drills down to the Generate Revenue Commitment page.

Return Authorizations to
Approve

Reminds you of returns you need to approve. Clicking this reminder
takes you to the Approve Return Authorizations page filtered to show
only returns you need to approve.

Return Authorizations to
Print

Reminds you of return authorizations you need to print. Clicking this
reminder takes you to the Return Authorizations page where you can
select the authorization that needs to be printed.

Return Authorizations to
Receive

Reminds you of returns you need to receive. Clicking this reminder takes
you to the Receive Returns page.

Return Authorizations to
Refund

Reminds you of returns you need to refund. Clicking this reminder takes
you to the Credit Returns page.

Revenue Recognition Entries
pending

Reminds you of revenue recognition entries that are pending. Clicking
this reminder takes you to the Revenue Recognition Journal Entries page
filtered to show only transactions for the current period.

Sales Orders Requiring
Revenue Commitments

Reminds you of the number of sales orders that need revenue
commitments. Drills down to the Generate Revenue Commitment page.

Sales Orders to Approve Reminds you of sales orders you need to approve. Clicking this reminder
takes you to the Approve Sales Orders page filtered to show only sales
orders you need to approve.

Sales Orders to Bill Reminds you of sales orders you need to bill. Clicking this reminder takes
you to the Bill Sales Order page.

Sales Orders to Print Reminds you of sales orders you need to print. Clicking this reminder
takes you to the Print Sales Order page.

Solutions to Approve Reminds you of knowledge base solutions you need to approve.

SuiteBundles to Update Reminds you that one or more installed bundles have an updated
version available.
Clicking this reminder takes you to the Installed Bundles page, where
you can click links to update bundles.
This reminder is added by default for an account's administrators and
users with SuiteBundler permission when the first bundle is installed in
the account.

Tasks due today Reminds you of tasks assigned to you that are due today.
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Reminder Description

Clicking this reminder takes you to a tasks lists filtered to show only tasks
due today.

Tasks that are overdue Reminds you of tasks assigned to you that are overdue.
Clicking this reminder takes you to a tasks list filtered to show only your
overdue tasks.

Tasks to complete Reminds you of tasks assigned to you that are not complete.
Clicking this reminder takes you to a tasks list filtered to show only tasks
you need to complete.

Time Records to Approve Reminds you if you need to approve the time of subordinates. Clicking
this reminder takes you to the Approve Time task.

Transfer Orders to Approve Reminds you of transfer orders due to be processed. All transfer orders
that are pending approval or pending fulfillment are included in this
count. Clicking this reminder takes you to the Approve Transfer Orders
page.

Vendor Return
Authorizations to Approve

Reminds you of vendor returns you need to approve. Clicking this
reminder takes you to the Approve Return Authorizations page filtered
to show only returns you need to approve.

Vendor Return
Authorizations to Refund

Reminds you of vendor returns you need to refund. Clicking this
reminder takes you to the Refund Vendor Return Authorization page.

Vendor Return
Authorizations to Return

Reminds you of vendor returns you need to send. Clicking this reminder
takes you to the Ship Vendor Return Authorization page.

Work Orders to Build Reminds you of assembly work orders you need to build.

Work Orders to Close Reminds you of assembly work orders to close.

Creating Custom Reminders

If the reminders provided by NetSuite do not meet all of your needs, you can create your own
reminders and add them to the Reminders portlet on your dashboard. Each reminder is based on a
count of the results of a saved search.

To create a custom reminder, enable the Available for Reminders option on the saved search definition
page. After this option is enabled, the saved search is listed as a reminder on the Set Up Reminders
page, and you can choose to show it in the Reminders portlet.

To create a custom reminder:

1. Create a new saved search or edit an existing saved search. See the help topic Defining a Saved
Search.

2. On the saved search definition page, check the Available for Reminders box.

https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N676039.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N676039.html
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3. Make sure that the search name is suited for display in the Reminders portlet.

The search name is displayed in the Reminders portlet, with the format: <number_of_results>
<saved_search_name>

4. On the Results subtab of the saved search, check whether any summary types that group search
results are included.

■ Custom reminders work best for saved searches that do not have any grouped results
because reminders are based on a count of the number of results and only display when this
count is a non-zero integer.

■ If you set up a reminder for a saved search that groups results by a summary type other than
a count, the reminder does not display.

■ You can define a count for a grouped field to make the reminder display, but the reminder
result is affected by the grouping and may not include the total count of saved search results.

■ It may be best to remove summary types or recreate the search without summary types for
use as a reminder.

■ For information about grouping search results with summary types, see the help topic
Summary Types for Search Results.

5. Click Save to save the search.

To add a custom reminder to the Reminders portlet:

1. Go to your home page. If this page does not include a Reminders portlet, click Personalize
Dashboard and add it. See Setting Up Reminders.

2. In the Reminders portlet menu, click Set Up.

3. In the Type menu, select Custom.

The custom reminders available in your account are displayed. Each custom reminder is marked
with a  icon.

Note that all saved searches to which you have access are listed if the Available for Reminders
box is checked. The list is not limited to searches you have created. See the help topic Accessing
a Saved Search.

4. Click a reminder in the left list or drag it to the Current Selections list on the right.

5. You can change the order in which reminders appear in the Reminders portlet by dragging them
up or down in the list.

6. If you want a reminder to be used as a headline reminder, drag it under the Headline.

Headline reminders are displayed in the upper part of the portlet and use a more prominent
layout.

https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N659258.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N685689.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N685689.html
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7. If you want the reminders to be shown even when there are no results to display, select Show
reminders with zero results.

8. When ready, click Save.

The Reminders portlet displays a count of search results. Click a custom reminder to see detailed
search results and complete related tasks.

Note: If a custom reminder causes an error that prevents the Reminders portlet from
displaying reminder links properly, click Set Up in the Reminders portlet’s menu, remove the
reminder from the Current Selections list, and click Save.

Example Custom Reminder
Custom reminders are based on saved search results, which enables you to include more fine-tuned
reminders in your dashboard. This can be especially helpful when you need reminders for custom
record types, because system-defined reminders are not provided for custom records.

For example, if your account has an equipment custom record type that includes Last Service field, and
you are in charge of keeping Equipment services on regular basis, you can set up a saved search and
custom reminder to determine if the Last Service of Equipment is within the last Fiscal Year.

To set a custom reminder for servicing Equipment:

1. Go to Reports > Saved Searches > All Saved Searches > New, and choose Equipment.

2. A saved search definition page opens.

3. Enter a meaningful name for the search.

4. Check the Available for Reminders box.

5. On the Criteria subtab, define a filter for the Last Service field to include equipment records with
a Last Service is within last fiscal year.

6. On the Results subtab, choose the columns to be displayed in search results.

7. Save the search.
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8. Go to your Home page. If this page does not include a Reminders portlet, click Personalize
Dashboard and add it. See Setting Up Reminders.

9. In the Reminders portlet, click Set Up.

10. Click the new reminder on the left to move it to the right, and then click Save.

11. Review the Reminders portlet on your Home page.

12. Click the reminder link to see the list of expiring warranties and the information you need to
renew them.

Report Snapshot Portlets
Report Snapshot portlets can show summaries of some reports that are available to you. You can
choose among standard report snapshots or create custom report snapshots.

To add a Report Snapshot to your dashboard:

1. Click the Personalize link in the upper right corner of your dashboard or use the Personalize
Dashboard link in the Settings portlet.

2. On the Report Snapshots tab of the Personalize Dashboard palette, click the Report Snapshots
icon or drag it onto the dashboard.

3. Click the Set Up link in the portlet menu and select the report snapshot you want to display from
the Snapshot list.

4. Click Save to update the portlet content.

For a list of standard report snapshots, see Standard Report Snapshots Table.

To learn how to create custom report snapshots, see Creating Custom Report Snapshots.

For more information about report snapshots, see Report Snapshots Overview.

Search Form Portlet
If you have a saved search that is used as your preferred search form, you can add this search as a
portlet to your dashboard. To learn how to define a saved search as a preferred search form, see the
help topic Defining a Saved Search as a Preferred Search Form.

To add a Search Form portlet to your dashboard:

1. Click the Personalize link in the upper right corner of your dashboard or use the Personalize
Dashboard link in the Settings portlet.

2. On the Standard Content tab of the Personalize Dashboard palette, click the Search Form icon
or drag it onto the dashboard.

https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N680007.html
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3. Click the Set Up link in the portlet or the portlet menu and use the Search list to select the
search form you want to display in the portlet.

You can also display personalized search forms on your dashboard. For details, see the help topics
Personalizing a Search Form and Adding Personalized Search Forms to NetSuite Pages.

Settings Portlet
The Settings portlet shows links to user-level setup tasks. The links that appear in the portlet are
system-defined and cannot be edited, and the portlet itself cannot be removed from the dashboard.

The links that appear in the portlet vary by role and may include the following:

■ Personalize Dashboard — Opens the Standard Content tab of the Personalize Dashboard palette,
which lets you add portlets to the dashboard. For more information, see Personalizing Dashboards.

■ Set Preferences — Opens the Set Preferences page, which lets you edit your preferences for
different areas of NetSuite. For more information, see the help topic Setting Personal Preferences.

■ Change Email — Opens the Change Email page, which lets you change the email address associated
to your NetSuite account. For more information, see the help topic Change Email.

■ Change Password — Opens the Change Password page, which lets you change the password you
use to access NetSuite. For more information, see the help topic Change Password.

■ Update Security Questions — Opens the Update Security Questions screen, which lets you change
the security questions associated to your NetSuite account. For more information, see the help
topic Updating Security Questions.

Other links that may appear in the portlet depending on your permissions and the features that have
been enabled in your NetSuite account include:

■ Publish Dashboard — Opens the Publish Dashboard page, which lets you publish a dashboard for
other users who log in to the same center you are currently in. For more information, see Publishing
Dashboards Overview.

■ Set Up NetSuite for Outlook — Opens the Set Up NetSuite for Outlook page, which lets you access
the NetSuite for Outlook installer. Once installed, NetSuite for Outlook enables you to synchronize
your Microsoft Outlook™ email, events, contacts, and tasks with your NetSuite account. For more
information, see the help topic NetSuite for Outlook.

■ Set Up SuiteAnalytics Connect — Opens the SuiteAnalytics Connect Driver Download page, which
lets you download a SuiteAnalytics Connect Driver. Once downloaded and installed, the driver
enables you to connect to the Connect Service which, in turn, lets you archive, analyze, and report
on NetSuite data using third-party tools such as Microsoft™ Excel, BIRST and Adaptive. For more
information, see the help topic Introducing SuiteAnalytics Connect.

Note: If you do not see a link in the Settings portlet that you think you should have access to,
contact your system administrator.

Shortcuts Portlet
The Shortcuts portlet contains links that you can click for easy access to your most frequently used
records, transactions, lists, and/or reports. These same links also appear as options on the shortcuts
menu, the star icon , on the navigation menu.

https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N666183.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N666481.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=chapter_N475297.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N487532.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N487604.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N487931.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=chapter_4485066695.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=chapter_3963845427.html
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You can add, remove, and change the order of shortcut links in the Shortcuts portlet and shortcuts
menu. You can also set up shortcuts to open linked pages in new windows. Any changes you make are
applied to both the Shortcuts portlet and the shortcuts menu options.

For instructions on how to add the Shortcuts portlet to a page, see Adding a Portlet to a Dashboard.

Important: If you have added the Shortcuts portlet to more than one page, the portlet
always maintains the same links on every page. Any changes you make to the Shortcuts portlet
displayed on one page are applied automatically to the Shortcuts portlet displayed on any other
page and to the menu options listed on the shortcuts menu.

Adding Shortcut Links
You can use either of the following methods to add a link to the Shortcuts portlet and shortcuts menu.
Go to the page where you want the shortcut link to go, and click More > Add to Shortcuts. Or go to the
Shortcuts portlet itself, and click its New Shortcut link.

To add a shortcut from the page where you want the shortcut to go:

1. On the page's More menu, click Add To Shortcuts.

2. Edit name for the shortcut link. By default it is the name of the page.

3. If you want the linked page to open in a new window, check the Open in New Window box.

4. Click Save.

To add a shortcut from the Shortcuts portlet:

1. On the Shortcuts portlet, click New Shortcut on the portlet menu.

2. Enter a name for the shortcut link.

3. Enter the URL for the page. (If you do not know the page's URL, go to the page and use the Add
To Shortcuts link on the page instead.)

4. If you want the linked page to open in a new window, check the Open in New Window box.

5. Click Save.

Setting Up Shortcut Links
In the Set Up Shortcuts popup window, you can remove, reorder, and rename shortcuts. You can also
indicate that they should open in new windows.
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To remove a shortcut:

1. Click the Set Up link in the Shortcuts portlet menu or the Set Up Shortcuts option on the
shortcuts menu to open the Set Up Shortcuts popup window.

2. Clear the Enable box next to each shortcut that you want to remove.

Note: Shortcuts that were created when a dashboard was published for you appear
with asterisks. The publisher may have restricted these shortcuts so that you cannot
remove them.

3. Click Save.

To reorder shortcut links:

1. Click the Set Up link in the Shortcuts portlet menu or the Set Up Shortcuts option on the
shortcuts menu to open the Set Up Shortcuts popup window.

2. Click the shortcut row to select it. The selected row is highlighted and has a drag gripper,
outlined in red below.

3. Drag the shortcut row where you want it or use the Move to Top or Move to Bottom buttons.

4. Click Save.

To indicate that a shortcut's linked page should open in a new window:

1. Click the Set Up link in the Shortcuts portlet menu or the Set Up Shortcuts option on the
shortcuts menu to open the Set Up Shortcuts popup window.

2. Check the Open in New Window box next to the shortcut name, and click Save.
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To rename a shortcut link:

1. Click the Set Up link in the Shortcuts portlet menu or the Set Up Shortcuts option on the
shortcuts menu to open the Set Up Shortcuts popup window.

2. Change the name in the Label field, and click Save.

Note: The Shortcuts portlet may contain duplicate links if your administrator has published
a dashboard with links that match the custom links you have added. To eliminate duplicates,
remove your own custom links.

SuiteApp Portlets
If you have a dashboard-compatible SuiteApp installed in your account, you can display this SuiteApp
on your dashboard.

To be available as a dashboard portlet, a SuiteApp must meet the following requirements:

■ It must be installed in your account.

■ It must include a dashboard component.

To add a SuiteApp portlet:

1. Click the Personalize link in the upper right corner of your dashboard or use the Personalize
Dashboard link in the Settings portlet.

2. On the SuiteApps tab of the Personalize Dashboard palette, click the SuiteApp you want to add
or drag it onto the dashboard.

You can add up to six SuiteApp portlets to your dashboard.

For more information about SuiteApp portlets, see the help topic Displaying SuiteApps on Your
Dashboard.

Tasks Portlet
If you want to show a list of Tasks on your dashboard, you can add a Tasks portlet from the Personalize
Dashboard palette.

You can view tasks using the Dashboard view or the Basic view. Basic view enables you to filter tasks
by status and priority as well as view tasks assigned to other users by choosing the assignee from the
Assigned To list.

You can also sort tasks by: In Order, Due Date, Recently Created, Recently Modified, or Recently Viewed.

Trend Graph Portlets
Trend graphs show the differences in Key Performance Indicators (KPIs) data over time. You can add up
to five Trend Graph portlets to your dashboard.

https://system.netsuite.com/app/help/helpcenter.nl?fid=section_4629759056.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_4629759056.html
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To add a Trend Graph portlet to your dashboard:

1. Click the Personalize link in the upper right corner of your dashboard or use the Personalize
Dashboard link in the Settings portlet.

2. On the Trend Graphs tab of the Personalize Dashboard palette, click the Trend Graph icon or
drag it onto the dashboard.

3. Click the Set Up link in the portlet or in the portlet menu and use the KPI list to select the KPI to
be used for this trend graph.

To learn more about trend graphs and displaying them on your dashboard, see Trend Graphs.

Printing and Exporting Dashboard Content
You can print or export content from some dashboard portlets. These options are usually in the same
menu as the Set Up option in the portlets where they are available. The following table lists the portlets
that support these options.

Portlet Type Supported Print/Export
Options

Notes

KPI Meter ■ Print the chart

■ Download PNG image

■ Download JPG image

■ Download PDF document

■ Download SVG vector image

Available from portlet menu.

KPI Scorecard ■ Export (data to CSV file) Available from portlet menu.

Report
Snapshot

■ Print the chart

■ Download PNG image

■ Download JPG image

■ Download PDF document

■ Download SVG vector image

Available from portlet menu.

Trend Graph
Portlet

■ Export (data to CSV file)

■ Print the chart

■ Download PNG image

■ Download JPG image

■ Download PDF document

■ Download SVG vector image

Available from portlet menu.

Trend Graph
Pop-Up
Window

■ Export (data to CSV file)

■ Print the chart

■ Download PNG image

■ Download JPG image

■ The Trend Graph pop-up window is available on
some portlets, including KPI Scorecard and Key
Performance Indicators portlets.
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Portlet Type Supported Print/Export
Options

Notes

■ Download PDF document

■ Download SVG vector image

■ Export link is available from the Trend Graph
window.

■ Print and download options are available from
the Trend Graph window menu.

Customer Dashboards
NetSuite includes a specialized dashboard that is available for every customer (including leads and
prospects) in your system. The customer dashboard provides at-a-glance access to all of a customer's
data, so you do not need to search through multiple screens to gather and piece together the
information you need.

To open a dashboard for a customer, you can:

■ Click the View Dashboard icon on a Customer record or on a row in a customer list:

■ Enter dash:customer_name in the Global Search field at the top of the NetSuite page.

By default, a customer dashboard includes a Key Performance Indicators portlet displaying important
summary data for the customer, a Dashboard Links portlet with links to reports related to the
customer, and a list portlet displaying the customer's transactions, as well as other portlets. You can
personalize customer dashboard portlets' content and setup.

■ Choose Set Up from the portlet menu to modify the portlet’s configuration. For more information,
see Setting Up Dashboard Portlet Content and Setting Up the Key Performance Indicators Portlet.

■ To add portlets, see Adding a Portlet to a Dashboard.

You can add a custom portlet that displays results from a SuiteScript, such as custom lists, data
entry forms, or free-form HTML. To ensure that the custom portlet provides data for the selected



Customer Dashboards  40

customer, pass the customer's entity ID to the SuiteScript function. See the help topics Portlet
Scripts, Portlet Script Execution, and Displaying Portlet Scripts on the Dashboard.

A customer dashboard includes information about all transactions and activities for the customer's
related projects and subcustomers. The customer dashboard's Transactions portlet data is consistent
with the customer record's Transactions subtab data, and the customer dashboard's Key Performance
Indicators portlet data is consistent with the customer record's Financial subtab data.

Note that the setting for the Accept Payments Through Top-Level Customer preference affects
the rollup of data for some customer dashboard KPIs, in the same manner that it affects the
customer record's Financial tab data. For more information about this preference, see the help topic
Consolidated Payments.

https://system.netsuite.com/app/help/helpcenter.nl?fid=chapter_N2989989.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=chapter_N2989989.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N2990301.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N2990709.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N1288474.html
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Key Performance Indicators Overview
Key Performance Indicators, or KPIs, synthesize your raw data into critical business metrics that you
can see right on your dashboard in the formats you choose. KPIs enable you to spend more time
learning from and acting on important data and less time gathering it. NetSuite includes over 75
prepackaged KPIs based on NetSuite standard reports, including summaries of forecast, pipeline,
orders, cases, and financial data. You also can create custom KPIs, based on custom saved searches.

NetSuite provides the following types of dashboard portlets where you can display key performance
indicators:

■ Key Performance Indicators portlet. This portlet displays a summary line for each selected KPI,
with clickable links that drill down into each KPI's underlying data source.

□ For information about adding a Key Performance Indicators portlet to a dashboard, and
choosing KPIs and layout options for the portlet, see Setting Up the Key Performance Indicators
Portlet.

□ For a list of the standard KPIs available from NetSuite, see Standard Key Performance Indicators
Table.

□ For a summary of what you can see in the Key Performance Indicators portlet, see Viewing Key
Performance Indicator Data.

□ For tips on displaying your own KPIs, see Defining Custom KPIs.

■ KPI Meter portlet. This portlet displays a visual representation of KPI data, a semi-circular meter
providing comparison, date range, and threshold values at a glance. For more information, see KPI
Meters.

■ Trend Graph portlet. This portlet displays a chart of KPI data values over selected time intervals.
This chart type can be Area, Line, Bar, or Column. Comparisons can be shown in continuous or side-
by-side manner. Popup trend graphs also are available from clickable icons in the Key Performance
Indicators portlet and the KPI Scorecard portlet. For information, see Trend Graphs.

■ KPI Scorecard portlet. This portlet displays a performance scorecard that can include complex
comparisons among multiple KPIs over multiple date ranges or accounting periods. Scorecards also
can include Excel-like formulas with KPIs and functions in their expressions. For information, see KPI
Scorecards Overview.

KPIs are role-based and feature-based, meaning the KPIs that you can choose to display depend upon
the role you used to log in to NetSuite and the features that are enabled.

Setting Up the Key Performance Indicators Portlet
If you want to display KPI data on a dashboard, the first step is to add the Key Performance Indicators
portlet to the page if it is not already there.

When the Key Performance Indicators portlet appears on a page, you can click the portlet's Set Up link
and define its contents and layout in the Set Up Key Performance Indicators popup window.

The KPIs that are available to you in the Set Up Key Performance Indicators popup window depend
upon the role you used to log in to NetSuite and the features that are enabled.

For more information, see the following:

■ Adding the Key Performance Indicators Portlet

■ Making Changes to the Key Performance Indicators Portlet

■ Choosing KPIs and Setting Layout Options
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Adding the Key Performance Indicators Portlet

To add the Key Performance Indicators portlet:

1. Click the Personalize Dashboard link on the page.

2. Click or drag and drop the Key Performance Indicators item.

The portlet appears on the page, displaying default or previously selected KPI data.

Making Changes to the Key Performance Indicators Portlet
You can make the following changes to the Key Performance Indicators portlet:

■ You can select the standard and/or custom KPIs that appear in the portlet.

■ You can select the period of time for which you want KPI data to be synthesized.

■ You can choose to display comparisons of KPI data across different time periods, with percentage
changes calculated automatically.

■ You can choose to highlight displayed KPI data that exceeds or falls short of a threshold that you
define.

■ You can set some KPI data to appear in the portlet header.

■ You can determine the order in which KPIs appear in the portlet.

■ For KPIs that provide time-based comparisons of data, you can define layout options for the popup
trend graphs that are available from Trend Graph icons.

■ You may be able to choose whether to display data for all employees or employees in your team.

Choosing KPIs and Setting Layout Options

To define KPIs and layout options for the Key Performance Indicators portlet:

1. In the Key Performance Indicators portlet, click Set Up to open the Set Up Key Performance
Indicators popup.

2. To select standard KPIs for display in the portlet, click Add Standard KPIs to open the Choose
Standard Key Performance Indicators dialog.

■ Click a KPI in the left list to move it to the right list, which indicates that it should be displayed.

■ Click Done after you have finished selecting KPIs to display.

■ Selected standard KPIs are listed with question mark icons. Click these icons for KPI
descriptions. For a complete list of standard KPIs and their descriptions, see Standard Key
Performance Indicators Table.

3. To select saved searches to display as custom KPIs, click Add Custom KPIs to open the Choose
Custom Key Performance Indicators dialog.

■ Click a saved search in the left list to move it to the right list, which indicates that it should be
displayed as a custom KPI.

■ You can choose up to 10 custom KPIs.

■ Click Done when you have finished selecting KPIs for display.

■ Selected custom KPIs are listed with “c” icons. Click an icon for a brief general description of
custom KPIs. For more details, see Defining Custom KPIs.

4. For each selected KPI, in the Range list, select the date or period range for which data should be
included.
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5. For each selected KPI, if an Employees list is available, select one of the following:

■ All – Includes KPI data for all employees in your organization.

■ Only Mine – Includes data only from employees in your group in a selected KPI.

■ My Team’s – Includes only KPI data that is relevant to employees in your team.

6. For each selected KPI, in the Highlight If list, select greater than or less than if you want to
highlight data that exceeds or falls short of a defined threshold. If you do not want highlighting
for this KPI, leave the list blank.

■ If you have made a selection from the Highlight If list, specify the threshold number in the
Threshold column.

■ If you want the selected KPI data to be highlighted in the portlet’s header, select the check
box in the Headline column.

7. For each selected KPI, in the Compare column, check the box if you want to compare results
from the time period defined in the Range list with results from another period defined in the
Compare Range list.

8. For each selected KPI, in the Compare Range list, if you checked the Compare box, select the
date or period range for which data should be compared with data from the first range. If you
did not check the Compare box, you do not need to make a selection here.

9. You can remove a selected KPI from the Key Performance Indicators portlet by clicking its x
button at far right. Click Remove All button to remove all selected KPIs.

10. You can change the order in which KPIs appear in the Key Performance Indicators portlet by
using the Move To Top and Move To Bottom buttons or by dragging and dropping individual
KPIs.

■ To drag and drop a KPI, click it and hold down the mouse button until you see the crossed
arrows and the KPI is highlighted gray. Continue holding down the mouse button, moving the
pointer to the location where you want the KPI to appear. Then release the mouse button.

■ To use one of the Move buttons, select a KPI by clicking on it and holding down the mouse
button until you see the crossed arrows and the KPI is highlighted gray. Then click either of
the Move buttons.

11. To change display options for KPIs' popup trend graphs, click the Popup Trend Graphs subtab.

Check or clear the Show Moving Average, Show Last Data Point on Pop-Up Trend Graphs, or
Include Zero on Y-Axis boxes. You also can set the chart theme and background for all popup
trend graphs, as well as default chart type and time increment. For information about these
options, see Setting Up Popup Trend Graphs.

12. If you do not want the portlet content to be refreshed automatically when you log in to NetSuite,
select the Cached Data option.

This option also adds a time indicator that appears when you point to the portlet title, so you can
see when the portlet was last updated.

13. Click Save.

You can now review the data displayed in the Key Performance Indicators portlet. To make further
changes, click the portlet's Set Up link and redo the steps above as needed. For tips about what you can
do in the portlet, see Viewing Key Performance Indicator Data.

Viewing Key Performance Indicator Data
After you have added a Key Performance Indicators portlet to a dashboard, clicked the Set Up link, and
performed setup tasks on the Set Up Key Performance Indicators page, you can perform the following
functions from within the portlet or on the dashboard.
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View comparisons of data from different periods:
If you have defined time ranges for comparisons in the Set Up Key Performance Indicators page, you
can view percentage changes for KPIs. An arrow indicates the direction of each change, and positive
changes appear in green, whereas negative changes appear in red. For instructions for setting up
comparisons, see Setting Up KPI Comparisons.

View highlighted data:
If you have defined goal amounts as thresholds for KPIs in the Set Up Key Performance Indicators page,
you may notice that some KPIs appear in bold text with red flags because they have either exceeded or
fallen short of goals. For more information, see Highlighting KPIs.

Drill down to underlying data:
Each standard KPI's data is based on a snapshot of a NetSuite report. Each custom KPI's data is based
on a saved search. The Key Performance Indicators portlet provides multiple links for each KPI that you
can click to open its underlying report or saved search. You can find one of these links by moving your
cursor over a KPI and clicking when you see a pointing hand and underlined text.

Note: For KPIs based on financial and sales reports, totals are always rounded to the nearest
whole number currency amount. You can drill down to the report to view the exact totals for
that report.

View trend graphs:
For any KPI that includes a time-based comparison, you can click its Trend Graph icon to open a popup
trend graph for that KPI. You can change the time period graphed by clicking options in the graph's
popup window or change the graph's layout options in the Set Up Key Performance Indicators popup.
For more information, see Trend Graphs.
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Move the Key Performance Indicators portlet:
You can drag and drop the Key Performance Indicators portlet to move it to a different place on the
dashboard. Note that when this portlet is in the left or right column of your dashboard, its display is
condensed so that individual Refresh icons and headline comparisons are not available. For a fuller
display with these options, move the portlet to the center column.

Minimize the Key Performance Indicators portlet:
You can minimize the Key Performance Indicators portlet so that its data is not loaded immediately
when a page opens, avoiding a lot of waiting for slow-loading KPI data. To minimize the portlet, click
its title bar. When the page is loaded, you can click the portlet’s title bar again to display KPI data as
needed.

Change KPI data setup:
You can click the Set Up link in the portlet menu at any time to open the Set Up Key Performance
Indicators popup and change the contents and layout of the portlet.

Setting Up KPI Comparisons
A variety of date ranges is available for KPI comparisons. Many additional date ranges and period
ranges are available for comparisons in KPI scorecards. See Date Ranges for KPI Scorecards and Period
Ranges for KPI Scorecards.

To set up KPI comparisons:

1. Click Set Up in your Key Performance Indicators portlet’s menu.

2. In the Set Up Key Performance Indicators popup, if the KPI is not displayed, click Add Standard
KPIs or Add Custom KPIs , select the KPI, and click Done.

3. In the Range column for the KPI, choose the first period of time for which data should be
included in the KPI.

4. Check the box in the Compare column.

5. In the Compare Range column, choose the second time period for which data should be
included in the KPI (and compared with the first period's data).

6. Repeat steps 2 through 5 for each indicator that you want to include a comparison.

7. Click Save.

After these setup steps, the KPI in your Key Performance Indicators Portlet now displays columns for
the current period's metric, the previous period's metric, and the percentage change.

If you have set up a comparison for custom KPI and results are not displaying properly, the saved
search on which the custom KPI is based may not satisfy related requirements. The saved search
definition must:

■ Not include any date fields defined as filters on the Criteria subtab

■ Have only one field with a summary type (such as group, sum, or count) defined on the Results
subtab.

■ Have a date field defined as an available filter on the Available Filters subtab.

For more information, see Defining Custom KPIs.
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Highlighting KPIs
You can call out specific KPIs when they are above or below your goals, to more quickly notice and
manage business issues.

For example, Alexa Wolfe's goal this month is to have sales over $40,000. If her company reaches
this goal, she wants to reward her team with dinner. To see this information in her KPI portlet, Wolfe
chooses to highlight her Sales indicator when it is over $40,000.

To call out KPIs, you can define goal amounts as thresholds in the Set Up Key Performance Indicators
popup. Then, if the KPI amount is greater than or less than the defined threshold amount, the KPI is
highlighted in the Key Performance Indicators portlet, by appearing in bold text with a red flag. You also
can indicate that a highlighted KPI can be displayed as a headline for the Key Performance Indicators
portlet, meaning it is displayed at the top of the portlet in large, bold text.

To highlight KPIs:

1. Click Set Up in your Key Performance Indicators portlet.

2. In the Set Up Key Performance Indicators popup, if the KPI is not displayed, click Add Standard
KPIs or Add Custom KPIs, select the KPI, and click Done.

3. In the Range column for the KPI, select the date or period range you want to report on for this
metric.

4. In the Highlight If column, choose to call out this indicator if it is greater than or less than a
threshold you set.

5. In the Threshold column, enter the threshold this indicator must exceed or fall below to be
highlighted.

6. In the Headline column, check the box if you want this KPI to be displayed as a headline at the
top of the Key Performance Indicators portlet in large, bold text.

7. Repeat the preceding steps for each indicator you want to highlight.

8. Click Save.

After these setup steps, a KPI that either exceeds or falls short of its defined threshold value displays
in bold text. If the Headline box is checked, the KPI is also displayed as a headline for the Key
Performance Indicators portlet.
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Note: Up to four KPIs can be displayed as headlines.

Standard Key Performance Indicators Table
Depending on your role and your account's enabled features, some or all of the following table's KPIs
are available for display in the Key Performance Indicators portlet. If you see a KPI in the table that is
not available to you in NetSuite and that you would like to display, check with your administrator to see
if the related feature can be enabled, or if you can use another role to log in to NetSuite.

The table lists KPIs in alphabetical order.

KPI Description

Authorized
Commission

This indicator shows the total outstanding commission amount that has been
authorized but not paid, as of the selected date range.
Click this KPI's period or total to open the Authorized Commission Summary
Report.

Authorized Partner
Commission

This indicator shows the total outstanding commission amount that has been
authorized but not paid to partners, as of the selected date range.
Click this KPI's period or total to open the Authorized Partner Commission
Summary Report.

Average Days to Pay (Available on the Customer Dashboard only) This indicator shows the
customer's average number of days between invoice date and the payment
date for the selected period(s).
Click this KPI's periods or totals to open the A/R Aging Detail Report.

Average Days
Overdue

(Available on the Customer Dashboard only) This indicator shows the average
number of days that the customer had an overdue balance for the selected
period(s).
Click this KPI's periods or totals to open the A/R Aging Detail Report.

Balance (Available on the Customer Dashboard only) This indicator shows the current
dollar amount owed by the customer.
Click this KPI's periods or totals to open the A/R Aging Detail Report.

Bank Balance
(May display as Total
Bank Balance)

This indicator shows the total impact on bank accounts, as of the selected
period(s).
Click this KPI's periods or totals to open either the Balance Sheet Report or the
Bank Register Report. (Your account setup determines which report is the basis
for this KPI. Click the Support by Phone button to understand your account
settings.)

Cart Abandonment This indicator shows the percentage difference between the number of Web
store shopping carts filled and the number of orders actually placed during the
selected date range.
Click this KPI's periods or totals to open the Shopping Cart Abandonment
Report.

Cases Closed This indicator shows the number of cases closed during the selected date
range(s).
Click this KPI's periods or totals to open the Closed Cases Snapshot report.

Cases Escalated This indicator shows the number of cases that have been escalated within the
selected date range(s).
Click this KPI's periods or totals to open the Open Case Escalation Summary
Report report.

Checkout
Abandonment

This indicator shows the percentage of web store checkouts that were started
but not completed during the selected date range(s). This calculation divides
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KPI Description

the total number of times the checkout process was started by the number of
successfully completed checkouts.
Click this KPI's periods or percentage totals to open the Shopping Cart
Abandonment Report.

Closed Issues This indicator shows the number of issues that have been closed within the
selected date range(s).
Click this KPI's periods or totals to open the Closed Issues Summary Report
report.

COGS This indicator shows the dollar value of the cost of goods sold in transactions
during the selected period(s).
Click this KPI's periods or totals to open the Income Statement Report.

Consolidated Average
Days Overdue

(Available on the Customer Dashboard only, when the Consolidated Payments
feature is enabled.) This indicator shows the average number of days that
the customer and its subcustomers had an overdue balance for the selected
period(s).
Click this KPI's periods or totals to open the A/R Aging Detail Report.

Consolidated Balance (Available on the Customer Dashboard only, when the Consolidated Payments
feature is enabled.) This indicator shows the current dollar amount owed by the
customer and its subcustomers.
Click this KPI's periods or totals to open the A/R Aging Detail Report.

Consolidated Days
Overdue

(Available on the Customer Dashboard only, when the Consolidated Payments
feature is enabled.) This indicator shows the current number of days that the
customer and its subcustomers have had an overdue balance.
Click this KPI's period or total to open the A/R Aging Detail Report.

Consolidated
Overdue Balance

(Available on the Customer Dashboard only, when the Consolidated Payments
feature is enabled.) This indicator shows the amount of the current overdue
balance for the customer and its subcustomers.
Click this KPI's Current link or total to open the A/R Aging Detail Report.

Consolidated Unbilled
Orders

(Available on the Customer Dashboard only, when the Consolidated Payments
feature is enabled.) This indicator shows the total amount of orders for the
customer and its subcustomers that have been placed but not billed for the
selected period(s).
Click this KPI's periods or totals to open the Open Sales Orders Report.

Credit Card Balance This indicator shows the total impact on credit card accounts during the
selected period(s).
Click this KPI's periods or totals to open the Trial Balance Report.

Custom KPIs Each of these indicators shows a total or count based on the results of a saved
search. You add a custom KPI by selecting the saved search for which you want
to display results.
You can define up to 10 custom KPIs to display in the portlet.
Click a custom KPI's periods or totals to open its underlying saved search
results.

Days Overdue (Available on the Customer Dashboard only) This indicator shows the current
number of days that the customer has had an overdue balance.
Click this KPI's period or total to open the A/R Aging Detail Report.

Deferred Revenue This indicator shows the total credits and debits to deferred revenue accounts
during the selected period.
Click this KPI’s periods or totals to open the Balance Sheet Report.
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KPI Description

Employees This indicator shows the number of active employees included in payroll with a
hire date in the past and no release date, as of the selected date range(s).
Click this KPI's periods or totals to open search results of employees that meet
the above conditions.

Note: This KPI is intended to list employees from a payroll point
of view, so its results may differ from the complete list of employees
shown at Lists > Employees > Employees.

Equity This indicator shows the dollar value of assets less liabilities for the selected
period(s).
Click this KPI's periods or totals to open the Balance Sheet Report.

Estimated
Commission

This indicator shows the total value of estimated commissions for all
transactions in the selected date range(s). Only commissions earned by you and
your subordinates appear in this indicator.
Click this KPI's periods or totals to view the Estimated Commission Summary
Report.
See also Commission Overview Report.

Estimated Partner
Commission

This indicator shows the total estimated value of commissions earned by
partners for transactions during the selected date range(s).
Click this KPI's periods or totals to open the Estimated Partner Commission
Summary Report.
See also Commission Overview Report.

Expenses This indicator shows the total debits to income and expense accounts during
the selected period(s).
Click this KPI's periods or totals to open the Income Statement Report.

Fixed Assets This indicator shows the total dollar value of fixed assets, meaning durable
property or equipment that will not be used up or converted to cash within a
year, for the selected period(s).
Click this KPI's periods or totals to open the Trial Balance Report.

Forecast
(This KPI is labeled
Forecast (Billings)
on the Customer
Dashboard.)

This indicator shows total sales within the selected date range(s), including the
following transactions:

■ Total income and reimbursed expenses from customers

■ Total value of open estimates that are set to be included in the forecast and
are expected to close in the selected date range(s)

■ Total value of open opportunities that are expected to close in the selected
date range(s) and do not include an estimate that is set to appear in the
forecast

Note: The values of estimates and opportunities included in forecasts
depend on the preferences defined at Setup > Sales > Sales Preferences,
Forecasts subtab.

This KPI can display a comparison of two different date ranges if you have
enabled the Historical Metrics feature. The check box for this feature is
available under Setup > Company > Enable Features, in the Sales section of the
CRM subtab.
Click this KPI's periods or totals to open the Billings Forecast vs. Quota Report.

Forecast (Alt. Sales) This indicator shows the total sales forecast, based on alternate sales amounts
(ASA), for the selected date range(s).
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KPI Description

This KPI can display a comparison of two different date ranges if you have
enabled the Historical Metrics feature. The check box for this feature is
available under Setup > Company > Enable Features, in the Sales section of the
CRM subtab.
Click this KPI's periods or totals to open the Alt. Sales Forecast vs. Quota Report.

Note: When The ASA feature is enabled, sales reps can track two
different forecasts, one based on billings, and one based on ASA.

Forecast Override This indicator shows the total amount of sales your reps expect to bring in
during the selected date range(s).
The forecast amount shown is the sum of the forecast overrides for reps whose
supervisors have not entered forecast overrides.
Click this KPI's periods or totals to open the Billings Forecast vs. Quota Report.

Forecast Override
(Alt. Sales)

This indicator shows the total sales forecast for the selected date range(s),
based on the ASA override forecast amounts (ASA).
The override forecast reflects the ASA amount that sales reps predict they will
earn for the period. Sales managers can enter forecast override amounts to
account for deals that have not yet been entered as transactions, adjusting the
forecast amounts of sales reps based on reps' previous success at predicting
their sales.
Click this KPI's periods or totals to open the Alt. Sales Forecast vs. Quota Report.

Gross New Leads This indicator shows the total number of lead records created during the
selected date range(s).
Click this KPI's periods or totals to open the Gross Lead Source Analysis Detail
Report. This report differs from the Lead Source Analysis Detail Report because
it includes all leads, rather than those in a lead statuses marked to be included
in lead reports within the date range of the report.

Hosted Page Hits This indicator shows the number of pages your hosted Web site has displayed
during the selected date range(s).
Click this KPI's periods or totals to open the Hosted Page Hits Report.

Income This indicator shows the total credits to income, other income, and expense
accounts during the selected period(s).
Click this KPI's periods or totals to open the Income Statement Report.

Inventory This indicator shows the balance of the Inventory asset account and any Other
Current Asset account for which you checked the Inventory box on the account
record, for the selected date range(s).
Click this KPI's periods or totals to open the Inventory Valuation Report.

Long Term Liabilities This indicator shows the total dollar value of long term liabilities, meaning debts
payable over more than one year, for the selected period(s).
Click this KPI's periods or totals to open the Trial Balance Report.

My Utilization This indicator displays a user’s utilization.

Net Cash Flow This indicator shows the overall change in cash position during the selected
period(s).
Click this KPI's periods or totals to open the Cash Flow Statement Report.
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KPI Description

Important: If your Cash Flow Statement has been customized, the
KPI amount may differ from the amount shown on the report.

New Business This indicator shows the total of all sales transactions during the selected
period(s) for customers with first sales occurring in the period(s). For this
period-based analysis, orders must be actual.
Click this KPI's periods or totals to open the New Customer Sales Summary
Report.

New Business (Orders
Alt. Sales)

This indicator shows the dollar value of sales generated through sales orders
by new customers, based on alternate sales amounts (ASA), during the selected
period(s).
Click this KPI's periods or totals to open the New Customer Sales Orders
Summary Report.

New Business (Sales
Orders)

This indicator shows the amount of sales generated through sales orders by
new customers during the selected period(s).
Click this KPI's periods or totals to open the New Customer Sales Orders
Summary Report.

New Cases This indicator shows the number of new cases created during the selected date
range(s).
Click this KPI's periods or totals to open the New Cases Snapshot report.

New Customers This indicator shows the number of customers whose first sales transactions
closed in the selected period(s). For this period-based analysis, transactions
must be actual.
Click this KPI's periods or totals to open the New Customer Sales Summary
Report.

New Customers
(Sales Orders)

This indicator shows the number of sales orders generated by customers with
first sales transactions closing in the selected period(s).
Click this KPI's periods or totals to open the New Customer Sales Orders
Summary Report.

New Issues This indicator shows the total number of issues created within the selected date
range(s).
Click this KPI's periods or totals to open the New Issues Report.

New Leads This indicator shows the total number of lead records created during the
selected date range(s).
Click this KPI's periods or totals to open the Lead Source Analysis Summary
Report.

New Opportunities This indicator shows the total number of new opportunities created during the
selected date range(s).
Click this KPI's periods or totals to open results of an opportunity search filtered
for the selected date range.

New Visitors This indicator shows the total number of first-time visitors your Web site has
received during the selected date range(s).
Click this KPI's periods or totals to open the New Visitor Report.

Open Cases This indicator shows the number of open cases as of the selected date(s).
Click this KPI's periods or totals to open the Open Cases Snapshot report.

Open Estimates This indicator shows the number of estimates that were open during the
selected date range(s). Open estimates have a probability between 0% and
100%, and have not expired, been voided or have not been closed by an order
or actual.
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KPI Description

Click this KPI's periods or totals to open the Estimates to Close Report.

Open Issues This indicator shows the number of issues with a base status other than Closed
as of the selected date(s).
Click this KPI's periods or totals to open the Open Issues Summary Report
report.

Open Opportunities This indicator shows the number of open opportunities expected to close
within the selected date range(s). Open opportunities have probabilities
between 0 and 100%, and have not been converted to sales.
Click this KPI's periods or totals to open the Opportunities to Close Detail
Report.

Open Projects This indicator shows the current number of open projects.
Click this KPI's Current link or total to open the Projects list filtered to show only
open projects.

Open Prospects This indicator shows the number of open prospects as of the selected date(s).
Click this KPI's periods or totals to open the Open Prospects Snapshot report.

Open Quotes This indicator shows the number of open quotes for the selected period.
Click this KPI to see the Quotes to Close report. For more information about
quotes, see the help topic Quotes.

Operating Cash Flow This indicator shows the change in cash position, excluding financing and
investment activities, during the selected period(s).
Click this KPI's periods or totals to open the Cash Flow Statement Report.

Important: If your Cash Flow Statement has been customized, the
KPI amount may differ from the amount shown on the report.

Operating Expenses This indicator shows the dollar value of operating expenses during the selected
period(s).
Click this KPI's periods or totals to open the Income Statement Report.

Opportunities Lost This indicator shows the number of opportunities marked lost in the selected
date range(s). Lost opportunities have probabilities of 0%.
Click this KPI's periods or totals to open the Opportunities Lost Report.

Opportunities Won This indicator shows the number of opportunities that were won in the
selected date range(s). This number includes opportunities converted to sales
transactions and those with probabilities set to 100%.
Click this KPI's periods or totals to open the Opportunities Won Report.

Orders This indicator shows the number of approved sales orders placed in the
selected date range.
Click this KPI's periods or totals to open the Sales Orders by Customer
Summary Report.

Other Assets This indicator shows the total dollar value of assets other than current assets
and fixed assets, for the selected period(s).
Click this KPI's periods or totals to open the Trial Balance Report.

Other Current Assets This indicator shows the total dollar value of other current assets, meaning
owned assets that are expected to be converted to cash within one year, for the
selected period(s).
Click this KPI's periods or totals to open the Trial Balance Report.

Other Current
Liabilities

This indicator shows the total dollar value of other current liabilities, meaning
debts payable within one year, for the selected period(s).
Click this KPI's periods or totals to open the Trial Balance Report.
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KPI Description

Overdue Balance (Available on the Customer Dashboard only) This indicator shows the amount
of the customer's current overdue balance.
Click this KPI's Current link or total to open the A/R Aging Detail Report.

Paid Commission This indicator shows the total amount of commissions paid to employees
during the selected period(s).
Click this KPI's periods or totals to open the Paid Employee Commission
Summary Report.

Paid Partner
Commission

This indicator shows the total amount of commissions paid to partners during
the selected period(s).
Click this KPI's periods or totals to open the Paid Partner Commission Summary
Report.

Payables This indicator shows the total impact on A/P accounts during the selected
period(s).
Click this KPI's periods or totals to open the A/P Aging Summary Report.

Note: This KPI assumes that vendor payments use the same class
and department. If linked transactions use different classes and
departments, the KPI may display incorrect balances.

Payroll This indicator shows the total earnings amount from paychecks or year-to-date
adjustments within the selected period(s).
Click this KPI's periods or totals to open the Payroll Summary Report.

Pipeline (Alt. Sales
Projected)

This indicator shows the projected dollar value of open opportunities and open
estimates, based on alternate sales amounts (ASA), expected to close within the
selected date range(s). This summed value excludes the value of opportunities
with estimates set to be included in the forecast.
This KPI can display a comparison of two different date ranges if you have
enabled the Historical Metrics feature. The check box for this feature is
available under Setup > Company > Enable Features, in the Sales section of the
CRM subtab.
Click this KPI's periods or totals to open the Alt. Sales Pipeline by Sales Rep
Summary Report.

Pipeline (Alt. Sales
Weighted)

This indicator shows the weighted dollar value of open opportunities and open
estimates, based on alternate sales amounts (ASA), expected to close within
the selected date range(s). The weighted value is calculated by multiplying
probability by projected total. This value excludes the value of opportunities
with estimates set to be included in the forecast.
This KPI can display a comparison of two different date ranges if you have
enabled the Historical Metrics feature. The check box for this feature is
available under Setup > Company > Enable Features, in the Sales section of the
CRM subtab.
Click this KPI's periods or totals to open the Alt. Sales Pipeline by Sales Rep
Summary Report.

Pipeline (Projected) This indicator shows the total value of open opportunities and open estimates
expected to close within the selected date range(s). This value excludes the total
of opportunities with estimates set to be included in the forecast.
This KPI can display a comparison of two different date ranges if you have
enabled the Historical Metrics feature. The check box for this feature is
available under Setup > Company > Enable Features, in the Sales section of the
CRM subtab.
Click this KPI's periods or totals to open the Pipeline by Sales Rep Summary
Report.
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KPI Description

Pipeline (Weighted) This indicator shows the weighted value of open opportunities and open
estimates expected to close within the selected date range(s). This value
excludes the total of opportunities with estimates set to be included in the
forecast. The weighted value is calculated by multiplying probability times
projected total.
This KPI can display a comparison of two different date ranges if you have
enabled the Historical Metrics feature. The check box for this feature is
available under Setup > Company > Enable Features, in the Sales section of the
CRM subtab.
Click this KPI's periods or totals to open the Pipeline by Sales Rep Summary
Report.

Pipeline Deals This indicator shows the number of open opportunities and open estimates
expected to close within the selected date range(s). This number excludes the
number of opportunities with estimates set to be included in the forecast.
This KPI can display a comparison of two different date ranges if you have
enabled the Historical Metrics feature. The check box for this feature is
available under Setup > Company > Enable Features, in the Sales section of the
CRM subtab.
Click this KPI's periods or totals to open the Pipeline by Sales Rep Summary
Report.

Profit This indicator shows the difference between your income and expenses during
the selected period(s).
Click this KPI's periods or totals to open the Income Statement Report.

Quota This indicator shows the sum of all top-level quotas to which you have access,
for the selected date range(s). If an employee is assigned a personal quota and
a team quota, only the team quota is included in the sum.
Click this KPI's periods or totals to open the Billings Forecast vs. Quota Report.

Quota (Alt. Sales) This indicator shows the sum of all top-level quotas to which you have access,
based on alternate sales amounts (ASA), for the selected date range(s). If an
employee is assigned both a personal quota and a team quota, only the team
quota is included in the sum.
Click this KPI's periods or totals to open the Alt. Sales Forecast vs. Quota Report.

Quota Reps This indicator shows the number of sales reps that have been assigned quotas
as of the selected date(s).
Click this KPI's periods or totals to open the Quota Reps report.

Receivables This indicator shows the total impact on A/R accounts during the selected
period(s).
Click this KPI's periods or totals to open the A/R Aging Summary Report.

Revenue This indicator shows the total credits to income and expense accounts during
the selected period(s).
Click this KPI's periods or totals to open the Income Statement Report.

Sales
(This KPI is labeled
Sales (Billings)
on the Customer
Dashboard.)

This indicator shows total paid or billed income and reimbursed expenses for
customers during the selected period(s). It excludes the following transaction
types: Journal, Deposit, Credit Card, Credit Card Refund, and Check.
Click this KPI's periods or totals to open the Sales by Customer Summary
Report.

Sales (Cash Basis) This indicator shows total paid income and reimbursed expenses for customers
during the selected period(s). It excludes the following transaction types:
Journal, Deposit, Credit Card, Credit Card Refund, and Check. Income is only
counted in this KPI if it has been paid. Sales are included based on the date of
the payment.
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KPI Description

Click this KPI's periods or totals to open the Sales by Customer Summary – Cash
Basis report.
See also Setting Up Cash Basis Reporting.

Sales (Orders) This indicator shows the dollar value of sales generated through approved sales
orders during the selected date range(s).
Click this KPI's periods or totals to open the Sales Orders by Customer
Summary Report.

Sales (Orders Alt.
Sales)

This indicator shows the dollar value of sales generated through approved
sales orders, based on alternate sales amounts (ASA), during the selected date
range(s).
Click this KPI's periods or totals to open the Sales Orders by Customer
Summary Report.

Total Backlog
(Projects)

This indicator shows the total number of budgeted hours left to complete all
open projects.
Click this KPI's Current link or total to open the Current Backlog By Resource
Report report.

Total Bank Balance See Bank Balance.

Total Open Estimates This indicator shows the number of estimates that were open as of the selected
date(s). Open estimates have a probability between 0% and 100%, and have not
been closed by an order or actual.
Click this KPI's periods or totals to open the Total Open Estimates Report.

Total Open
Opportunities

This indicator shows the number of opportunities that were open as of the
selected date(s). Open opportunities have a probability between 0% and 100%,
and have not been closed by an order or actual.
Click this KPI's periods or totals to open the Total Open Opportunities Detail
Report.

Total Open Quotes This indicator shows the total number of open quotes for the selected period.
Click this KPI to see the Total Quotes report. For more information about
quotes, see the help topic Quotes.

Total Orders (Count) This indicator shows the number of sales orders placed during the selected
date range(s).
Click this KPI's periods or totals to open the Sales Order Register Report.

Total Pipeline (Alt.
Sales Projected)

This indicator shows the total projected dollar value of open opportunities and
open estimates based on alternate sales amounts (ASA), that are open as of
today, or as of the other dates selected.
This KPI can display a comparison for two different dates if you have enabled
the Historical Metrics feature. The check box for this feature is available under
Setup > Company > Enable Features, in the Sales section of the CRM subtab.
Click this KPI's periods or totals to open the Alt. Sales Total Pipeline by Sales Rep
Summary Report.

Total Pipeline (Alt.
Sales Weighted)

This indicator shows the total weighted dollar value of open opportunities and
open estimates, based on alternate sales amounts (ASA),that are open as of
today, or as of the other dates selected. The weighted value is calculated by
multiplying probability by projected total.
This KPI can display a comparison for two different dates if you have enabled
the Historical Metrics feature. The check box for this feature is available under
Setup > Company > Enable Features, in the Sales section of the CRM subtab.
Click this KPI's periods or totals to open the Alt. Sales Total Pipeline by Sales Rep
Summary Report.
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KPI Description

Total Pipeline
(Projected)

This indicator shows the projected value of open opportunities and estimates,
as of today, or as of the other dates selected. This value excludes the total of
opportunities with estimates set to be included in the forecast.
This KPI can display a comparison for two different dates if you have enabled
the Historical Metrics feature. The check box for this feature is available under
Setup > Company > Enable Features, in the Sales section of the CRM subtab.
Click this KPI's periods or totals to open the Total Pipeline by Sales Rep
Summary Report.

Total Pipeline
(Weighted)

This indicator shows the weighted value of open opportunities and estimates,
as of today, or as of the other dates selected. This value excludes the total of
opportunities with estimates set to be included in the forecast. The weighted
value is calculated by multiplying probability times projected total.
This KPI can display a comparison for two different dates if you have enabled
the Historical Metrics feature. The check box for this feature is available under
Setup > Company > Enable Features, in the Sales section of the CRM subtab.
Click this KPI's periods or totals to open the Total Pipeline by Sales Rep
Summary Report.

Total Pipeline Deals This indicator shows the total number of opportunities and estimates that are
presently open, as of today, or as of the other dates selected.
This KPI can display a comparison for two different dates if you have enabled
the Historical Metrics feature. The check box for this feature is available under
Setup > Company > Enable Features, in the Sales section of the CRM subtab.
Click this KPI's periods or totals to open the Total Pipeline by Sales Rep
Summary Report.

Total Sales (Orders) This indicator shows the total dollar value of sales, through both approved and
unapproved sales orders, during the selected date range(s).
Click this KPI's periods or totals to open the Sales Order Register Report.

Unbilled Orders (Available on the Customer Dashboard only) This indicator shows the total
amount of the customer's orders that have been placed but not billed for the
selected period(s).
Click this KPI's periods or totals to open the Open Sales Orders Report.

Unique Visitors This indicator shows the number of visitors your Web site has received during
the selected date range(s).
Click this KPI's periods or totals to open the Visitor Activity Summary Report.

Web Orders This indicator shows a count of web orders placed during the selected date
range(s).
Click this KPI's periods or totals to open the Item Orders Report.

Web Revenue This indicator shows the total credits to income and expense accounts from
Web orders during the selected date range(s).

Web Site Hits This indicator shows the number of pages your Web site has displayed during
the selected date range(s).
Click this KPI's periods or totals to open the Page Hits Report.

KPI Meters
You can add up to three KPI Meter portlets to a dashboard. Each meter visually represents data for one
KPI that is displayed in the dashboard's Key Performance Indicators portlet.
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Choices of KPIs for a meter are limited to the KPIs displayed in the dashboard's Key Performance
Indicators portlet, plus the following: Actual vs. Forecast, Actual vs. Quota, Forecast vs. Quota, and
Forecast vs. Quota (Alt. Sales).

Each KPI meter can show KPI data for one date range, a comparison of KPI data for two different date
ranges, or a flagged threshold value. By default, the meter shows comparisons or thresholds if they
are set up for the KPI in the Key Performance Indicators portlet. Whenever you change these options
in either the KPI meter or the Key Performance Indicators portlet, they are also changed in the other
portlet so that the two portlets remain in sync. You can, however, set up different options for the KPI
meter, for instance not showing a comparison in the KPI meter portlet but showing one in the Key
Performance Indicators portlet.

To set up a KPI Meter portlet:

1. Ensure that the KPI you want to display in the KPI meter is listed in the Key Performance
Indicators portlet. If it is not listed, click Set Up in the portlet menu. In the Set Up Key
Performance Indicators popup, click Add Standard KPIs or Add Custom KPIs , select the KPI, and
click Done. Click Save to add the selected KPI to the portlet.

2. To add a KPI Meter portlet to a page, click the Personalize Dashboard link. In the Add Content
Panel, click the KPI Meter icon or drag it onto the dashboard.

3. By default, the KPI Meter portlet displays a graph for the KPI that is listed first in the Key
Performance Indicators portlet. To change the KPI that the meter represents, select another KPI
from the portlet’s dropdown list.

If you select Actual vs. Forecast, Actual vs. Quota, Forecast vs. Quota, or Forecast vs. Quota
(Alt. Sales), the following message may appear: “No data available for this portlet.”

This message indicates that you need to add one or both of the underlying KPIs to the Key
Performance Indicators portlet to display the KPI meter.

To display this meter... Add these KPIs to Key Performance Indicators Portlet:

Actual vs. Forecast Sales, Forecast (Alt. Sales)

Actual vs. Quota Sales, Quota

Forecast vs. Quota Forecast (Alt. Sales), Quota

Forecast vs. Quota (Alt. Sales) Forecast (Alt. Sales), Quota (Alt. Sales)

To add these KPIs to the Key Performance Indicators portlet, click the Set Up link in the portlet
menu, click the Add Standard KPIs button, select each KPI from the box, click Done, and click
Save. For more information, see Setting Up the Key Performance Indicators Portlet.
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4. To change the meter's settings for showing comparison or threshold highlighting, click the Set
Up link in the portlet menu, make changes in the Set Up KPI Meter popup, and click Save.

You can also print the KPI Meter or download it to a file, using the options in the portlet menu.

You can change the position of the KPI Meter portlet on your dashboard by dragging it to a different
location. For more information, see Arranging Dashboard Portlets.

Important: If you have selected a custom KPI to display in a KPI meter and its results do not look
correct, the saved search on which the custom KPI is based may not satisfy related requirements. The
saved search definition must:

■ Not include any date fields defined as filters on the Criteria subtab

■ Have only one field with a summary type (such as group, sum, or count) defined on the Results
subtab.

■ Have a date field defined as an available filter on the Available Filters subtab.

For more information, see Defining Custom KPIs.

Trend Graphs
NetSuite's dashboard trend graphs can be used to illustrate the differences in KPI data values over
time.
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Trend graphs offer choices to display data in Area, Line, Bar, or Column charts, and to use continuous
or side-by-side comparisons. You can click thumbnails to shift among these choices.

You can also use the dropdown list to set the time period for trend graph data.

When you roll over a point in a trend graph, its value displays:
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Trend graphs are available in two display modes: popup trend graphs and trend graph portlets. You can
set layout options for both types of trend graphs. Both also offer options to print charts, to download
charts to PNG, JPG, PDF, and SVG files, and to export chart data to CSV files.

For more information, see the following topics:

■ Displaying Popup Trend Graphs

■ Displaying Trend Graph Portlets

■ Displaying Custom KPI Results in Trend Graphs

Displaying Popup Trend Graphs
Popup trend graphs are available from clickable Trend Graph icons in the Key Performance Indicators
portlet and the KPI Scorecard portlet.

■ To enable this icon for a KPI in the Key Performance Indicators portlet, you need to set up a time-
based comparison for it in the Set Up Key Performance Indicators popup. For information, see
Setting Up KPI Comparisons.

■ In KPI Scorecard portlets, trend graph icons are usually enabled when the portlet is set to display
KPIs on the left. However, when the portlet is set to display date ranges on the left, you may need to
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click Set Up in the KPI Scorecard portlet to open the KPI Scorecard Setup popup and select the Show
Trend Graph Icon check box. For information, see Adding a KPI Scorecard Portlet to a Dashboard.

When you click a Trend Graph icon, a popup trend graph displays data.

■ You can set display options for all popup trend graphs in the Popup Trend Graphs subtab of the Set
Up window of the Key Performance Indicators portlet. For more information, see Setting Up Popup
Trend Graphs.

■ Each popup trend graph includes buttons you can click to print the trend graph chart, or to
download it to a PNG, JPG, PDF, or SVG file, and an Export link you can click to export chart data to a
CSV file.

Displaying Trend Graph Portlets
You can add up to five trend graph portlets to any standard or custom dashboard, by clicking Trend
Graphs icons in the Personalize Dashboard panel or dragging them onto the dashboard. Each trend
graph portlet includes a Set Up link that you can click to set display options for that trend graph only.
For more information, see Setting Up Trend Graph Portlets. Additional menu options enable you to
print the trend graph chart, to download it to a PNG, JPG, PDF, or SVG file, and to export chart data to a
CSV file.
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Displaying Custom KPI Results in Trend Graphs
■ A custom KPI can be displayed in a trend graph portlet if the saved search on which this custom KPI

is based:

□ Does not include any date fields defined as filters on the Criteria subtab

□ Has exactly one field with a summary type (such as group, sum, or count) defined on the Results
subtab. The rest of the fields on the Results subtab should not use any summary types.

□ Has a date field defined as an available filter on the Available Filters subtab.

■ Custom KPIs can only be displayed in trend graph portlets on pages that include a Key Performance
Indicators portlet.

■ When a KPI is set to Custom KPI #1-#10, the Default Trend Type dropdown will display saved
searches, which meet criteria used in trend graphs.

For more information, see Defining Custom KPIs.

Setting Up Popup Trend Graphs
You set display options for popup trend graphs on the Popup Trend Graphs subtab of the Set Up
Key Performance Indicators popup. These options apply to all popup trend graphs for both the Key
Performance Indicators portlet and the KPI Scorecard portlet.

You also can reset the time interval for each graph's x-axis directly in each trend graph popup.

For more information, see the following topics:

■ Making Popup Trend Graphs Available

■ Setting Up Popup Trend Graph Display Options
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Making Popup Trend Graphs Available
■ To make popup trend graphs available from the Key Performance Indicators portlet, ensure that the

portlet displays the KPI for which you want to view a popup trend graph, and that you have set up a
date range comparison for the KPI. For information, see Setting Up the Key Performance Indicators
Portlet.

■ Popup trend graphs are available for KPIs in a KPI Scorecard portlet that is set to display KPIs on the
left. If your KPI Scorecard portlet is set to display date ranges on the left, you need to click the Set
Up link in the portlet’s menu and select the Show Trend Graph Icon box. For information, see Adding
a KPI Scorecard Portlet to a Dashboard.

Setting Up Popup Trend Graph Display Options
You can define display options for popup trend graphs on the Popup Trend Graphs tab of the Set Up
Key Performance Indicators window that is displayed when you click the Key Performance Indicators
portlet's Set Up link.

Note that the options you set here apply to ALL popup trend graphs available from both the Key
Performance Indicators portlet and the KPI Scorecard portlet.

To set up a popup trend graph:

1. Click Set Up in the Key Performance Indicators portlet to open the Set Up Key Performance
Indicators popup.

2. Click the Popup Trend Graphs subtab. You can set the following options.
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1. Select from the Default Chart Type list to set the default chart used for all popup trend
graphs.

■ Chart type options are Area, Line, Bar, and Column.

■ You can click thumbnails in an individual trend graph to change its chart type from the
default set here.

In addition to the set of four chart type thumbnails on the left, each popup trend
graph includes two thumbnails that you can click to choose either a continuous or
side-by-side comparison of data in the trend graph.

2. Select from the Default Time Increment list to set the default time interval used for all
popup trend graph comparisons.

■ Choices usually include Daily, Weekly, Monthly, Quarterly, and Yearly.

■ You can change this default in an individual trend graph by selecting from its time
interval dropdown.

3. Review the following options, and check or clear boxes as desired.

■ If the Show Moving Average option is enabled, all popup trend graphs display a
dotted line representing the rolling average of KPI data values. This option is enabled
by default.

■ If the Show Last Data Point on Pop-Up Trend Graphs option is enabled, all popup
trend graphs display the most recent KPI data point. Because the last point may not
provide complete data, you may want to exclude this point from the graph to avoid a
misleading display. This option is enabled by default.

■ If the Include Zero on Y-Axis option is enabled, the first y-axis value for all popup
trend graphs is set to zero, rather than to the initial KPI data point. This option is
disabled by default, to avoid showing misleadingly dramatic increases in initial trend
graph data.

4. Enter a number in the Period to Calculate Moving Average field.

■ This number indicates the number of data points to use in calculating the slope of the
moving average line in popup trend graphs.

■ Note that the lower the number here, the greater the slope of the line.

■ You can enter the number that represents the window of data you want to average
based on the time increment selected. For example, if you select Monthly and enter 3
as your window, each data point on your Y-axis represents a 3 month average.

5. Select from the Chart Themes list to set a look and feel for popup trend graph data:

■ Global Theme – uses the chart theme selected at Home > Set Preferences.

■ Basic – provides limited color contrast.

■ Colorful – provides more color contrast.

■ Match Color Theme - Bold – harmonizes with your choices in the Colors section of
the Set Preferences page using bolder shades.

■ Match Color Theme - Light – harmonizes with your choices in the Colors section of
the Set Preferences page using lighter shades.

6. Select from the Chart Background list to set the display behind popup trend graph data:

■ Global Background – uses the chart background set at Home > Set Preferences.
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■ Lines – provides lines that demarcate different levels along the Y-axis.

■ Bands – provides bands that demarcate different levels along the Y-axis.

■ Grid – provides a grid all throughout the Y-axis.

7. You can also specify a custom color for the trend graph line by typing its hexadecimal
code in the Custom Series Color field or by clicking the palette button that appears when
you hover over this field.

3. Click Save.

Note: A custom KPI will not display properly in a popup trend graph if the saved search on
which it is based does not meet related requirements. For information, see Displaying Custom
KPI Results in Trend Graphs.

Setting Up Trend Graph Portlets
You can add up to five trend graph portlets to any standard or custom page, by clicking or dragging and
dropping KPIs in the Trend Graphs folder of the page's Add Content panel. Each trend graph portlet
includes a Set Up link that you can click to set display options for that trend graph only.
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To set up a trend graph portlet:

1. Click the Personalize link in the upper right corner of a page or in the Settings portlet.

2. On the Trend Graphs subtab, click a Trend Graph icon or drag it onto the dashboard.

3. Click the Set Up link in the trend graph portlet’s menu.

4. Select a standard or a custom KPI from the KPI dropdown list.

Important: Custom KPIs are only available in trend graph portlets on pages that
include a Key Performance Indicators portlet.

5. You can also edit the following settings:

1. Select from the Default Chart Type list to set the default chart type displayed in this
portlet.

■ Chart type options are Area, Line, Bar, and Column.

■ You can click thumbnails in the portlet itself to dynamically change its chart type from
the default set here.

In addition to the set of four chart type thumbnails on the left, each trend graph
portlet includes two thumbnails that you can click to choose either a continuous or
side-by-side comparison of data in the trend graph.

2. If you selected a custom KPI, select a saved search from the Default Trend Type
dropdown list. If a saved search is not available, or returns an error when you select it,
its definition may not meet requirements for trend graph display. For information, see
Displaying Custom KPI Results in Trend Graphs

3. Select from the Trend Type list to indicate whether the graph's x-axis time scale should
be daily, weekly, monthly, quarterly, or yearly. You also can set this option by selecting
from a dropdown list in the portlet.

4. Check the Show Moving Average box to display a dotted line in the trend graph,
representing the rolling average of KPI data values. This option is enabled by default.

5. In the Period to calculate moving average field, enter the number that represents the
window of data you want to average based on the date range selected in the Trend Type
field. For example, if you select monthly and enter 3 as your window, each data point on
your y-axis will represent a 3 month average.

6. Check the Show Last Data Point box to display the most recent KPI data point in the
trend graph. Because the last point may not provide complete data, you may want to
exclude this point from the graph to avoid a misleading display. This option is enabled by
default.

7. Check the Include Zero on Y-Axis box to set the first y-axis value for the trend graph to
zero, rather than to the initial KPI data point. This option is disabled by default, to avoid
showing misleadingly dramatic increases in initial trend graph data.

8. Select from the Chart Theme dropdown to set a look and feel for chart data:

■ Global Theme – uses the chart theme set at Home > Set Preferences (the default). See
the help topic Setting Preferences for Appearance.

■ Basic – provides limited color contrast.

■ Colorful – provides more color contrast.

https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N479574.html
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■ Match Color Theme - Bold – harmonizes with your choices in the Colors section of
the Set Preferences page using bolder shades.

■ Match Color Theme - Light – harmonizes with your choices in the Colors section of
the Set Preferences page using lighter shades.

9. In the Custom Series Color field, enter a hexadecimal value for a custom color you want
to use for the chart. (Note that this option is provided for backwards compatibility with
custom chart colors defined prior to the introduction of chart themes in Version 2012
Release 2.)

10. Select from the Background Type dropdown to set the display behind chart data:

■ Global Background – uses the background type set at Home > Set Preferences (the
default).

■ Lines – provides lines that demarcate different levels along the Y-axis.

■ Bands – provides bands that demarcate different levels along the Y-axis.

■ Grid – provides a grid all throughout the Y-axis.

6. When you are done, click Save. The portlet refreshes itself.

Note that each trend graph portlet includes menu options to print the chart, to download it to a PNG,
JPG, PDF, or SVG file, and to export its data to a CSV file.

Defining Custom KPIs
NetSuite provides over 75 standard KPIs that you can display in a dashboard's Key Performance
Indicators portlet, or use for calculations in a KPI scorecard. These standard KPIs provide quick
summaries of standard NetSuite report data and enable you to drill down into the full reports for more
detail.

You may have other important data that you would like to display as a KPI on your dashboard, that is
not available from standard reports. In this case, you can find a preexisting saved search that compiles
this data or create a new saved search for this purpose.

For information, see:

■ Selecting an Existing Search to be a Custom KPI

■ Creating a New Search to be a Custom KPI

After you have identified an appropriate saved search, you can define it as a data source for a custom
KPI.

■ You can display up to ten custom KPIs in each Key Performance Indicators portlet. When a custom
KPI is displayed in the portlet, you can click it to drill down to detailed results from its saved search,
and click a Trend Graph icon to display its data in a popup trend graph. For information, see Adding
a Custom KPI to the Key Performance Indicators Portlet.

■ You can define up to ten custom KPIs to be used in each KPI scorecard portlet's calculations. For
information, see Using a Custom KPI in a KPI Scorecard.

■ Custom KPIs displayed in the Key Performance Indicators portlet are also available for display in
KPI Meter portlets. You can display up to three KPI meters on a dashboard. For information, see KPI
Meters.

■ Custom KPI data can also be displayed in Trend Graph portlets. You can add up to five Trend Graph
portlets. For information, see Setting Up Trend Graph Portlets.

■ Custom KPI definitions for individual KPI scorecards, the Key Performance Indicators portlet, and
Trend Graph portlets are all independent of each other.
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For a saved search to be used as a custom KPI that displays results for multiple date ranges in the Key
Performance Indicators portlet, a KPI scorecard, a trend graph, or a KPI meter, the search definition
must:

■ Not include any date fields defined as filters on the Criteria subtab. See the help topic Standard
Search Filters.

■ Have exactly one field with a summary type (such as count, group, or sum) defined on the Results
subtab. The rest of the fields on the Results subtab should not use any summary types. See the help
topic Defining Summary Types to Roll Up Search Results.

■ Have a date field defined as an available filter on the Available Filters subtab. See the help topic
Selecting Available Filters for Saved Searches.

Selecting an Existing Search to be a Custom KPI

To select an existing saved search to be used as a custom KPI:

1. Choose Reports > Saved Searches > All Saved Searches.

2. In the Saved Searches list, click Edit next to the search you want to use as a custom KPI. You
need to ensure that the search has been defined correctly to display KPI data in the manner you
want.

3. On the Criteria subtab, make sure that no date filters are used as search criteria.

Note: KPIs cannot enforce summary criteria filters because KPI calculations do not
include groupings. If a saved search used as a custom KPI includes any summary criteria
filters, the result for the KPI may differ from results when the search is run.

4. On the Results subtab, make sure you have only one field that uses a summary type.

■ If you want to display a count of the number of search results for a KPI, select a number or ID
field (such as Number) and set a Count summary type for this field.

■ If you want to display summary data such as sum (total), average, minimum, or maximum,
select a field and set the appropriate summary type for it.

5. On the Available Filters subtab, add a date field to be able to compare saved search results over
different date ranges in a Key Performance Indicators portlet, a trend graph, a KPI meter, or a
KPI scorecard.

■ If the type of search you have selected does not offer a date column as a filter, you may be
able to use a different type of search, for example, a transaction search.

■ If you want to use a saved search as a custom KPI in a scorecard and you have enabled the
Use Periods option for a scorecard, only saved searches with a Period filter defined as an
Available Filter can be defined as custom KPIs for the scorecard.

6. Edit the search to meet your requirements and resave it.

■ If you do not have the ability to edit and resave this search, you can ask the owner to edit it,
or you can create another, similar search yourself.

■ Choose Save & Run to verify the search results are what you expect.

7. Note the title of the search. It will appear in the custom KPI lists in the Set Up Key Performance
Indicators popup and the KPI scorecard.

8. Now you can use the search as a custom KPI and add it to the Key Performance Indicators
portlet, add it to a KPI scorecard, or display it in a trend graph portlet. See Adding a Custom KPI
to the Key Performance Indicators Portlet , or Using a Custom KPI in a KPI Scorecard.

For more information about editing saved searches, see the help topic Using Saved Searches.

https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N646693.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N646693.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N648820.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N678025.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=chapter_N675442.html
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Creating a New Search to be a Custom KPI

To create a new saved search to be used as a custom KPI:

1. Choose Reports > Saved Searches > All Saved Searches > New.

2. In the New Saved Search list, click a search type.

3. On the Saved Search form, enter a title for the search. (This title will appear in the custom KPI
dropdown lists in the Set Up Key Performance Indicators popup and the KPI scorecard.)

4. On the Criteria subtab, define the filters that will limit the search data, making sure you don’t
include date filters as search criteria.

Note: KPIs cannot enforce summary criteria filters because KPI calculations do not
include groupings. If a saved search used as a custom KPI includes any summary criteria
filters, the result for the KPI may differ from results when the search is run.

5. On the Results subtab, define which fields you want to be returned in the saved search results.
Make sure you have exactly one field that uses a summary type.

■ If you want to display a count of the number of search results for a KPI, select a number or ID
field (such as Number) and set a Count summary type for this field.

■ If you want to display summary data such as sum (total), average, minimum, or maximum,
select a field and set the appropriate summary type for it.

6. On the Available Filters subtab, add a date field to be able to compare saved search results over
different date ranges in a Key Performance Indicators portlet, a trend graph, a KPI meter, or a
KPI scorecard.

■ If the type of search you have selected does not offer a date column as a filter, you may be
able to use a different type of search, for example, a transaction search.

■ If you want to use a saved search as a custom KPI in a scorecard and you have enabled the
Use Periods option for a scorecard, only saved searches with a Period filter defined as an
Available Filter can be defined as custom KPIs for the scorecard.

7. When you are done defining the search, click Save. (You can choose Save & Run to verify the
search results are what you expect.)

Now you can use the search as a custom KPI and add it to the Key Performance Indicators portlet,
add it to a KPI scorecard, or display it in a trend graph portlet. See Adding a Custom KPI to the Key
Performance Indicators Portlet , or Using a Custom KPI in a KPI Scorecard.

For more information about creating saved searches, see the help topic Using Saved Searches.

Adding a Custom KPI to the Key Performance Indicators
Portlet
Custom KPIs are based on saved searches, so you need to create or select an appropriate search
before you add a custom KPI to the portlet. For information, see Creating a New Search to be a Custom
KPI or Selecting an Existing Search to be a Custom KPI.

To add a custom KPI to the Key Performance Indicators Portlet:

1. Click Set Up in your Key Performance Indicators portlet.

2. In the Set Up Key Performance Indicators popup, click Add Custom KPIs to open the Choose
Custom Key Performance Indicators popup window.

https://system.netsuite.com/app/help/helpcenter.nl?fid=chapter_N675442.html
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■ Click a saved search in the right list to move it to the left list, which indicates that it should be
displayed as a custom KPI.

■ Click Done after you have finished selecting KPIs for display.

■ You can choose up to 10 custom KPIs.

■ Custom KPIs are listed with “c” icons. Click an icon for a brief general description of custom
KPIs.

3. For each selected KPI, in the Range list, select the date or period range for which data should be
included.

4. For each selected KPI, in the Compare column, check the box if you want to compare results
from the time period defined in the Range list with results from another period defined in the
Compare Range list.

5. For each selected KPI, in the Compare Range list, if you checked the Compare box, select the
date or period range for which data should be compared with data from the first range. If you
did not check the Compare box, you do not need to make a selection here.

6. For each selected KPI, in the Highlight If list, select greater than or less than if you want to
highlight data that exceeds or falls short of a defined threshold. If you do not want highlighting
for this KPI, leave this column blank.

7. If you selected an option in the Highlight If column, enter the threshold value in the Threshold
column.

If you want the change to be highlighted in the portlet’s headline when the specified threshold
value is reached, select the check box in the Headline column.

8. Click Save.

Using a Custom KPI in a KPI Scorecard
You can use custom KPIs for comparisons in KPI scorecards as well as include them in KPI scorecard
formulas.

To learn how to create and configure KPI scorecards, see KPI Scorecards Overview.

Note: Custom KPIs are based on saved searches, so you need to create or select an
appropriate search before you add a custom KPI to a scorecard. For information, see Creating a
New Search to be a Custom KPI or Selecting an Existing Search to be a Custom KPI.

To add a custom KPI to a KPI scorecard:

1. Open the KPI scorecard where you want to add a custom KPI.

■ To edit an existing KPI scorecard, go to Customization > Centers and Tabs > KPI Scorecards
and click Edit next to the KPI scorecard you want to edit.

■ To create a new KPI scorecard, go to Customization > Centers and Tabs > KPI Scorecards
> New. For more information, see Creating a KPI Scorecard, and Entering Basic Scorecard
Information.

2. On the Content tab, select one of the custom KPIs (Custom KPI #1–Custom KPI #10) from the
KPIs list.

3. On the Custom subtab, find the custom KPI number you added to the KPIs list (Custom KPI #1
through Custom KPI #10) and specify the saved search to be used as this custom KPI.

4. If you want to add a custom KPI ID to a formula expression, select a formula from the KPIs list,
click the Set Formula icon in the Formula column, and select one of the custom KPIs you defined
on the Custom subtab.
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To learn how to define other formula settings, see Defining KPI Scorecard Formulas.

5. Define other settings for the KPI comparison. For information, see Defining KPI Scorecard
Comparisons.
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KPI Scorecards Overview
The KPI Scorecard portlet displays your choice of a performance scorecard. KPI scorecards can
provide complex comparisons among multiple KPIs over multiple date ranges or accounting periods.
Scorecards also can include Excel-like formulas with KPIs and functions in their expressions. Scorecards
offer many choices for calculation and display of KPI data. To get an understanding of what you can do
with KPI scorecards, see the following:

■ Scorecard Data Calculation and Comparison Options

■ Scorecard Data Display Options

To get started using KPI scorecards, see the following:

■ Enabling the KPI Scorecards Feature

■ Adding a KPI Scorecard Portlet to a Dashboard

■ Creating a KPI Scorecard

Scorecard Data Calculation and Comparison Options

■ Comparison of KPI results for a greater variety of date range types

■ Comparison of KPI results for a progression of date ranges

■ Comparison of multiple KPIs' results

■ Different types of comparative calculations including:

□ Sums: A+B

□ Variances in absolute or percent terms: A-B or 100(B-A)/A

□ Ratios in absolute or percentage terms: (B/A) or 100*B/A

■ Inversion of date ranges in comparisons

■ Excel-like formulas with the following features:

□ Formula results that can be expressed as:

▬ Dollar amounts

▬ Percentages

▬ Numeric amounts

□ Formula expressions that can include:

▬ Multiple KPIs

▬ Common functions

□ Ability to define hidden formulas with results to be used by other formulas

Scorecard Data Display Options

■ Ability to orient KPIs horizontally or vertically

■ Ability to define custom labels in place of KPI names

■ Optional popup trend graphs

■ Ability to limit displayed data to your own or your team's results.
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Note: NetSuite includes a prebuilt Financial Ratios scorecard that is available to users with
permission to see the Trial Balance report. For information about this scorecard, see Financial
Ratios Scorecard.

Enabling the KPI Scorecards Feature
The KPI Scorecards feature must be enabled before you can create a KPI scorecard or add a KPI
Scorecard portlet to a dashboard.

To enable the KPI Scorecards feature:

1. Go to Setup > Company > Enable Features.

2. On the Analytics subtab, check the KPI Scorecards box, and click Save.

Note: If you do not see the Enable Features option in your Setup tab's menu, you do not
have this permission. You need to ask an administrator or someone with the Enable Features
permission to enable the KPI Scorecards feature.

When the KPI Scorecards feature is enabled, you can:

■ Create your own KPI scorecard (if you have the KPI Scorecards permission). See Creating a KPI
Scorecard.

■ Add a KPI scorecard portlet to display an existing KPI scorecard. See Adding a KPI Scorecard Portlet
to a Dashboard.

Adding a KPI Scorecard Portlet to a Dashboard
You can add a KPI Scorecard portlet to a dashboard in the same manner that you add other portlets,
but this portlet is not available unless the KPI Scorecards feature has been enabled.

After you have added a KPI Scorecard portlet, you can click Set Up in the portlet, then select a KPI
scorecard and define display options.

To add a KPI Scorecard portlet to a dashboard:

1. Click the Personalize link in the upper right corner of your dashboard. You can also use the
Personalize Dashboard link in the Settings portlet.

2. On the Standard Content tab of the Personalize Dashboard palette, click the KPI Scorecard
item or drag it onto the dashboard.

If the list does not include KPI Scorecard, the KPI Scorecards feature has not been enabled. See
Enabling the KPI Scorecards Feature.

3. In the KPI Scorecard portlet, click the Set Up link to open a KPI Scorecard Setup popup.

1. In the KPI Scorecard list, select the scorecard that you want to display.

If you do not see a suitable scorecard, you may need to create a new KPI scorecard. See
Creating a KPI Scorecard.

2. By default, the Restrict To list is set to All to indicate that scorecard results are not
filtered. If you want to filter results, select My Team or Only Mine.

3. By default, the Orientation list is set to KPIs on Left, meaning that the scorecard lists
KPI labels on the left and date ranges across the top. To change this layout, select Date
Ranges on Left.
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4. Check or clear the Show Trend Graph Icon box to indicate whether you want the KPI
Scorecard portlet to include icons that can be clicked to open popup trend graphs of KPI
data. For more information, see Setting Up Popup Trend Graphs.

5. Check or clear the Show Date Row box to indicate whether to include explicit date ranges
as the first row (or first column if you selected Date Ranges on Left for Orientation). This
data is useful to display if the scorecard uses relative date ranges, such as 1 year ago.

6. Click Save.

4. Review the portlet's contents and links. The portlet title matches the name of the selected KPI
scorecard.

1. Click Refresh to refresh portlet data.

2. Click Set Up to change portlet settings.

3. Click Edit or Customize to open the KPI scorecard and make changes to its definitions.
For information, see Editing a KPI Scorecard.

4. Click Export to save scorecard results in an external CSV file.

Creating a KPI Scorecard
NetSuite enables you to create custom scorecards that can be displayed in the KPI Scorecard
dashboard portlet.

To create a new KPI scorecard:

1. Go to Customization > Centers and Tabs > KPI Scorecards > New.

If this menu option is not available, the KPI Scorecards feature may not be enabled. See Enabling
the KPI Scorecards Feature. Or you may not have permission to create scorecards. Check with
your account administrator to ensure you have the KPI Scorecards permission.

2. At the top of the page, you can enter basic scorecard information. See Entering Basic Scorecard
Information.

3. On the KPIs subtab of the Content subtab, you can add KPIs and define their comparisons, and
add formulas and define formula expressions.
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■ Scorecards can intermingle KPIs and formulas and compare them to each other, so you
define KPIs and formulas in the same place using some slightly different fields on the subtab.

□ For KPI steps, see Defining KPI Scorecard Comparisons.

□ For formula steps, see Defining KPI Scorecard Formulas.

■ If you define custom KPIs to be used in scorecards, you need to define their underlying saved
searches on the Custom subtab of the Content subtab.

Only saved searches with a date field defined under Available Filters are available for use
as custom KPIs in scorecards. The exception is if you enable the Use Periods option for a
scorecard. Then only saved searches with a Period filter defined under Available Filters are
available.

■ After you have entered KPIs and formulas, you can reorder them by dragging and dropping or
using the Move buttons.

4. On the Date Ranges (or Periods) subtab of the Content subtab, you can define multiple date
ranges (or periods). These date ranges apply to all scorecard data. See Defining KPI Scorecard
Date Ranges or Periods.

After you have entered date ranges, you can reorder them by dragging and dropping or using
the Move buttons.

5. On the Highlighting subtab of the content subtab, you can set highlighting options to make
results more visible in KPI Scorecard portlets. See Highlighting KPI Scorecard Results.

6. On the Audience subtab, you can define who has access to your scorecard, meaning who
can put it in their KPI Scorecard portlet. You can base this definition on roles, departments,
subsidiaries, groups, employees, or partners. See Sharing a Custom KPI Scorecard.

7. When you have completed all steps to define the scorecard, click Save.

Entering Basic Scorecard Information
To create a new KPI scorecard, go to Customization > Centers and Tabs > KPI Scorecards > New. For
more information, see Creating a KPI Scorecard. Then you can enter basic scorecard information at the
top of the page.

To enter basic KPI scorecard information:

1. Enter a Name for the KPI scorecard. This name will appear as the title of portlets displaying this
scorecard.

By default, your name appears in the Owner dropdown list. If you are an administrator, you can
define a different owner by selecting a different name.

2. If you want the KPI data to be calculated according to accounting periods rather then date
ranges, check the Use Periods box.

When Use Periods is selected:

■ The name of the Date Ranges subtab changes to Periods.

■ Only saved searches with a Period filter defined under Available Filters are available for use
as custom KPIs in this scorecard.

■ You may encounter issues with KPI scorecard data if you have not set up accounting periods,
or if you have not set the Report by Period preference to All Reports on the Analytics tab of
the Set Preferences page.

3. (Optional) Enter a Description for the scorecard.
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Defining KPI Scorecard Comparisons
You can define KPI scorecard comparisons when you are creating a new scorecard or editing an existing
scorecard.

■ To create a new KPI scorecard, go to Customization > Centers and Tabs > KPI Scorecards > New. For
more information, see Creating a KPI Scorecard, and Entering Basic Scorecard Information.

■ To edit an existing KPI scorecard, go to Customization > Centers and Tabs > KPI Scorecards and click
Edit next to the KPI scorecard you want to edit.

To define KPI scorecard comparisons:

1. Click Customize from the KPI scorecard portlet dropdown list.

2. On the KPIs subtab of the Content subtab, select a KPI from the KPI list.

3. In the Compare Value to list, select a KPI to compare to the first KPI you selected.

4. If you selected a custom KPI from either dropdown, go to the Custom subtab, and in the
corresponding custom KPI list there, select the saved search to be used as the basis for the
custom KPI.

Only saved searches with a date field defined under Available Filters are available for use as
custom KPIs in scorecards. The exception is if you enable the Use Periods option for a scorecard.
Then only saved searches with a Period filter defined under Available Filters are available.

Note that KPI scorecard custom KPI definitions are different from Key Performance Indicators
portlet custom KPI definitions. For more information, see Defining Custom KPIs.

5. Check Compare with Previous if you want to compare the results of this comparison to the
comparison defined in the row above this one on the KPIs subtab.

6. Select one of the following comparison types:

■ Variance (Percent) : 100*(B-A)/A

■ Variance (Absolute) : B-A

■ Ratio (Percent) : 100*B/A

■ Ratio (Absolute) : B/A

■ Sum : A + B

7. Check Invert Comparison if you want to invert the operation used to calculate the comparison
type.

8. Enter a Label for the KPI if you want something other than the KPI name to display as a row or
column header in the portlet.

9. Click Add, if you are adding a new KPI to the scorecard, or OK, if you are editing an existing KPI
entry).

Warning: KPI scorecards do not support results that are unions of two comparisons. If you
enter a KPI comparison as a row on the KPIs subtab and also enter a date range comparison
on the Date Ranges subtab, that KPI comparison displays a result of N/A in the KPI Scorecard
portlet. To work around this limitation, try defining the comparison as a formula instead.
For example, instead of entering Quota for KPI, Sales for Compare Value To, and Variance
(Percent) for Comparison Type, enter Formula (Percent) for KPI and {SALES}/{QUOTA} for
Formula. See Defining KPI Scorecard Formulas.

Defining KPI Scorecard Formulas
You can define formulas to calculate KPI comparisons when you are creating a new scorecard or editing
an existing scorecard. These formulas are similar to those used in Excel, and can include functions and
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KPI IDs. A Formula popup page, available from the KPI scorecard record, provides dropdown menus
that you can use to build formula expressions.

■ To create a new KPI scorecard, go to Customization > Centers and Tabs > KPI Scorecards > New. For
more information, see Creating a KPI Scorecard, and Entering Basic Scorecard Information.

■ To edit an existing KPI scorecard, go to Customization > Centers and Tabs > KPI Scorecards and click
Edit next to the KPI scorecard you want to edit.

Warning: KPI scorecards do not support results that are unions of two comparisons. If you
enter a KPI comparison as a row on the KPIs subtab and also enter a date range comparison
on the Date Ranges subtab, that KPI comparison displays a result of N/A in the KPI Scorecard
portlet. To work around this limitation, try defining the comparison as a formula instead.
For example, instead of entering Quota for KPI, Sales for Compare Value To, and Variance
(Percent) for Comparison Type, enter Formula (Percent) for KPI and {SALES}/{QUOTA} for
Formula. See Defining KPI Scorecard Comparisons.

To define KPI scorecard formulas:

1. Click Customize from the KPI scorecard portlet dropdown list.

2. On the KPIs subtab of the Content subtab, select a formula from the KPI list. The following
choices are available:

■ Formula (Currency)

■ Formula (Numeric)

■ Formula (Percent)

3. Enter the formula's expression in the Formula column. Click the Set Formula icon to open the
Formula popup. In this popup, you can:

■ Select from the Function list to add functions to the formula.

■ Select from the KPIs dropdown to add KPI IDs to the formula. For a list of IDs and their
corresponding KPI names, see KPI IDs Available for Scorecard Formulas.

■ Edit the formula directly in the Formula field.

When you have finished entering the expression, click Set.

4. If you included a custom KPI in a formula, go to the Custom subtab, and in the corresponding
custom KPI list, select the saved search to be used as the basis for the custom KPI.

Only saved searches with a date field defined under Available Filters are available for use as
custom KPIs in scorecards. The exception is if you enable the Use Periods option for a scorecard.
Then only saved searches with a Period filter defined under Available Filters are available.

KPI scorecard custom KPI definitions are independent of the custom KPIs selected for display in
the Key Performance Indicators portlet. For more information, see Defining Custom KPIs.

5. If lower values are preferable for this formula's results, check the box in the Less is More
column. When this option is enabled, downward arrows are green and upward arrows are red in
the KPI scorecard portlet. (The default is the reverse.)

6. If you do not want this formula's results to display in the scorecard, check the Hidden box. This
option is available so you can use a formula as the basis for another displayed comparison.

7. Enter a Label for the formula. This label appears as a row or column header in the portlet.

8. Click Add, if you are adding a new KPI to the scorecard, or OK, if you are editing an existing KPI
entry).
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KPI IDs Available for Scorecard Formulas
The following table lists the KPI IDs that are available for use in KPI scorecard formulas. For a
description of each KPI, see Standard Key Performance Indicators Table.

KPI Name KPI ID

Authorized Commission COMMISSIONS

Authorized Partner Commission COMMISSIONSPARTNER

Bank Balance BANKBAL

Cart Abandonment CARTABANDON

Cases Closed CLOSEDCASES

Cases Escalated ESCALATEDCASES

Checkout Abandonment CHECKOUTABANDON

Closed Issues CLOSEDISSUES

COGS COGS

Credit Card Balance CREDITCARDBAL

Custom KPI #1 CUSTOM

Custom KPI #2 CUSTOM2

Custom KPI #3 CUSTOM3

Custom KPI #4 CUSTOM4

Custom KPI #5 CUSTOM5

Custom KPI #6 CUSTOM6

Custom KPI #7 CUSTOM7

Custom KPI #8 CUSTOM8

Custom KPI #9 CUSTOM9

Custom KPI #10 CUSTOM10

Deferred Revenue DEFERREDREVENUE

Employees EMPLOYEES

Equity EQUITY

Estimated Commission ECOMMISSIONS

Estimated Partner Commission ECOMMISSIONSPARTNER

Expenses EXPENSES

Fixed Assets FIXEDASSET

Forecast FORECAST

Forecast (Alt. Sales) FORECASTASA

Forecast Override FORECASTOVERRIDE

Forecast Override (Alt. Sales) FORECASTOVERRIDEASA

Gross New Leads NEWLEADSGROSS

Hosted Page Hits HOSTEDSITETRAFFIC
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KPI Name KPI ID

Income INCOME

Inventory INVENTORY

Long Term Liabilities LONGTERMLIAB

My Utilization UTILIZATION

Net Cash Flow NETCASHFLOW

New Business NEWBUSINESS

New Business (Orders Alt. Sales) NEWBUSINESSORDALT

New Business (Sales Orders) NEWBUSINESSORD

New Cases NEWCASES

New Customers NEWCUSTOMERS

New Customers (Sales Orders) NEWCUSTOMERSORD

New Issues NEWISSUES

New Leads NEWLEADS

New Opportunities NEWOPPORTUNITIES

New Visitors NEWVISITORS

Open Cases OPENCASES

Open Estimates ESTIMATESRANGE

Open Issues OPENISSUES

Open Opportunities OPPORTUNITIESRANGE

Open Prospects PROSPECTS

Open Quotes ESTIMATESRANGE

Operating Cash Flow OPERCASHFLOW

Operating Expenses OPERATINGEXPENSES

Opportunities Lost OPPORTUNITIESLOST

Opportunities Won OPPORTUNITIESWON

Orders ORDERS

Other Assets OTHERASSET

Other Current Assets OTHERCURRENTASSET

Other Current Liabilities OTHERCURRENTLIAB

Paid Commission PCOMMISSIONS

Paid Partner Commission PCOMMISSIONSPARTNER

Payables PAYABLES

Payroll PAYROLL

Pipeline (Alt. Sales Projected) PIPELINEASA

Pipeline (Alt. Sales Weighted) PIPELINEWEIGHTEDASA

Pipeline (Projected) PIPELINE
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KPI Name KPI ID

Pipeline (Weighted) PIPELINEWEIGHTED

Pipeline Deals PIPELINEDEALS

Profit PROFIT

Quota QUOTA

Quota (Alt. Sales) QUOTAASA

Quota Reps QUOTAREPS

Receivables RECEIVABLES

Revenue REVENUE

Sales SALES

Sales (Cash Basis) SALESCASHBASIS

Sales (Orders) BOOKINGS

Sales (Orders Alt. Sales) BOOKINGSALT

Total Open Opportunities OPPORTUNITIES

Total Open Quotes ESTIMATES

Total Orders (Count) TOTALORDERS

Total Pipeline (Alt. Sales Projected) TOTALPIPELINEASA

Total Pipeline (Alt. Sales Weighted) TOTALPIPEWEIGHTEDASA

Total Pipeline (Projected) TOTALPIPELINE

Total Pipeline (Weighted) TOTALPIPEWEIGHTED

Total Pipeline Deals TOTALPIPEDEALS

Total Sales (Orders) TOTALBOOKINGS

Unique Visitors VISITORTRAFFIC

Web Orders WEBORDERS

Web Revenue WEBREVENUE

Web Site Hits SITETRAFFIC

You can enter KPI IDs in a scorecard formula by selecting a KPI name from the KPI dropdown in the
scorecard's Formula popup window. Open this popup by clicking on the Set Formula icon that is
available when you add a formula to the scorecard's KPIs subtab. For more information, see Defining
KPI Scorecard Formulas.

If you include a custom KPI's ID in a scorecard's formula, you need to go to the scorecard's Custom
subtab, and select a saved search in the corresponding custom KPI dropdown list there.

For an example of how to use formulas in KPI scorecards, check out NetSuite’s prebuilt Financial Ratios
scorecard that is available to users with permission to see the Trial Balance report. You can review the
formulas in this scorecard as examples. See Financial Ratios Scorecard Formulas.

Defining KPI Scorecard Date Ranges or Periods
You can define the date ranges to use in KPI data calculations when you are creating a new scorecard
or editing an existing scorecard.
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■ To create a new KPI scorecard, go to Customization > Centers and Tabs > KPI Scorecards > New. For
more information, see Creating a KPI Scorecard, and Entering Basic Scorecard Information.

■ To edit an existing KPI scorecard, go to Customization > Centers and Tabs > KPI Scorecards and click
Edit next to the KPI scorecard you want to edit.

For lists of date and period ranges available for KPI scorecard comparisons, see Date Ranges for KPI
Scorecards and Period Ranges for KPI Scorecards.

Note: If you have checked the Use Periods box on a KPI scorecard, you need to define periods
rather than date ranges, and the name of the Date Ranges subtab is changed to Periods. Please
note that you cannot clear the Use Periods box after the KPI scorecard has been saved.

To define date ranges for a KPI scorecard:

1. On the Date Ranges subtab of the Content subtab, in the Range column, specify date ranges to
be applied to all KPI scorecard data.

2. In the Compare Value to field, select a date range to compare to the first range you selected.

3. Check Compare with Previous if you want to compare the results for this comparison to the
date ranges listed above this one.

4. Select one of the following comparison types:

■ Variance (Percent) : 100*(B-A)/A

■ Variance (Absolute) : B-A

■ Ratio (Percent) : 100*B/A

■ Ratio (Absolute) : B/A

■ Sum : A + B

5. Check the box in the Invert Comparison column if you want to invert the operation used to
calculate the comparison type.

6. Enter a Label for this date range. This label appears as a column or row header in the portlet.

7. Click Add, if you are adding a new KPI to the scorecard, or OK, if you are editing an existing KPI
entry).

If you select multiple relative date ranges, such as 2 months ago, you can display the explicit dates in
the KPI Scorecard portlet, by checking the Show Date Row box in the KPI Scorecard Setup dialog. See
Adding a KPI Scorecard Portlet to a Dashboard.

Warning: KPI scorecards do not support results that are unions of two comparisons. If you
enter a KPI comparison as a row on the KPIs subtab and also enter a date range comparison
on the Date Ranges subtab, that KPI comparison displays a result of N/A in the KPI Scorecard
portlet. To work around this limitation, try defining the comparison as a formula instead.
For example, instead of entering Quota for KPI, Sales for Compare Value To, and Variance
(Percent) for Comparison Type, enter Formula (Percent) for KPI and {SALES}/{QUOTA} for
Formula. See Defining KPI Scorecard Formulas.

Date Ranges for KPI Scorecards
Below, in alphabetical order, are the date ranges that you can select for comparisons on the Date
Ranges subtab of a KPI Scorecard page.

Note: If you check the Use Periods box on this page, period ranges are listed on a Periods
subtab instead. See Period Ranges for KPI Scorecards.

■ April last year
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■ April last year to date

■ April this year

■ August last year

■ August last year to date

■ August this year

■ August this year to date

■ December last year

■ December last year to date

■ December this year

■ December this year to date

■ February last year

■ February last year to date

■ February this year

■ February this year to date

■ January last year

■ January last year to date

■ January this year

■ January this year to date

■ January through April last year

■ January through April this year

■ January through August last year

■ January through August this year

■ January through February last year

■ January through February this year

■ January through July last year

■ January through July this year

■ January through June last year

■ January through June this year

■ January through March last year

■ January through March this year

■ January through May last year

■ January through May this year

■ January through November last year

■ January through November this year

■ January through October last year

■ January through October this year

■ January through September last year

■ January through September this year

■ July last year

■ July last year to date

■ July this year
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■ July this year to date

■ June last year

■ June last year to date

■ June this year

■ June this year to date

■ March last year

■ March last year to date

■ March this year

■ March this year to date

■ May last year

■ May last year to date

■ May this year

■ May this year to date

■ November last year

■ November last year to date

■ November this year

■ November this year to date

■ October last year

■ October last year to date

■ October this year

■ October this year to date

■ September last year

■ September last year to date

■ September this year

■ September this year to date

■ calendar week 2 last month

■ calendar week 2 same month last fiscal quarter

■ calendar week 2 same month last fiscal year

■ calendar week 2 this month

■ calendar week 3 last month

■ calendar week 3 same month last fiscal quarter

■ calendar week 3 same month last fiscal year

■ calendar week 3 this month

■ calendar week 4 last month

■ calendar week 4 same month last fiscal quarter

■ calendar week 4 same month last fiscal year

■ calendar week 4 this month

■ first 2 weeks last month (first 14 days)

■ first 2 weeks same month last fiscal quarter (first 14 days)

■ first 2 weeks same month last fiscal year (first 14 days)

■ first 2 weeks this month (first 14 days)
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■ first 3 weeks last month (first 21 days)

■ first 3 weeks same month last fiscal quarter (first 21 days)

■ first 3 weeks same month last fiscal year (first 21 days)

■ first 3 weeks this month (first 21 days)

■ first 4 weeks last month (first 28 days)

■ first 4 weeks same month last fiscal quarter (first 28 days)

■ first 4 weeks same month last fiscal year (first 28 days)

■ first 4 weeks this month (first 28 days)

■ first fiscal half fiscal year before last

■ first fiscal half fiscal year before last to date

■ first fiscal half last fiscal year

■ first fiscal half last fiscal year to date

■ first fiscal half this fiscal year

■ first fiscal half this fiscal year to date

■ first fiscal quarter fiscal year before last

■ first fiscal quarter fiscal year before last to date

■ first fiscal quarter last fiscal year

■ first fiscal quarter last fiscal year to date

■ first fiscal quarter this fiscal year

■ first fiscal quarter this fiscal year to date

■ first month fiscal quarter before last

■ first month fiscal quarter before last to date

■ first month last fiscal quarter

■ first month last fiscal quarter to date

■ first month same fiscal quarter fiscal year before last

■ first month same fiscal quarter fiscal year before last to date

■ first month same fiscal quarter last fiscal year

■ first month same fiscal quarter last fiscal year to date

■ first month this fiscal quarter

■ first month this fiscal quarter to date

■ first three fiscal quarters fiscal year before last

■ first three fiscal quarters last fiscal year

■ first three fiscal quarters this fiscal year

■ first two fiscal quarters of fiscal year before last

■ first two fiscal quarters of last fiscal year

■ first two fiscal quarters of this fiscal year

■ first two months fiscal quarter before last

■ first two months last fiscal quarter

■ first two months same fiscal quarter fiscal year before last

■ first two months same fiscal quarter last fiscal year

■ first two months this fiscal quarter
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■ fiscal half before last

■ fiscal half before last to date

■ fiscal quarter before last

■ fiscal quarter before last to date

■ fiscal year before last

■ fiscal year before last to date

■ five days ago

■ five days from now

■ four days ago

■ four days from now

■ four weeks starting this week

■ fourth fiscal quarter fiscal year before last

■ fourth fiscal quarter fiscal year before last to date

■ fourth fiscal quarter last fiscal year

■ fourth fiscal quarter last fiscal year to date

■ fourth fiscal quarter this fiscal year

■ fourth fiscal quarter this fiscal year to date

■ last business week

■ last fiscal half

■ last fiscal half one fiscal year ago

■ last fiscal half to date

■ last fiscal quarter

■ last fiscal quarter one fiscal year ago

■ last fiscal quarter to date

■ last fiscal quarter two fiscal years ago

■ last fiscal year

■ last fiscal year to date

■ last month

■ last month one fiscal quarter ago

■ last month one fiscal year ago

■ last month to date

■ last month two fiscal quarters ago

■ last month two fiscal years ago

■ last rolling half

■ last rolling quarter

■ last rolling year

■ last week

■ last week to date

■ last year

■ last year to date

■ month after next
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■ month after next to date

■ month before last

■ month before last to date

■ next business week

■ next fiscal half

■ next fiscal quarter

■ next fiscal year

■ next four weeks

■ next month

■ next one half

■ next one month

■ next one quarter

■ next one week (7 rolling days)

■ next one year

■ next week

■ ninety days ago

■ ninety days from now

■ one year before last

■ previous fiscal quarters last fiscal year

■ previous fiscal quarters this fiscal year

■ previous months last fiscal half

■ previous months last fiscal quarter

■ previous months last fiscal year

■ previous months same fiscal half last fiscal year

■ previous months same fiscal quarter last fiscal year

■ previous months this fiscal half

■ previous months this fiscal quarter

■ previous months this fiscal year

■ previous one day

■ previous one half

■ previous one month

■ previous one quarter

■ previous one week

■ previous one year

■ previous rolling half

■ previous rolling quarter

■ previous rolling year

■ same day fiscal quarter before last

■ same day fiscal year before last

■ same day last fiscal quarter

■ same day last fiscal year
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■ same half last fiscal year

■ same day last month

■ same day last week

■ same day month before last

■ same day week before last

■ same fiscal half last fiscal year

■ same fiscal half last fiscal year to date

■ same fiscal quarter fiscal year before last

■ same fiscal quarter last fiscal year

■ same fiscal quarter last fiscal year to date

■ same month fiscal quarter before last

■ same month fiscal year before last

■ same month last fiscal quarter

■ same months last fiscal quarter to date

■ same month last fiscal year

■ same month last fiscal year to date

■ same week fiscal year before last

■ same week last fiscal year

■ second fiscal half fiscal year before last

■ second fiscal half fiscal year before last to date

■ second fiscal half last fiscal year

■ second fiscal half last fiscal year to date

■ second fiscal half this fiscal year

■ second fiscal half this fiscal year to date

■ second fiscal quarter fiscal year before last

■ second fiscal quarter fiscal year before last to date

■ second fiscal quarter last fiscal year

■ second fiscal quarter last fiscal year to date

■ second fiscal quarter this fiscal year

■ second fiscal quarter this fiscal year to date

■ second month fiscal quarter before last

■ second month fiscal quarter before last to date

■ second month last fiscal quarter

■ second month last fiscal quarter to date

■ second month same fiscal quarter fiscal year before last

■ second month same fiscal quarter fiscal year before last to date

■ second month same fiscal quarter last fiscal year

■ second month same fiscal quarter last fiscal year to date

■ second month this fiscal quarter

■ second month this fiscal quarter to date

■ sixty days ago
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■ sixty days from now

■ start of last month to end of its first week

■ start of last month to end of its fourth week

■ start of last month to end of its second week

■ start of last month to end of its third week

■ start of same month last fiscal quarter to end of its first week

■ start of same month last fiscal quarter to end of its fourth week

■ start of same month last fiscal quarter to end of its second week

■ start of same month last fiscal quarter to end of its third week

■ start of same month last fiscal year to end of its first week

■ start of same month last fiscal year to end of its fourth week

■ start of same month last fiscal year to end of its second week

■ start of same month last fiscal year to end of its third week

■ start of this month to end of its first week

■ start of this month to end of its fourth week

■ start of this month to end of its second week

■ start of this month to end of its third week

■ start of week 5 last month to end of last month

■ start of week 5 same month last fiscal quarter to end of that month

■ start of week 5 same month last fiscal year to end of that month

■ start of week 5 this month to end of this month

■ ten days ago

■ ten days from now

■ third fiscal quarter fiscal year before last

■ third fiscal quarter fiscal year before last to date

■ third fiscal quarter last fiscal year

■ third fiscal quarter last fiscal year to date

■ third fiscal quarter this fiscal year

■ third fiscal quarter this fiscal year to date

■ third month fiscal quarter before last

■ third month fiscal quarter before last to date

■ third month last fiscal quarter

■ third month last fiscal quarter to date

■ third month same fiscal quarter fiscal year before last

■ third month same fiscal quarter fiscal year before last to date

■ third month same fiscal quarter last fiscal year

■ third month same fiscal quarter last fiscal year to date

■ third month this fiscal quarter

■ third month this fiscal quarter to date

■ thirty days ago

■ thirty days from now
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■ this business week

■ this fiscal half

■ this fiscal half to date

■ this fiscal quarter

■ this fiscal quarter to date

■ this fiscal year

■ this fiscal year to date

■ this month

■ this month to date

■ this rolling half

■ this rolling quarter

■ this rolling year

■ this week

■ this week to date

■ this year

■ this year to date

■ three days ago

■ three fiscal quarters ago

■ three fiscal quarters ago to date

■ three fiscal years ago

■ three fiscal years ago to date

■ three months ago

■ three months ago to date

■ today

■ today to end of this month

■ tomorrow

■ two days ago

■ two days from now

■ week 1 last month (days 1–7)

■ week 1 same month last fiscal quarter (days 1–7)

■ week 1 same month last fiscal year (days 1–7)

■ week 1 this month (days 1–7)

■ week 2 last month (days 8–14)

■ week 2 same month last fiscal quarter (days 8–14)

■ week 2 same month last fiscal year (days 8–14)

■ week 2 this month (days 8–14)

■ week 3 last month (days 15–21)

■ week 3 same month last fiscal quarter (days 15–21)

■ week 3 same month last fiscal year (days 15–21)

■ week 3 this month (days 15–21)

■ week 4 last month (days 22–28)

■ week 4 same month last fiscal quarter (days 22–28)
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■ week 4 same month last fiscal year (days 22–28)

■ week 4 this month (days 22–28)

■ week 5 last month (day 29–month’s end)

■ week 5 same month last fiscal quarter (day 29–month’s end)

■ week 5 same month last fiscal year (day 29–month’s end)

■ week 5 this month (day 29–month’s end)

■ week after next

■ week after next to date

■ week before last

■ week before last to date

■ yesterday

■ 1 day ago

■ 2 days ago

■ 3 days ago

■ 4 days ago

■ 5 days ago

■ 6 days ago

■ 7 days ago

■ 1 week ago

■ 2 weeks ago

■ 3 weeks ago

■ 4 weeks ago

■ 5 weeks ago

■ 6 weeks ago

■ 7 weeks ago

■ 8 weeks ago

■ 1 month ago

■ 2 months ago

■ 3 months ago

■ 4 months ago

■ 5 months ago

■ 6 months ago

■ 7 months ago

■ 8 months ago

■ 9 months ago

■ 10 months ago

■ 11 months ago

■ 12 months ago

■ 1 fiscal quarter ago

■ 2 fiscal quarters ago

■ 3 fiscal quarters ago

■ 4 fiscal quarters ago
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■ 5 fiscal quarters ago

■ 6 fiscal quarters ago

■ 7 fiscal quarters ago

■ 8 fiscal quarters ago

■ 1 fiscal half ago

■ 2 fiscal halves ago

■ 3 fiscal halves ago

■ 4 fiscal halves ago

■ 5 fiscal halves ago

■ 6 fiscal halves ago

■ 7 fiscal halves ago

■ 8 fiscal halves ago

■ 1 fiscal year ago

■ 2 fiscal years ago

■ 3 fiscal years ago

■ 4 fiscal years ago

■ 5 fiscal years ago

■ 6 fiscal years ago

■ 7 fiscal years ago

■ 8 fiscal years ago

Period Ranges for KPI Scorecards
If you check the Use Periods box on a KPI Scorecard page, you can select the following period ranges,
on the Periods subtab, for scorecard comparisons.

Note: If you do not check the Use Periods box, date ranges are listed on a Date Ranges subtab
instead. See Date Ranges for KPI Scorecards.

The following period ranges are listed alphabetically:

■ First Fiscal Quarter Last FY

■ First Fiscal Quarter This FY

■ Fiscal Quarter Before Last

■ Fiscal Year Before Last

■ Fourth Fiscal Quarter Last FY

■ Fourth Fiscal Quarter This FY

■ Last Fiscal Quarter

■ Last Fiscal Quarter One Fiscal Year Ago

■ Last Fiscal Quarter to Period

■ Last Fiscal Year

■ Last Fiscal Year to Period

■ Last Period

■ Last Period One Fiscal Quarter Ago
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■ Last Period One Fiscal Year Ago

■ Last Rolling 18 Periods

■ Last Rolling 6 Fiscal Quarters

■ Period Before Last

■ Same Fiscal Quarter Last FY

■ Same Fiscal Quarter Last FY to Period

■ Same Period Last FY

■ Same Period Last Fiscal Quarter

■ Second Fiscal Quarter Last FY

■ Second Fiscal Quarter This FY

■ Third Fiscal Quarter Last FY

■ Third Fiscal Quarter This FY

■ This Fiscal Quarter

■ This Fiscal Quarter to Period

■ This Fiscal Year

■ This Fiscal Year to Period

■ This Period

After the alphabetical list, the following periods are listed chronologically: each fiscal year, quarter, and
month for the periods set up in your system. For more information about accounting periods, see the
help topic Setting Up Accounting Periods.

Highlighting KPI Scorecard Results
You can set up highlighting of KPI scorecard results when you are creating a new scorecard or editing
an existing scorecard. Highlighting makes results more visible in the KPI Scorecard portlet.

■ To create a new KPI scorecard, go to Customization > Centers and Tabs > KPI Scorecards > New. For
more information, see Creating a KPI Scorecard, and Entering Basic Scorecard Information.

■ To edit an existing KPI scorecard, go to Customization > Centers and Tabs > KPI Scorecards and click
Edit next to the KPI scorecard you want to edit.

To set highlighting options for a result in a KPI scorecard:

1. Select a KPI from the dropdown list.

2. Select an option in the Highlight If... column, to indicate how the result should be compared to
the Threshold value. The following options are available:

https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N1445585.html
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■ Always

■ Less Than

■ Greater Than

■ Magnitude Greater Than

■ Magnitude Less Than

3. Enter a Threshold value.

4. Select the Date Range or Period to determine whether highlighting should be applied when
the comparison with the threshold is performed. The available options include All and the date
ranges or periods set on the Date Ranges or Periods subtab.

5. You can use any of the following options to specify the highlighting to be applied to the results
that exceed or fall short of the specified Threshold value.

■ Use the Image column to select an image to be displayed with the highlighted result in the
KPI scorecard portlet.

■ Use the Text Color column to select a text color other than the default for the highlighted
result.

■ Use the Background Color column to select a background color other than the default for the
highlighted result.

■ Check the box in the Bold column to display the highlighted result in bold text.

■ Check the box in the Headline column to display the highlighted result as a headline, in large
bold text at the top of the KPI Scorecard portlet.

Note: Up to four scorecard results can be displayed as headlines.

Sharing a Custom KPI Scorecard
You can define an audience for your KPI scorecard when you are creating a new scorecard or editing an
existing scorecard. Members of that audience can display your custom scorecard in their KPI Scorecard
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portlets. You can base the audience definition on roles, departments, subsidiaries, groups, employees,
or partners.

■ To create a new KPI scorecard, go to Customization > Centers and Tabs > KPI Scorecards > New. For
more information, see Creating a KPI Scorecard, and Entering Basic Scorecard Information.

■ To edit an existing KPI scorecard, go to Customization > Centers and Tabs > KPI Scorecards and click
Edit next to the KPI scorecard you want to edit.

To define an audience for a KPI scorecard:

1. On the KPI Scorecard record, click the Audience subtab.

2. Use the list boxes provided to define the audience with whom you want to share the portlet. You
can check a Select All box to include everyone or select individual list items, holding down the
Ctrl key.

3. Click Save.

Editing a KPI Scorecard
If you own a KPI scorecard, you can make changes to it. To open a custom KPI scorecard, you can:

■ In the KPI Scorecard portlet, click the Edit link, or

■ Go to Customization > Centers and Tabs > KPI Scorecards and click Edit next to the scorecard.

If you want to customize a prebuilt KPI scorecard, you can open it and make changes, then save it with
a different name. To open a prebuilt KPI scorecard, you can:

■ In the KPI Scorecard portlet, click the Customize link, or

■ Go to Setup > Customization > KPI Scorecards and click Customize next to the scorecard.

You can perform the following tasks:

■ Entering Basic Scorecard Information

■ Defining KPI Scorecard Comparisons

■ Defining KPI Scorecard Formulas

■ Defining KPI Scorecard Date Ranges or Periods

■ Highlighting KPI Scorecard Results

■ Sharing a Custom KPI Scorecard

Financial Ratios Scorecard
NetSuite provides a prebuilt Financial Ratios scorecard to help you analyze your business's financial
position and operating efficiency. This scorecard includes metrics built with embedded formulas that
incorporate standard NetSuite key performance indicators (KPIs).

The scorecard displays metrics for the current accounting period and the previous accounting period,
and shows the percentage change between periods for each metric. Metrics include:

■ Current Ratio

■ Receivables Turnover

■ Days Sale Outstanding

■ Inventory Turnover
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■ Days Inventory on Hand

■ Asset Turnover

■ Profit Margin on Sales

■ Return on Assets

■ Return on Equity

■ Debt to Total Assets

■ Debt to Equity

To view the formulas used to calculate these metrics, see Financial Ratios Scorecard Formulas.

The Financial Ratios scorecard's data is based on a set of NetSuite standard reports, and you can click
on the scorecard's metrics to drill down into each of the detailed reports. By default, the scorecard
is available to you only if you have permission to view the Trial Balance report. If you have this
permission, you can display this scorecard in your KPI Scorecard portlet.

Administrators can review this scorecard's definitions and modify them to create a custom Financial
Ratios scorecard, including giving permission to additional users to display the scorecard on their
dashboard by changing the audience for the scorecard. For information, see Editing a KPI Scorecard.

Note: You may encounter issues viewing Financial Ratios scorecard data if you have not set
up accounting periods or if you have not set the Report by Period preference to All Reports at
Home > Set Preferences, the Analytics tab.

To display the Financial Ratios scorecard on your dashboard:

1. Add a KPI Scorecard portlet to your dashboard.

1. On the page where you want to see the scorecard, click the Personalize link.

2. In the Personalize Dashboard panel, click the KPI Scorecard icon or drag it onto the
dashboard.

2. In the KPI Scorecard portlet’s menu, click the Set Up link.

3. Select Financial Ratios from the KPI Scorecard list, and click Save.

To review the Financial Ratios scorecard formulas:
■ Go to Customization > Centers and Tabs > KPI Scorecards, and in the KPI Scorecards list, click

Financial Ratios.

To customize the Financial Ratios scorecard:

1. In the Financial Ratios KPI Scorecard portlet, click Customize in the portlet’s menu, or go to
Customization > Centers and Tabs > KPI Scorecards, and click Customize next to Financial
Ratios.

2. Notice that the name of the scorecard is changed automatically. You can make additional
changes and click Save. For information, see Editing a KPI Scorecard.

Financial Ratios Scorecard Formulas
The following table lists the formulas used to calculate data for NetSuite's prebuilt Financial Ratios
scorecard. This scorecard is available if you have permission to see the Trial Balance report. Formula
components are standard NetSuite KPI IDs.
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Scorecard Ratio Formula

Current Ratio ({BANKBAL}+{RECEIVABLES}+{OTHERCURRENTASSET})/({PAYABLES}+{
CREDITCARDBAL}+{OTHERCURRENTLIAB})

Receivables {SALES}/{RECEIVABLES}

Days Sales Outstanding {DAYS}/({SALES}/{RECEIVABLES})

Inventory Turnover {COGS}/{INVENTORY}

Days Inventory On Hand {DAYS}/({COGS}/{INVENTORY})

Asset Turnover {SALES}/({BANKBAL}+{RECEIVABLES}+{OTHERCURRENTASSET}+
{FIXEDASSET}+{OTHERASSET})

Profit Margin on Sales {PROFIT}/{INCOME}

Return on Assets {PROFIT}/({BANKBAL}+{RECEIVABLES}+
{OTHERCURRENTASSET}+{FIXEDASSET}+{OTHERASSET})

Return on Equity {PROFIT}/{EQUITY}

Debt to Total Assets ({PAYABLES}+{CREDITCARDBAL}+{OTHERCURRENTLIAB}+
{LONGTERMLIAB})/({BANKBAL}+{RECEIVABLES}+
{OTHERCURRENTASSET}+{FIXEDASSET}+{OTHERASSET})

Debt to Equity ({PAYABLES}+{CREDITCARDBAL}+{OTHERCURRENTLIAB}+
{LONGTERMLIAB})/{EQUITY}

■ For more information about this scorecard, see Financial Ratios Scorecard.

■ For information about the underlying report, see the help topic Trial Balance Report.

■ For a list of standard KPI IDs, see KPI IDs Available for Scorecard Formulas.

■ For a list of standard KPIs and descriptions, see Standard Key Performance Indicators Table.

■ For information about adding formulas to KPI scorecards, see Defining KPI Scorecard Formulas.

https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N1520986.html
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Report Snapshots Overview
NetSuite includes a large number of standard reports that you can run to obtain detailed information
about your business. For immediate access to reports' summary data, NetSuite enables you to add
Report Snapshot portlets to your dashboard. Report Snapshot portlets offer quick looks at important
business results every time you view your dashboard.

Each Report Snapshot portlet displays a high-level summary of a report's results for a selected date or
time period. You can configure the number and order of results, and choose the format that is most
useful for you, including four different chart types, or a list. You can define the look and feel of each
chart by setting its theme and background. Each portlet also includes menu options to print content, to
download content to a PNG, JPG, PDF, or SVG file, and to view the underlying report's detailed data.

When you roll over a data point in a report snapshot chart, its value displays.

Adding Report Snapshots
For instructions for adding Report Snapshot portlets to your dashboard, see Adding a Report Snapshot
Portlet. The available snapshots vary according to enabled features, and each user's roles and
permissions. They may include the following:

■ Standard Report Snapshots - You can select from a list of predefined report snapshots. See
Standard Report Snapshots Table.

■ Custom Report Snapshots - You can create a custom report snapshot from a customized report.
See Creating Custom Report Snapshots.

■ Sales Management Report Snapshots - You can choose to view sales management report
summaries rolled up to different levels of management hierarchy. See Sales Management
Snapshots.

Using Report Snapshots
After you have added a report snapshot to your dashboard, you can configure the data that is
displayed.

■ Click thumbnails in the portlet to try different chart types.
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■ Select the time period for which report snapshot data is displayed.

□ Date Selector for Comparative Report Snapshots:

□ Date Selector for Other Report Snapshots:

■ For more configuration options, click the Set Up link.

For more information, see Setting Up a Report Snapshot Portlet.

Adding a Report Snapshot Portlet
You can add Report Snapshot portlets to some dashboard pages. The report snapshots that are
available for display in a dashboard portlet depend on your role and the features you have enabled. A
report snapshot is available to you if you have permission to view the underlying report's data.

To add a Report Snapshot portlet to a page:

1. Click the Personalize link in the upper right corner of the dashboard. You can also use the
Personalize Dashboard link in the Settings portlet.

2. On the Report Snapshots tab of the Personalize Dashboard palette, click the Report Snapshots
icon or drag it onto the dashboard.

If the Report Snapshots tab does not display in the Personalize Dashboard panel, it means you
cannot add Report Snapshot portlets to this page.

3. Click the Set Up link in the portlet’s menu to select the report snapshot you want to be displayed
in the portlet.

The snapshots you have added appear in portlets on the page. When you log in, the information in
each portlet refreshes.

■ You can manually refresh report snapshot data at any time by clicking the portlet's Refresh icon.

■ You can click a thumbnail in the portlet to change the type of chart used to display data. For most
snapshots, choices are line, bar, column, or pie charts.

■ You can change the dates for displayed report snapshot data using the dropdown list in the portlet.

■ You can select a menu option to print the portlet content, to download content to a PNG, JPG, PDF,
or SVG file, or to view the underlying report.

■ You may be able to change layout options for report snapshot data by clicking the portlet's Set Up
link, if it is available. Layout options include whether to display report results in a list or a graph,
the default chart type for the graph, the theme and background for the chart, how many results to
display, and the order in which to display results. For more information, see Setting Up a Report
Snapshot Portlet.

Notes:

■ Comparative sales report snapshots have different setup options than other types of report
snapshots. For details, see Setup Options for Comparative Sales Report Snapshots.
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■ Report snapshot list text truncates at 25 characters when the report snapshot portlet is in the left
or right dashboard column. To avoid this truncation, place the portlet in the middle column. Also,
report snapshot list amounts are rounded to the nearest whole number and do not display decimal
places.

Standard Report Snapshots Table
The following table lists NetSuite standard report snapshots, in alphabetical order. You can see the
snapshots available by clicking the Set Up link in the Report Snapshot portlet’s menu and checking the
Snapshot list. You may see a subset of snapshots listed in the following table, depending upon your
role and the features you have enabled.

Note: A report snapshot is only available to you if you have permission to view the underlying
report's data.

Report Snapshot Description

Campaigns By
Activity

This snapshot shows the top campaigns by percent of campaign messages
viewed during the date range you choose.
This snapshot is based on the Campaign Response Summary Report.

Campaigns By
Profitability

This snapshot shows the top campaigns by profitability during the date range
you choose.
This snapshot is based on the Campaign ROI Analysis Summary Report.

Comparative Sales This line graph compares the total income and reimbursed expenses for
customers in the periods you choose. It excludes the following transaction types
—Journal, Deposit, Credit Card, Credit Card Refund and Check.
This snapshot is based on the Comparative Sales report.
This snapshot offers different setup options from other standard snapshots. For
information, see Setup Options for Comparative Sales Report Snapshots.

Comparative Sales
(Orders)

This line graph compares the total income for sales orders in the periods you
choose. It excludes the following transaction types—Journal, Deposit, Credit
Card, Credit Card Refund and Check.
This snapshot is based on the Comparative Sales (Orders) report.
This snapshot offers different setup options from other standard snapshots. For
information, see Setup Options for Comparative Sales Report Snapshots.

Comparative Sales
(Orders Alt. Sales)

This snapshot shows a comparison of the total dollar values of sales orders,
based on alternate sales amounts (ASA) in the two date ranges you select. These
values exclude the following transaction types: journal, deposit, credit card,
credit card refund, and check.
This snapshot is based on the Comparative Sales (Alt. Sales) report.
This snapshot offers different setup options from other standard snapshots. For
information, see Setup Options for Comparative Sales Report Snapshots.

Customers By
Balance

This snapshot shows the customers with the largest account balances due for
the date range you select.
This snapshot is based on the A/R Aging Summary Report.

Customers By
Forecast

This snapshot shows the top customers by forecast during the time period you
select. The forecast includes:

■ total income and reimbursed expenses

■ total value of open estimates that are set to be included in the forecast and
are expected to close in the period you have selected

https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N1012638.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N1010554.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N1531392.html
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Report Snapshot Description

■ total value of open opportunities that are expected to close in the period
you have selected and do not include an estimate that is set to appear in the
forecast
Note: The values of the estimates and opportunities that are included in
the forecast depend on the preferences you have set at Setup > Sales >
Preferences > Sales Preferences on the Forecasts subtab.

This snapshot is based on the Forecast by Customer Summary Report.

Customers
By Forecast
Outstanding

This snapshot shows the top customers by outstanding forecast during the time
period you select. This snapshot includes:

■ total value of open estimates that are set to be included in the forecast and
are expected to close in the period you have selected

■ total value of open opportunities that are expected to close in the period
you have selected and do not include an estimate that is set to appear in the
forecast
Note: The values of the estimates and opportunities that are included in
the forecast depend on the preferences you have set at Setup > Sales >
Preferences > Sales Preferences on the Forecasts subtab.

This snapshot is based on the Forecast (Outstanding) by Customer Summary
Report.

Customers By
Hosted Page Hits

This snapshot shows the top customers by hosted page hits in your Web site
during the date range you choose.
This snapshot is based on the Hosted Page Hits by Customer Report.

Customers By Page
Hits

This snapshot shows the top customers by page hits in your Web site during the
date range you choose.
This snapshot is based on the Page Hits by Customer Report.

Customers By
Pipeline

This snapshot shows the top customers by pipeline. The pipeline includes the
projected amount of open opportunities and open estimates expected to close
in the date range you choose. This excludes the total of opportunities with
estimates set to be included in the forecast.
This snapshot is based on the Pipeline by Customer Summary Report.

Customers By
Profitability

This snapshot shows the most profitable customers for the date range you
select. Profit is calculated by subtracting cost from revenue.
This snapshot is based on the Customer Profitability Summary Report.

Customers By Sales This snapshot shows the top customers by sales during the time period you
select.
This snapshot is based on the Sales by Customer Summary Report.

Customers By Sales
Orders

This snapshot shows the total of the approved sales orders for each customer
during the date range you select.
This snapshot is based on the Sales Orders by Customer Summary Report.

Customers By Total
Pipeline

This snapshot shows the top customers by total pipeline. The total pipeline
includes the projected amount of all opportunities and estimates that are
open as of the date you choose. This excludes the total of opportunities with
estimates set to be included in the forecast.
This snapshot is based on the Total Pipeline by Customer Summary Report.

Earned Value This snapshot shows the top projects by earned value as of the date you choose.
This data illustrates the effectiveness of project resources.
This snapshot is based on the Earned Value by Project Report, which includes
data on the difference between projects' earned value and planned value, and
the difference between projects' earned value and actual cost.

https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N1058733.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N1059361.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N1059361.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N2647049.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N2647166.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N1106886.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N1119966.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N1115281.html
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Report Snapshot Description

Forecast By Status This snapshot shows your forecast divided by customer statuses. This enables
you to understand where sales are in the sales cycle.
This snapshot is based on the Forecast by Status Summary Report.

Hosted Page Hits This snapshot shows you the number of hits to Web pages hosted in your
NetSuite file cabinet during the date range you choose.
This snapshot is based on the Hosted Page Hits Report.

Hosted Page Hits By
Unique Visitor

This snapshot shows the top hosted pages by unique-visitor hits in your Web site
during the date range you choose.
This snapshot is based on the Hosted Page Hits Report.

Internal Search Hits This snapshot shows the keywords that Web site visitors are using to search
within your site and the search results being returned.
This snapshot is based on the Internal Search Summary Report.

Inventory Sales This snapshot shows the top selling items by amount of revenue generated.
This snapshot is based on the Inventory Revenue Report.

Invoices This snapshot shows the top open invoices by customer during the date range
you choose.
This snapshot is based on the Open Invoices Reports.

Items By Qty Sold This snapshot shows the top selling items by quantity sold.
This snapshot is based on the Sales by Item Summary Report.

Items By Sales This snapshot shows the top items by sales during the date range you choose.
This snapshot is based on the Sales by Item Summary Report.

Items By Sales
Orders

This snapshot shows the top items by sales order income during the date range
you choose.
This snapshot is based on the Sales Orders by Item Summary Report.

Keywords By
Revenue

This snapshot shows the top keywords Web site customers enter in search
engines by the revenue generated from customers who used those keywords
during the date range you choose.
This snapshot is based on the Search Engine Keywords Summary Report.

Keywords By Visitors This snapshot shows the top keywords Web site customers enter in search
engines and follow results to your site during the date range you choose.
This snapshot is based on the Search Engine Keywords Summary Report.

Lead Sources By
Activity

This snapshot shows the top lead sources by the quantity of lead records
entered in NetSuite during the date range you choose.
This snapshot is based on the Lead Source Analysis Summary Report.

Open Escalations This snapshot shows the number of escalated cases during the range you
choose grouped by employee.
This snapshot is based on the Open Escalations report.

Open Estimates This snapshot shows the estimates with the highest projected amounts expected
to close during the date range you select. Open estimates have a probability
between 0% and 100% and have not been closed by an order or actual.
This snapshot is based on the Estimates to Close Report.

Open Opportunities This snapshot shows the opportunities with the highest projected amounts
expected to close during the date range you select. Open opportunities have
a probability between 0% and 100% and have not been closed by an order or
actual.
This snapshot is based on the Opportunities to Close Detail Report.

Open Sales Orders This snapshot shows the top open sales orders by customer during the date
range you choose.

https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N1056905.html
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Report Snapshot Description

This snapshot is based on the Open Sales Orders Report.

Page Hits This snapshot shows the top pages by hits in your Web site during the date
range you choose.
This snapshot is based on the Page Hits Report.

Page Hits By Unique
Visitors

This snapshot shows the top pages by unique-visitor hits in your Web site during
the date range you choose.
This snapshot is based on the Page Hits Report.

Partners By Activity This snapshot shows the top partners by the quantity of activities they have
entered in NetSuite during the date range you choose.
This snapshot is based on the Partner Activity Summary Report.

Partners By
Customer
Acquisition

This snapshot shows the top partners by the quantity of customers they
acquired in the date range you choose.
This snapshot is based on the Customers by Partner Summary Report.

Partners By Sales This snapshot shows the top partners by sales during the period you choose.
This snapshot is based on the Sales by Partner Summary Report.

Partners By Sales
Orders

This snapshot shows the top partners by sales order totals during the date range
you choose.
This snapshot is based on the Sales Orders by Partner Summary Report.

Pipeline By Status This snapshot shows the total of the open estimates and opportunities expected
to close in the date range you choose grouped by status.
This snapshot is based on the Pipeline by Status Summary Report.

Promotion By Sales
Orders

This snapshot shows sales order income by promotion during the date range
you choose.
This snapshot is based on the Sales Orders by Promotion Code Summary
Report.

Prospects This snapshot shows the top prospects by projected value of estimates expected
to closed during the date range you choose.
This snapshot is based on the Prospect Analysis Summary Report.

Referrer By Revenue This snapshot shows the top referring Web sites by the revenue they deliver
during the date range you choose.
This snapshot is based on the Referrer Summary Report.

Referrer By Visitors This snapshot shows the top referring Web sites by the quantity of shoppers
they deliver during the date range you choose.
This snapshot is based on the Referrer Summary Report.

Sales Reps By
Activity

This snapshot shows the top sales reps by the number of sales activities they
have initiated during the time period you select. Activities include events, tasks,
notes, messages, and campaigns.
This snapshot is based on the Sales Activity by Sales Rep Summary Report.

Sales Reps By
Forecast

This snapshot shows the top sales reps by forecast for the date range you select.
The forecast includes:

■ total income and reimbursed expenses from customers

■ total value of open estimates that are set to be included in the forecast and
are expected to close in the period you have selected

■ total value of open opportunities that are expected to close in the period
you have selected and do not include an estimate that is set to appear in the
forecast
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Report Snapshot Description

Note: The values of the estimates and opportunities that are included in
the forecast depend on the preferences you have set at Setup > Sales >
Preferences > Sales Preferences on the Forecasts subtab.

This snapshot is based on the Alt. Sales and Billings Forecast vs. Quota Report.

Sales Reps By
Pipeline

This snapshot shows the top sales reps by pipeline. This snapshot includes open
estimates and opportunities expected to close in the date range you select.
This snapshot is based on the Pipeline by Sales Rep Summary Report.

Sales Reps By Sales This snapshot shows the top-selling sales reps for the date range you select.
This snapshot is based on the Sales by Sales Rep Summary Report.

Sales Reps By Sales
Orders

This snapshot shows the top-selling sales reps by sales orders for the date range
you select.
This snapshot is based on the Sales Orders by Sales Rep Summary Report.

Sales Reps By Sales
Orders Alt. Sales

This snapshot shows the sales reps with the greatest dollar amounts of sales
orders, based on alternate sales amounts (ASA), for the date range you select.
This snapshot is based on the Sales Orders by Sales Rep Summary Report.

Sales Reps By Total
Pipeline

This snapshot shows the top sales reps by total pipeline. This snapshot includes
all estimates and opportunities that are open as of the date you select on the
snapshot.
This snapshot is based on the Total Pipeline by Sales Rep Summary Report.

Support Reps By
Closed Cases

This snapshot shows the top support reps by the quantity of closed cases during
the date range you choose.
This snapshot is based on the Closed Case Analysis Summary Report.

Support Reps By
Open Cases

This snapshot shows the top support reps by the quantity of open cases during
the date range you choose.
This snapshot is based on the Open Case Analysis Summary Report.

Time by Employee This snapshot shows the employees who have the most time recorded during
the date range you choose.
This snapshot is based on the Time by Employee Summary Report.

Time by Item This snapshot shows the service items with the most time recorded against
them during the date range you choose.
This snapshot is based on the Time by Item Summary Report.

Time by Project This snapshot shows the projects with the most time recorded against them
during the date range you choose.
This snapshot is based on the Time by Customer Summary Report.

Total Open
Estimates

This snapshot shows the estimates with the highest projected amounts that
were open as of the date you select. Open estimates have a probability between
0% and 100% and have not been closed by an order or actual.
This snapshot is based on the Total Open Estimates Report.

Total Open
Opportunities

This snapshot shows the opportunities with the highest projected amounts
that were open as of the date you select. Open opportunities have a probability
between 0% and 100% and have not been closed by an order or actual.
This snapshot is based on the Total Open Opportunities Detail Report.

Total Pipeline By
Statuses

This snapshot shows the projected and weighted total of all the open estimates
and opportunities for each customer status.
Only estimates that are marked to be included in forecasts are included in this
report. Only opportunities that have not been converted to estimates or other
transactions are included.
This snapshot is based on the Total Pipeline by Statuses Summary Report.

https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N1056111.html
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Report Snapshot Description

Utilization This snapshot shows the employees with the highest productivity during the
date range you choose.
This snapshot is based on the Utilization by Employee report.

Web Items Ordered This snapshot shows you the quantity of Web site orders by item during the
period you choose.
This snapshot is based on the Item Orders Report.

Web Items Ordered
By Unique Visitors

This snapshot shows the top items by quantity that were ordered from unique
visitors in your Web site during the period you choose.
This snapshot is based on the Item Orders Report.

Setup Options for Comparative Sales Report Snapshots
Most report snapshots let you compare at most two date ranges. For Comparative Sales Report
Snapshots, including Comparative Sales, Comparative Sales (Orders), and Comparative Sales (Orders
Alt. Sales), you can choose whether to compare two or three date ranges in a snapshot line graph.
For both two and three data point comparisons, a number of standard date range sets are provided.
Additionally, you can define custom date ranges for either sort of comparison, of the type you choose:
daily, weekly, monthly, quarterly, or yearly.

Report setup options are different for comparative sales report snapshots than for other report
snapshots. Click the Set Up link in this type of portlet to open a popup where you can:

■ Define the number of data points to be graphed in the snapshot (2 or 3).

■ Select a set of standard date ranges, or select Custom to create your own set of date ranges, for
comparison.

If you select Custom, you need to:

□ Select a time interval for date ranges in the Date Range Type dropdown: daily, weekly, monthly,
quarterly, or yearly. The following topics for lists of date range comparisons that are available:

▬ Standard Two-Point Date Range Comparisons

▬ Standard Three-Point Date Range Comparisons

□ Select specific date ranges in the grid below. (The grid's date range fields become dropdown
selectors after Custom is selected for Date Range.)

■ Select a default chart type for the portlet data. Note that comparative sales report snapshots
support a different set of chart types than other report snapshots: Area, Line, Column, and Bar.

■ Select a chart theme to define the look and feel of chart data.

■ Select a chart background to define the display behind chart data.

■ Select the color for each date range. (If you do not make selections here, defaults for the selected
chart theme are used.)

You also can select or change a standard date range comparison from a dropdown in the portlet, and
click portlet thumbnails to change the type of chart displayed.

Standard Two-Point Date Range Comparisons
The following standard date range sets are available for two data point comparisons:

■ Today vs Yesterday

■ This Week vs Last Week

https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N2649034.html
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■ This Month vs Last Month

■ This Month vs Same Last Year

■ This Month vs Same Last Qtr

■ This Qtr vs Last Qtr

■ This Qtr vs Same Last Year

■ This Year vs Last Year

■ Last Month vs Month Before Last

■ Last Month vs Same Last Qtr

■ Last Month vs Same Last Year

■ Last Qtr vs Qtr Before Last

■ Last Qtr vs Same Last Year

■ Last Year vs. Year Before Last

For more information, see Setting Up KPI Comparisons.

Standard Three-Point Date Range Comparisons
The following standard date range sets are available for three data point comparisons:

■ Today vs. Yesterday vs. 2 Days Ago

■ This Week vs. Last Week vs. Week Before Last

■ This Month vs. Last Month vs. Month Before Last

■ This Month vs. Last Month vs. Same Last Year

■ This Month vs. Same Last year vs. Same Year Before Last

■ This Month vs. Same Last Qtr vs. Same Qtr Before Last

■ This Month vs. Same Last Qtr vs. Same Last Year

■ This Qtr vs. Last Qtr vs. Qtr Before Last

■ This Qtr vs. Last Qtr vs. Same Last Year

■ This Qtr vs. Same Last Year vs. Same Year Before Last

■ This Year vs. Last Year vs. Year Before Last

■ Last Three Months

■ Last Month vs. Same Last Qtr vs. Same Qtr Before Last

■ Last Month vs. Same Last Year vs. Same Year Before Last

■ Last Three Qtrs

■ Last Qtr vs. Same Last Year vs. Year Before

■ Last Three Years

For more information, see Setting Up KPI Comparisons.

Creating Custom Report Snapshots
If standard report snapshots are not providing the information that you need, you can create custom
report snapshots to be displayed in dashboard portlets. To create a custom snapshot, customize a
standard report that currently generates snapshots, and create a snapshot of the customized report
when you save it.
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You can create custom report snapshots only from reports that currently are used to generate
standard report snapshots. For a list of these reports, see Reports Available for Custom Report
Snapshots.

To create a custom report snapshot:

1. Open the report you want to customize.

For a list of reports you can use, see Reports Available for Custom Report Snapshots.

■ Go to Reports > Reports Overview, find the report to customize, point to it and click
Customize next to its name.

■ If the report is displayed in a report snapshot portlet, click View Report in the portlet’s menu,
and then click Customize in the report’s footer area.

2. Use the Report Builder to customize the report.

For information about how to customize a report, see the help topic Report Customization.

Important: By default, when users click a custom report snapshot link to view detailed
data, drilldown goes to the standard detail report, not to a customized detail report.

3. Click Save and Create Snapshot.

4. On the Customize Report Snapshot page, define layout options for portlets displaying this
custom report snapshot.

1. Enter a Portlet Title that will be displayed in the header bar of this snapshot's portlet.

The title must be unique.

2. On the List subtab, select the columns you want to display in the narrow and wide
versions of the portlet.

The narrow version of the portlet can display only two columns.

The wide version shows only when the portlet is positioned in the center column of the
dashboard.

3. On the Graph subtab, select the columns of data to show in the graph's X and Y axes.

5. Click Save.

This snapshot is now available for you to add to a dashboard portlet. For instructions, see Adding a
Report Snapshot Portlet. When a custom snapshot is displayed in a portlet, you can click the portlet's
Edit link to make changes.

Note: If you receive the error message “This record already exists” when you click the Save
and Create Snapshot button or when you click Save for a customized snapshot, it means
there is a previously created custom snapshot that has the same name. You can change your
report snapshot title or delete the previously created snapshot. See Deleting a Custom Report
Snapshot.

Deleting a Custom Report Snapshot
You can delete a custom report snapshot when it is displayed in a report snapshot portlet.

To delete a custom report snapshot:

1. Find the custom report snapshot on your dashboard.

2. Click the report snapshot dropdown and select Edit.

3. From the Actions menu, select Delete.

https://system.netsuite.com/app/help/helpcenter.nl?fid=chapter_N736328.html
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Reports Available for Custom Report Snapshots
The only reports that you can customize to create custom report snapshots are reports that are used to
generate standard report snapshots.

Note: The reports available to you in NetSuite depend upon your role and the features you
have enabled.

The following reports can be customized to create custom report snapshots.

■ Alt.Sales and Billings Forecast vs. Quota

■ Campaign ROI Analysis Summary

■ Campaign Response Summary

■ Closed Case Analysis Summary

■ Customers by Partner Summary

■ Customer Profitability Summary

■ Earned Value by Project

■ Forecast (Outstanding) by Customer Summary

■ Forecast by Item Summary

■ Forecast by Sales Rep Summary

■ Forecast by Status Summary

■ Forecast by Customer Summary

■ Hosted Page Hits Detail

■ Hours & Earnings

■ Internal Search Summary

■ Inventory Revenue Summary

■ Item Orders Summary

■ Lead Source Analysis Summary

■ Open Case Analysis Summary

■ Open Invoices

■ Open Sales Orders

■ Page Hits Detail

■ Page Hits Summary

■ Partner Activity Summary

■ Payroll Liabilities

■ Pipeline by Sales Rep Summary

■ Pipeline by Status Summary

■ Pipeline by Customer Summary

■ Prospect Analysis Summary

■ Referrer Summary

■ Sales Activity by Sales Rep Summary

■ Sales by Customer Summary

■ Sales by Item Summary

■ Sales by Partner Summary

■ Sales by Sales Rep Summary
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■ Sales Orders by Customer Summary

■ Sales Orders by Item Summary

■ Sales Orders by Partner Summary

■ Sales Orders by Promotion Code Summary

■ Sales Orders by Sales Rep Summary

■ (Search Engine) Keywords Summary

■ Time by Customer Summary

■ Time by Employee Summary

■ Time by Item Summary

■ Total Open Estimates

■ Total Open Opportunities Detail

■ Total Pipeline by Customer Summary

■ Total Pipeline by Sales Rep Summary

■ Total Pipeline by Statuses Summary

■ Utilization by Employee (deprecated)

Sales Management Snapshots
If you are a sales manager, administrator, or executive with access to sales reports, you can display
sales management report snapshots in dashboard portlets. NetSuite provides the following sales
management report snapshots:

■ Sales Managers by Sales Orders. This snapshot shows the approved sales order totals for each
manager and rep in a selected date range, and is based on the Sales Orders by Sales Rep Summary
report.

■ Sales Managers by Forecast. This snapshot shows the quota, actual sales, calculated forecast, and
override forecast, for each manager and rep in a selected date range, and is based on the Alt. Sales
and Billings Forecast vs. Quota report.

■ Sales Managers by Sales. This snapshot shows the sales revenue by each sales manager in the
selected period range, and is based on the Sales by Sales Rep report.

Sales management reports roll up and display data according to the sales management hierarchy. This
hierarchy is based on the supervisors defined on employee records.

After you have added a sales management snapshot portlet, you can click the portlet's Set Up link to
select the hierarchical level of data to display.

■ For example, you may have four levels of hierarchy: the CEO, the sales VP, sales managers, and sales
reps. If you select the 2nd level of hierarchy for a snapshot, you will see information for the CEO and
the sales VP only. However, the totals include the corresponding subordinate's totals.

■ In the Report Snapshot portlet, you can click a + or - sign next to a sales manager to display more or
less data.

To display a sales management snapshot:

1. Click the Personalize link in the upper right corner of the dashboard. You can also use the
Personalize Dashboard link in the Settings portlet.

2. On the Report Snapshots tab of the Personalize Dashboard palette, click the Report Snapshots
icon or drag it onto the dashboard.

If the Report Snapshots tab does not display in the Personalize Dashboard panel, it means you
cannot add Report Snapshot portlets to this page.
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3. Click the Set Up link in the portlet’s menu.

4. In the Snapshot dropdown list, select either of the following sales management snaphots:

■ Sales Managers by Forecast

■ Sales Managers by Sales

■ Sales Managers by Sales Orders

5. In the Hierarchy Level list, select the level of management data to display.

6. Click Save.

The snapshot portlet refreshes to display the selected level of hierarchy. From the portlet, you also can
do the following:

■ Change the date or period range to display results for a different time period.

■ Click a + or - next to a manager's name to expand or collapse displayed data.

■ Click Refresh to reload and update the portlet's data.

■ Choose Print, Download, or View Report menu options.

Setting Up a Report Snapshot Portlet
When you have added a Report Snapshot portlet to your dashboard, you can configure the portlet to
display data in the most useful manner.

To learn how to add a Report Snapshot portlet, see Adding a Report Snapshot Portlet.

To set up a Report Snapshot portlet:

1. In the report snapshot portlet, click  and select Set Up from the menu.

2. The portlet setup window displays.
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3. In the portlet setup window, you can:

■ For custom report snapshots, change the portlet title, or the name of the snapshot.

■ Use the Snapshot menu to select the report snapshot to display.

■ Use the As of or Date Range dropdown menu to change the time period for which data is
displayed.

■ Choose a Display Type to indicate whether data should be displayed as a list or a graph.

Note the following about report snapshots that display lists:

□ Report snapshot list text truncates at 25 characters when the report snapshot portlet is
in the left or right dashboard column. To avoid this truncation, place the portlet in the
middle column.

□ Report snapshot list amounts are rounded to the nearest whole number and do not
display decimal places.

□ Graph-specific settings, including Default Chart Type, Chart Theme, Custom Series Color,
and Background Type, are not available for lists.

■ Choose a Display Order.

□ If you select Top, your data will be shown in order starting with the greatest value.

□ If you select Bottom, your data will show in order starting with the lowest value.

■ From the How Many list, select the number of results to display. Choices include:

□ Top 5

□ Top 10
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□ Top 15

□ Top 25

□ Top 50

■ For graphs, use the Default Chart Type dropdown menu to set the default chart used for
snapshot data. You can later change the chart type by clicking a thumbnail in the portlet itself.

□ For comparative sales report snapshots, chart type options are Area, Line, Bar, and
Column.

□ For other report snapshots, chart type options are Line, Bar, Column, and Pie.

■ For graphs, use the Chart Theme dropdown menu to set a look and feel for chart data:

□ Global Theme – uses the chart theme set in the Chart Themes section on the Home > Set
Preferences page (the default). See the help topic Setting Preferences for Appearance.

□ Basic – provides limited color contrast.

□ Colorful – provides more color contrast.

□ Match Color Theme - Bold – harmonizes with your choices in the Colors section on the
Home > Set Preferences page, using bolder shades. See the help topic Setting Preferences
for Appearance.

□ Match Color Theme - Light – harmonizes with your choices in the Colors section on the
Home > Set Preferences page, using lighter shades. See the help topic Setting Preferences
for Appearance.

■ For graphs, use the Custom Series Color field to enter a hexadecimal value for the color
you want to use for the graph. Please note that this option is provided for backwards
compatibility with custom chart colors defined prior to the introduction of chart themes in
Version 2012 Release 2.

■ For graphs, use the Background Type dropdown menu to set the background display behind
chart data:

□ Global Background – uses the background type set on the Set Preferences page (the
default)

□ Lines

□ Bands

□ Grid

4. When you have finished configuring the portlet, click Save to save your configuration.

Note: Some report snapshot portlets do not include a Set Up link because these snapshots
do not offer choices for data display. For custom snapshots, an Edit link may be available that
provides some of the same settings as those available from the Set Up link.

https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N479574.html
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Publishing Dashboards Overview
NetSuite's user interface is role-based, so that your role determines the set of tabbed pages, or center,
that displays when you log in. Centers are tied to functional areas, such as Accounting, Marketing,
Sales, and Support. NetSuite provides a default visual workspace, or dashboard, for each tabbed page,
and lets you personalize your dashboards to fit your business. Administrators can share, or publish,
their personalized dashboards to users logging in to the same center. A published dashboard can
include one tabbed page, or multiple pages.

Published dashboards provide a consistent interface to users with related roles. This uniformity in
dashboards' appearance can make it easier for users to work together, because they have ready access
to the same data. Publishing dashboards also can save time, by allowing an administrator to set up
dashboards for an entire team of users.

Permissions and Roles
To get started publishing dashboards, you need to understand the following:

■ To publish dashboards, you must have the Publish Dashboards permission. A few administrative
roles have this permission assigned by default, but most users do not. For more information, see
Publish Dashboards Permission.

■ When you have the Publish Dashboards permission, you can publish dashboards to other users,
designated by role. You can only publish a dashboard to roles that tie to the same center in which
you have personalized the dashboard. For example, if your role is set to Account Administrator
when you personalize a dashboard, you can publish it only to roles tied to the Classic center. If your
role is set to Sales Administrator, you can publish a personalized dashboard only to roles tied to the
Sales center. For more information, see Publish Dashboards Permission.

Publishing a Dashboard
To publish a dashboard, you need to complete the following two steps:

1. Personalize the dashboard you want to publish – After you have verified that you have the
Publish Dashboards permission, and logged in with the appropriate role, the next step to
publishing a dashboard is to personalize one or more of your own tabbed pages to fit the
team's business needs. Personalization can involve changes you make to NetSuite's standard
tabs or the creation of custom tabs of your own. See Personalizing Dashboards and Creating
Center Tabs.

2. Publish the dashboard – When you have finished personalizing your own tabbed pages, you
can publish one or more of them to appear on other users' tabs. See Publishing a Dashboard.

When you publish a dashboard, you make the following choices. Note that some choices can be
changed after you have published the dashboard, and others cannot.

■ The roles to which the dashboard should be published. (Can be changed later.)

■ Whether the dashboard should be published to new users only or to both existing and new
users, replacing existing users' dashboards. (Can be changed later.)

■ The tabbed pages to include in the dashboard. (Cannot be changed later.)

■ The restriction levels for users' dashboard personalizations. (Cannot be changed later.)

https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N2890512.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N2890512.html
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After you have published a dashboard, you can make further changes to it and apply these changes to
users' dashboards. See Applying Changes to Published Dashboards.

Publish Dashboards Permission
To publish dashboards, you must have the Publish Dashboards permission. A few administrative roles
have this permission assigned by default, but most users do not. When you use the Publish Dashboard
button, the dashboard will appear in the state of the dashboard for you and your corresponding role
that is currently logged into NetSuite. If you make a change to a published dashboard, the dashboard
will publish with those edits included. It is not possible to revert back to dashboard settings that were
previously published.

If you have the Publish Dashboards permission, a Publish Dashboard link displays in the Settings
portlet on your home page. If this link is not available, you do not have the permission.

For information, see the following topics:

■ Roles with Publish Dashboards Permission

■ Adding the Publish Dashboards Permission

■ Can Publish to Own Center Only

Roles with Publish Dashboards Permission

By default, the Publish Dashboards permission is available to users assigned the following roles:

■ Administrator – can publish dashboards to users assigned roles in the Classic Center.

■ Intranet Manager – can publish dashboards to users assigned roles in the Ecommerce
Management Center.

■ Issue Administrator – can publish dashboards to users assigned roles in the Engineering Center

■ Marketing Administrator – can publish dashboards to users assigned roles in the Marketing Center.

■ Product Manager – can publish dashboards to users assigned roles in the Support Center.

■ QA Manager – can publish dashboards to users assigned to roles in the Engineering Center.

■ Sales Administrator – can publish dashboards to users assigned roles in the Sales Center.

■ Support Administrator – can publish dashboards to users assigned roles in the Support Center.

■ System Administrator – can publish dashboards to users assigned roles in the System
Administrator Center.

Adding the Publish Dashboards Permission

If additional users require the Publish Dashboards permission, for example, in cases where centers do
not have any existing roles with this permission, the account administrator can customize the users'
roles to add the permission, or create a custom role with the permission.

For example, to allow the publishing of a dashboard to roles that use the Advanced Partner Center
role, the account administrator can create a customized Advanced Partner Center role, add the Publish
Dashboards permission to it, and assign the role to the user who needs to publish the dashboard.
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The Publish Dashboards permission is listed on the Setup subtab of each Role record's Permissions
subtab. For more information, see the help topic Customizing or Creating NetSuite Roles.

Note: If the Global Permissions feature is enabled, the account administrator can add the
Publish Dashboards permission directly to employee records' Global Permissions subtab, to be
applicable to all of the employees' assigned roles.

Can Publish to Own Center Only
Be aware that even with the Publish Dashboards permission, you can publish dashboards only to other
users with roles tied to the same center where you have personalized your dashboard, because only
roles tied to the same center share the same set of tabbed pages. For example, if you are logged in as a
sales administrator when you personalize a dashboard, only sales roles are available when you attempt
to publish that dashboard.

The account administrator generally uses the Classic Center, which may not be shared with many
other users. For this user to publish dashboards to users with roles in other centers, he or she must
be assigned an additional role for each center where a published dashboard is needed. If any of these
roles do not have the Publish Dashboards permission, it needs to be added. Then, this user can log in
with each role to personalize and publish a dashboard to roles for the related center.

In other cases, it may make more sense for different users to publish dashboards to different centers.
In all cases, you should be aware of the center for your role, know which other roles share your center,
and ensure that you have the Publish Dashboards permission, BEFORE you personalize a dashboard
that you want to publish.

Note: Dashboards published to the Advanced Partner Center are published to partner
contacts as well as partners. If a partner or a partner contact modifies the dashboard content
by, for example, adding a portlet, this change will appear on the dashboards of the partner and
all partner contacts logged in using the same role.

Publishing a Dashboard
You can share your personalized dashboard with other users in your center by publishing it. A
published dashboard can consist of one tabbed page or of multiple pages. When you publish a
dashboard, you define the roles for users who will see the published dashboard, and what changes
users will be able to make to the published dashboard.

Note: The minimum required screen width size when using a three column layout is 1400
pixels.

Before you attempt to publish a dashboard:

■ Verify that you have the Publish Dashboards permission by checking for the Publish Dashboard link
in your home page Settings portlet.

■ Verify that the role you are currently using shares the same center as the roles to which you want to
publish the dashboard. Do not begin personalizing a dashboard until you are sure that your role can
publish to the users you want!

For more information, see Publish Dashboards Permission.

■ Personalize the home page by adding portlets that you want to be part of the published home page
dashboard. For more information, see Setting Up Dashboard Portlet Content.

https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N285937.html
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Note: Please note that if your dashboard contains a calendar portlet that displays My
Calendar, the published dashboard users will see their personal calendar, not the publisher's
one.

■ Personalize one or more of your own tabbed pages to be part of the published dashboard. You
can personalize a page by making changes to a standard NetSuite tabbed page, as described in
Personalizing Dashboards. Or, you can create your own custom tabbed page, as described in
Creating Center Tabs.

When you create a custom tab, you select the centers where it will display. For example, for a tab
used by sales reps, you would select the Sales Center, and for a tab used by accounting clerks, you
would select the Accounting Center. You also have the option of making a tab display in all centers.
However, be aware that tabs applied to all centers are not available in published dashboards.

To publish a dashboard:

1. Go to your home page, and in the Settings portlet, click the Publish Dashboard link.

2. On the Publish Dashboard page, enter a name for the dashboard in the Name field, and, if
desired, descriptive text in the Notes field. These fields are for your reference only and are not
exposed to other users.

3. If you want to prevent users from removing Shortcuts portlet links on the published dashboard's
pages, check the Lock Shortcuts box.

■ When you enable this option, users still can add and reorder links in their Shortcuts portlets.

■ For information about the Shortcuts portlet, see Shortcuts Portlet.

4. To prevent users from removing Create New menu links on the published dashboard's page,
check the Lock New Bar box.

■ When you enable this option, users still can add and reorder links in their Create New menu.

■ For information about the Create New menu, see the help topic Using the Create New Menu.

5. On the Apply To Roles subtab, select the roles to which you want to publish this dashboard and
indicate whether to publish the dashboard to new users only or to both new and existing users.

1. Select a role from the Role list.

Only roles tied to the center that your current role uses are listed here, because you can
only publish a dashboard to roles that share your center. If a role is not listed here, you
cannot publish the dashboard to it when you are logged in with your current role. You
may be able to log in with a different role, personalize a dashboard, and publish it to
additional roles. For more information, see Publish Dashboards Permission.

Roles that are inactive are not included in the list.

2. By default, for a dashboard being published for the first time Override existing user's
settings is set to Yes, indicating that this dashboard should be published to existing users
with the selected role, replacing their current dashboards. Clear this check box if you
want to publish the dashboard only to new users assigned the selected role.

3. Click Add.

4. Repeat the preceding steps for additional roles to which you want to publish the
dashboard.

Only a part of the published dashboard content may be available to some users. Users can view
only the dashboard content that their assigned roles give them permission to see.

6. On the Apply To Tabs subtab, select the tabbed pages that you have customized to be part of
the published dashboard, and choose how you want to restrict users' changes to the published
dashboard's pages.

https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N2890512.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N588325.html
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1. Check the box in the Apply column next to each tabbed page you want to include in this
dashboard.

2. In the Mode column, choose the level of restriction for users' changes to the selected
page:

■ Unlocked – lets users make all changes to the selected page.

■ Locked – restricts users from making any changes to the selected page.

■ Add/Move Content – enables users to add and rearrange portlets on the selected
page, and at the same time prevents them from removing portlets.

Note: The Add/Move Content option prevents users from removing not only
portlets that were added as part of the published dashboard but also the portlets
they added themselves.

For more information, see Restricting Users' Dashboard Personalizations.

Important: After you have saved a published dashboard, you cannot redefine which
tabbed pages are included or change their restriction modes, so make these choices very
carefully.

7. Click Save.

The published dashboard is applied to users assigned the selected roles. They may need to log
out and log back in to the system for changes to be visible. They also may need to clear their
browser cache.

Assigning Published Dashboards to Users
You define the users for a published dashboard by selecting one or more roles when you first publish
it. After the dashboard has been published, you can add or remove roles to change the users.

All of a published dashboard's information may not be available to all of its users. Users can view only
the dashboard content that their assigned roles give them permission to see.

To assign saved dashboards to users:

1. Go to your home page, and in the Settings portlet, click the List link next to Publish Dashboard.

A list of your dashboards appear.

2. Click Edit next to the name of the dashboard for which you want to change assigned users.

3. On the Apply To Roles subtab of the Published Dashboard page, you can:

1. Add a role to which the dashboard should be published by placing the cursor in a blank
line, selecting a role from the Role list, and clicking Add.

By default, for a previously published dashboard Override existing user's settings is set
to No, indicating that the dashboard will be published only to new users assigned the
selected role. Check this box to change it to Yes if you want to publish the dashboard to
existing users with the selected role, replacing their current dashboards.

2. Remove a previously selected role from the published dashboard's list by selecting the
role and clicking the Remove button.

4. Click Save.

The published dashboard is applied to users with the selected roles. They may need to log out
and log back in to the system for changes to be visible.
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Restricting Users' Dashboard Personalizations
When you first publish a dashboard, you can set a restriction level that indicates the types of changes
users can make to each tabbed page of the published dashboard.

You set this restriction level by selecting from the following three modes on the Publish Dashboard
page's Apply To Tabs subtab:

■ Unlocked – lets users make all changes to the selected page.

■ Locked – restricts users from making any changes to the selected page.

■ Add/Move Content – enables users to add and rearrange portlets on the selected page, and at the
same time prevents them from removing portlets.

Note: The Add/Move Content option prevents users from removing not only portlets that
were added as part of the published dashboard but also the portlets they added themselves.

When selecting a mode for each tabbed page, or tab, included in the published dashboard, you can
specify different modes for each tab.

After you have saved a published dashboard, you cannot modify these modes, so make your selections
very carefully!

Note: Each Publish Dashboard page has options for locking the Shortcuts portlet and the New
Bar so that users cannot remove links. These options can be changed after a dashboard has
been published.

Applying Changes to Published Dashboards
When you make changes to a personalized dashboard that you have published, you can apply these
changes to the dashboards of all or some of the users for the published dashboard, based on users'
assigned roles.

To change a published dashboard:

1. Log in with the role you were using when you published the dashboard.

2. Make changes to one or more of your dashboards that you previously published to other roles.

3. Go to your home page, and in the Settings portlet, click the List link next to Publish Dashboard.

4. Click Edit next to the dashboard you want to reapply to other roles.

5. On the Apply To Roles subtab of the Publish Dashboard page, you can apply your changed
dashboard to users' dashboards based on their roles.

For each role to which you want to apply the changed dashboard, check the box in the Override
existing user's settings column.

If you checked this box for a role when you initially published the dashboard, this box is not
checked now. If you want to apply these changes to that role, you must check this box again.

6. Click the Save and Update Content button.

Note: If you click the Save button, the dashboard definition is saved, but the changes
are not applied to users' dashboards.

Your changes to this published dashboard are applied to users assigned the selected roles. They may
need to log out and log back in to the system for changes to be visible. Depending on your browser’s
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caching settings, users may need to manually refresh the page for each dashboard that has been
updated.

Applying Updates for Bundled Published Dashboards
Changes to a dashboard installed by a bundle may be applied automatically, as part of bundle updates,
to the dashboards of users with roles to whom the dashboard was previously published.

Whether these automatic updates to users' dashboards occur depends upon the setting for a related
bundle preference. The user who updates the bundle in your account can indicate whether bundled
dashboard updates should be applied only to the dashboard definition, or to both the definition and to
the dashboards of all users with roles to which the dashboard was previously published.

If the updates are applied only to the dashboard definition, you can follow steps 2-6 above to apply
updates to users' dashboards as desired. For information about the bundle update process, see the
help topics Updating an Installed Bundle, Reviewing the Preview Bundle Update Page, and Set Bundle
Update Preferences.

https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N3397927.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N3399556.html
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N3399556.html#bridgehead_N3399815
https://system.netsuite.com/app/help/helpcenter.nl?fid=section_N3399556.html#bridgehead_N3399815
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